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1
Installing the Operating System

Ä
CAUTION: Do not add optional hardware or third-party devices to your computer until the operating 
system is successfully installed. Doing so may cause errors and may prevent the operating system from 
installing properly.

Ä
CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL 
THE PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the 
software that runs the computer or prevent its proper installation.

The first time the computer is turned on, the operating system is automatically installed. This 
takes approximately 10 minutes, depending on the system hardware configuration. At the 
beginning of the installation process, you are prompted to select the appropriate language for the 
operating system. Read and follow the instructions that appear on the screen to complete the 
installation. During this process, do not turn off your computer unless you are directed to do so.

✎ If the computer shipped with more than one operating system language on the hard drive, the 
installation process could take up to 60 minutes.

1.1 Installing or Upgrading Device Drivers 
To install hardware devices such as a printer, a display adapter, or network adapter after the 
operating system installation is completed, the operating system needs access to the appropriate 
software drivers for the devices.

If prompted for the I386 directory, replace the path specification with C:\i386, or use the Browse 
button in the dialog box to locate the i386 folder. This action points the operating system to the 
appropriate drivers.

Obtain the latest support software, including support software for the operating system from 
www.hp.com. Click Support & Drivers, select Download drivers and software, enter the 
model number of the computer, and press Enter.

You can also obtain the latest support software on CDs. The following Web site provides 
information on how to purchase a support software CD subscription:

http://h18000.www1.hp.com/support/files/desktops/us/purchase.html 

✎ If the computer has an optical CD-RW drive, install the appropriate application to be able to 
write to the drive. To install the application, double-click the Setup Software icon on the desktop 
or the application launcher and select the Easy CD Creator and Direct CD option when 
prompted.
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Installing the Operating System
1.2 Transferring Files and Settings
Use the Microsoft Windows XP Files and Settings Transfer Wizard to move files and settings 
from an old computer to a new one. Click Start > All Programs > Accessories > System Tools 
> Files and Settings Transfer Wizard.

1.3 Backing Up and Restoring Files

1.3.1 Creating a Backup File—Windows XP Professional
1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Use the Backup or Restore Wizard to create a backup file or tape.

✎ A backup file can be saved to a hard disk, a floppy disk, CD, USB flash media device, tape drive, 
or to any other removable or nonremovable media.

1.3.2 Restoring from the Backup File—Windows XP Professional
1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Use the Backup or Restore Wizard to restore files from a backup file.

✎ A backup file can be on a hard disk, a floppy disk, CD, USB flash media device, tape drive, or 
any other removable or nonremovable media.

1.4 Converting to NTFS

Windows XP Professional

To convert a FAT or FAT32 volume to NTFS,

1. Click Start > All Programs > Accessories > Command Prompt.

2. Type convert drive_letter: /fs:ntfs (where drive_letter is the volume to be converted) and 
press Enter.

1.5 HP Software
The Microsoft Windows XP Professional operating system is preinstalled on the computer and 
will be configured automatically the first time the computer is turned on. The following HP 
software may also be installed at that time on selected models: 

■ Computer Setup Utilities

■ HP Support Software including device drivers

■ Configuration Record

■ Online Safety & Comfort Guide
■ Power Management with energy saver features

■ Security Management tools
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Installing the Operating System
■ Software Support Management tools

Certain drivers and utilities are available only in selected languages. You can obtain the latest 
version of these files, in English and selected other languages, in one of three ways:

■ Support Software CD 

■ HP Web site at www.hp.com 

■ Restore Plus! CD, which is supplied with many HP models

✎ Additional HP software may be required in certain situations. 
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2
Setup Utilities and Diagnostics Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer 
system when contacting Customer Support. These tools can also be used to:

■ Change factory default settings and to set or change the system configuration, which may be 
necessary when you add or remove hardware.

■ Determine if all of the devices installed on the computer are recognized by the system and 
functioning properly.

■ Determine information about the operating environment of the computer.

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Establish and manage passwords and other security features.

■ Establish and manage energy-saving timeouts.

✎ All features identified in this chapter may not be available on all HP products.

2.1 Power-On Self-Test (POST)
POST is a series of diagnostic tests that runs automatically when the system is turned on. POST 
checks the following items to ensure that the computer system is functioning properly:

■ Keyboard

■ Memory modules

■ All mass storage devices 

■ Processors

■ Controllers

✎ If the Power-On Password is set, a key icon appears on the screen while POST is running. You 
will need to enter the password before continuing. Refer to Chapter 3, Section 3.1for information 
on setting, deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. For POST error 
messages and their solutions refer to Appendix C, “POST Error Messages.”
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2.2 Computer Setup Utilities
Use Computer Setup Utilities (F10) to: 

■ Change factory default settings.

■ Set the system date and time.

■ Set, view, change, or verify the system configuration, including settings for processor, 
graphics, memory, audio, storage, communications, and input devices.

■ Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, 
or USB flash media devices.

■ Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests 
run during a Full Boot. You can set the system to:

❏ always Quick Boot (default);

❏ periodically Full Boot (from every 1 to 30 days); or

❏ always Full Boot.

■ Select Post Messages Enabled or Disabled to change the display status of Power-On 
Self-Test (POST) messages. Post Messages Disabled suppresses most POST messages, such 
as memory count, product name, and other non-error text messages. If a POST error occurs, 
the error is displayed regardless of the mode selected. To manually switch to Post Messages 
Enabled during POST, press any key (except F1 through F12).

■ Establish an Ownership Tag, the text of which is displayed each time the system is turned on 
or restarted.

■ Enter the Asset Tag or property identification number assigned by the company to this 
computer.

■ Enable the power-on password prompt during system restarts (warm boots) as well as during 
power-on.

■ Establish a setup password that controls access to Computer Setup (F10) Utility and the 
settings described in this section.

■ To secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or 
embedded NIC, so that they cannot be used until they are unsecured.

■ Enable or disable Master Boot Record (MBR) Security. 

■ Enable or disable removable media boot ability.

■ Enable or disable legacy diskette write ability (when supported by hardware).

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Replicate the system setup by saving system configuration information on diskette and 
restoring it on one or more computers.

■ Execute self-tests on a specified ATA hard drive (when supported by drive).

■ Enable or disable DriveLock security (when supported by MultiBay drive).
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2.2.1 Using Computer Setup (F10) Utilities 
Computer Setup can be accessed only by turning on the computer or restarting the system. To 
access the Computer Setup Utilities menu, complete the following steps: 

1. Turn on or restart the computer. If you are in Windows, click Start >Shut Down >Restart. 

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary. 

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select your language from the list and press the Enter key.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, 
Security, Power, and Advanced. 

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and 
down) keys to select the option you want, then press Enter. To return to the Computer Setup 
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit. 

❏ If you have made changes that you do not want applied, select Ignore Changes and 
Exit.

❏ To reset to factory settings, select Set Defaults and Exit. This option will restore the 
original factory system defaults.

Ä
CAUTION: Do NOT turn the computer power OFF while the ROM is saving your F10 Computer Setup 
changes because the CMOS could become corrupted. It is safe to turn off all power to the computer after 
you exit the F10 Setup screen. 
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2.2.2 Computer Setup Menu
.

Heading Option Description

File System Information Lists:
• Product name
• Processor type/speed/stepping
• Cache size (L1/L2)
• Installed memory size/speed, number of channels (single or 

dual) (if applicable)
• Integrated MAC address for embedded, enabled NIC (if 

applicable)
• System ROM (includes family name and version)
• Chassis serial number
• Asset tracking number

About Displays copyright information.

Set Time and Date Allows you to set system time and date.

Replicated Setup Save to Removable Media
Saves system configuration, including CMOS, to a formatted 
1.44-MB diskette, a USB flash media device, or a diskette-like 
device (a storage device set to emulate a diskette drive).
Restore from Removable Media
Restores system configuration from a diskette, a USB flash media 
device, or a diskette-like device.

Default Setup Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default
Restores the factory system configuration settings as the default.

Apply Defaults 
and Exit

Applies the currently selected default settings and clears any 
established passwords.

Ignore Changes 
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and 
Exit

Saves changes to system configuration or default settings and exits 
Computer Setup.

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage Device 
Configuration

Lists all installed BIOS-controlled storage devices.
When a device is selected, detailed information and options are 
displayed. The following options may be presented.

Diskette Type
Identifies the highest capacity media type accepted by the diskette 
drive.
Legacy Diskette Drives
Options are 3.5" 1.44 MB and 
5.25" 1.2 MB.

Drive Emulation
Allows you to select a drive emulation type for a certain storage 
device. (For example, a Zip drive can be made bootable by 
selecting diskette emulation.) 

Drive Type Emulation Options

ATAPI Zip drive None (treated as Other)

Diskette (treated as diskette drive)

ATA Hard disk None (treated as Other) 

Hard disk (treated as hard drive)

Legacy diskette No emulation options available

CD-ROM drive No emulation options available

ATAPI LS-120 None (treated as Other).

Diskette (treated as diskette drive).

Default Values IDE/SATA

Multisector Transfers (ATA disks only)
Specifies how many sectors are transferred per multi-sector PIO 
operation. Options (subject to device capabilities) are Disabled, 8, 
and 16.

Transfer Mode (ATA devices only)
Specifies the active data transfer mode. Options (subject to device 
capabilities) are PIO 0, Max PIO, Enhanced DMA, Ultra DMA 0, 
and Max UDMA.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Device 
Configuration
(continued)

Translation Mode (ATA disks only)
Lets you select the translation mode to be used for the device. This 
enables the BIOS to access disks partitioned and formatted on other 
systems and may be necessary for users of older versions of UNIX 
(e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, 
LBA Assisted, User, and None

Ä CAUTION: Ordinarily, the translation mode selected 
automatically by the BIOS should not be changed. If the selected 
translation mode is not compatible with the translation mode that 
was active when the disk was partitioned and formatted, the data 
on the disk will be inaccessible.

Translation Parameters (ATA disks only)

✎ This feature appears only when User translation mode is selected.
Allows you to specify the parameters (logical cylinders, heads, and 
sectors per track) used by the BIOS to translate disk I/O requests 
(from the operating system or an application) into terms the hard 
drive can accept. Logical cylinders may not exceed 1024. The 
number of heads may not exceed 256. The number of sectors per 
track may not exceed 63. These fields are only visible and 
changeable when the drive translation mode is set to User.

Storage Options Removable Media Boot 
Enables/disables ability to boot the system from removable media.

Legacy Diskette Write
Enables/disables ability to write data to legacy diskettes.

✎ After saving changes to Removable Media Write, the computer 
will restart. Turn the computer off, then on, manually.

BIOS DMA Data Transfers
Allows you to control how BIOS device I/O requests are serviced. 
When “Enable” is selected, the BIOS will service ATA device read 
and write requests with DMA data transfers. When “Disable” is 
selected, the BIOS will service ATA device read and write requests 
with PIO data transfers.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage
(continued)

Storage Options
(continued)

SATA Emulation
Allows you to choose how the SATA controller and devices are 
accessed by the operating system. 
“Separate IDE Controller” is the default option. Up to 4 SATA and 2 
PATA devices may be accessed in this mode. The SATA and PATA 
controllers appear as two separate IDE controllers. Use this option 
with Microsoft Windows 2000 and Windows XP.

• SATA 0 is seen as SATA Primary Device 0
• SATA 1 (if present) is seen as SATA Secondary Device 0

“Combined IDE Controller” is the other option. Up to 2 PATA and 2 
SATA devices may be accessed in this mode. The SATA and PATA 
controllers appear as one combined IDE controller. Use this option 
with Microsoft Windows 98 and earlier operating systems.

• PATA Primary Device 0 replaces SATA 1
• PATA Primary Device 1 replaces SATA 3

IDE Controller
Allows you to enable or disable the primary IDE controller. This 
feature is supported on select models only.

Primary SATA Controller
Allows you to enable or disable the Primary SATA controller.

Secondary SATA Controller
Allows you to enable or disable the Secondary SATA controller. This 
feature is supported on select models only.

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of 
performing the Drive Protection System (DPS) self-tests.

✎ This selection will only appear when at least one drive capable of 
performing the DPS self-tests is attached to the system.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Boot Order Allows you to:
• Specify the order in which attached devices (such as a USB 

flash media device, diskette drive, hard drive, optical drive, or 
network interface card) are checked for a bootable operating 
system image. Each device on the list may be individually 
excluded from or included for consideration as a bootable 
operating system source.

• Specify the order of attached hard drives. The first hard drive in 
the order will have priority in the boot sequence and will be 
recognized as drive C (if any devices are attached).

✎ MS-DOS drive lettering assignments may not apply after a 
non-MS-DOS operating system has started.

Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device 
specified in Boot Order, restart the computer and press F9 when the 
monitor light turns green. After POST is completed, a list of bootable 
devices is displayed. Use the arrow keys to select the preferred 
bootable device and press Enter. The computer then boots from the 
selected non-default device for this one time.

Security Setup Password Allows you to set and enables setup (administrator) password. 

✎ If the setup password is set, it is required to change Computer 
Setup options, flash the ROM, and make changes to certain plug 
and play settings under Windows.

See the Troubleshooting Guide on the Documentation CD for more 
information.

Power-On 
Password

Allows you to set and enable power-on password.
See the Troubleshooting Guide for more information.

Password Options 
(This selection will 
appear only if a 
power-on 
password is set.)

Allows you to specify whether the password is required for warm 
boot (CTRL+ALT+DEL). 
See the Desktop Management Guide for more information.

Smart Cover Allows you to:
• Lock/unlock the Cover Lock.
• Set the Cover Removal Sensor to Disable/Notify User/Setup 

Password.

✎ Notify User alerts the user that the sensor has detected that the 
cover has been removed. Setup Password requires that the setup 
password be entered to boot the computer if the sensor detects 
that the cover has been removed.

This feature is supported on select models only. See the Desktop 
Management Guide on the Documentation CD for more 
information.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Security
(continued)

Embedded 
Security

Allows you to:
• Enable/disable the Embedded Security device.
• Reset the device to Factory Settings.

This feature is supported on select models only. See the Desktop 
Management Guide on the Documentation CD for more 
information.

Device Security Enables/disables serial ports, parallel port, front USB ports, system 
audio, network controllers (some models), MultiBay devices (some 
models), SMBus controller (some models), and SCSI controllers 
(some models).

Network Service 
Boot

Enables/disables the computer’s ability to boot from an operating 
system installed on a network server. (Feature available on NIC 
models only; the network controller must reside on the PCI bus or be 
embedded on the system board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte 

identifier displayed during POST). 
 
See the Desktop Management Guide on the Documentation CD 
for more information.

• Chassis serial number or Universal Unique Identifier (UUID) 
number. The UUID can only be updated if the current chassis 
serial number is invalid. (These ID numbers are normally set in 
the factory and are used to uniquely identify the system.)

• Keyboard locale setting (for example, English or German) for 
System ID entry.

DriveLock Security Allows you to assign or modify a master or user password for 
MultiBay hard drives. When this feature is enabled, the user is 
prompted to provide one of the DriveLock passwords during POST. If 
neither is successfully entered, the hard drive will remain 
inaccessible until one of the passwords is successfully provided 
during a subsequent cold-boot sequence.

✎ This selection will only appear when at least one MultiBay drive 
that supports the DriveLock feature is attached to the system.

See the Desktop Management Guide on the Documentation CD for 
more information.

Data Execution 
Prevention

Enable/Disable.  
Data Execution Prevention Mode help prevent OS security breaches.

✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize the function. 

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Power OS Power 
Management

• Runtime Power Management - Enable/Disable. Allows certain 
operating systems to reduce processor voltage and frequency 
when the current software load does not require the full 
capabilities of the processor.

• Idle Power Savings - Extended/Normal. Allows certain 
operating systems to decrease the processors power 
consumption when the processor is idle.

• ACPI S3 Support - Enables or disables ACPI S3 support.
• ACPI S3 Hard Disk Reset - Enabling this causes the BIOS to 

ensure hard disks are ready to accept commands after 
resuming from S3 before returning control to the operating 
system.

• ACPI S3 PS2 Mouse Wakeup - Enables or disables waking from 
S3 due to PS2 mouse activity.

Hardware Power 
Management

SATA power management enables or disables SATA bus and/or 
device power management.

Thermal Fan idle mode - This bar graph controls the minimum permitted fan 
speed.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced*
*For 
advanced 
users only

Power-On Options Allows you to set:
• POST mode (QuickBoot, FullBoot, or FullBoot every 1-30 days).
• POST messages (enable/disable).
• F9 prompt (enable/disable). Enabling this feature will display 

the text F9=Boot Menu during POST. Disabling this feature 
prevents the text from being displayed but pressing F9 will still 
access the Shortcut Boot (Order) Menu screen. See Storage > 
Boot Order for more information. 

• F10 prompt (enable/disable). Enabling this feature will display 
the text F10=Setup during POST. Disabling this feature 
prevents the text from being displayed but pressing F10 will still 
access the Setup screen.

• F12 prompt (enable/disable). Enabling this feature will display 
the text F12=Network Service Boot during POST. 
Disabling this feature prevents the text from being displayed but 
pressing F12 will still force the system to attempt booting from 
the network.

• Option ROM* prompt (enable/disable). Enabling this feature 
will cause the system to display a message before loading 
options ROMs. (This feature is supported on select models only.)

• Remote wakeup boot source (remote server/local hard drive).
• After Power Loss (off/on/previous state): After power loss, if you 

connect your computer to an electric power strip and would like 
to turn on power to the computer using the switch on the power 
strip, set this option to ON.

✎ If you turn off power to your computer using the switch on a 
power strip, you will not be able to use the suspend/sleep feature 
or the Remote Management features.

• POST Delay (in seconds) (enable/disable). Enabling this feature 
will add a user-specified delay to the POST process. This delay 
is sometimes needed for hard disks on some PCI cards that spin 
up very slowly; so slowly that they are not ready to boot by the 
time POST is finished. The POST delay also gives you more time 
to press F10 to enter Computer (F10) Setup.

• I/O APIC Mode (enable/disable). Enabling this feature will 
allow Microsoft Windows Operating Systems to run optimally. 
This feature must be disabled for certain non-Microsoft 
Operating Systems to work properly.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced* 
(continued)
*For 
advanced 
users only

Power-On Options 
(continued)

Allows you to set: (continued)
• ACPI/USB Buffers @ Top of Memory (enable/disable). 

Enabling this feature places USB memory buffers at the top 
of memory. The advantage is that some amount of memory 
below 1 MB is freed up for use by option ROMs. The 
disadvantage is that a popular memory manager, HIMEM.SYS, 
does not work properly when USB buffers are at top of memory 
AND the system has 64 MB or less of RAM.

• Hyper-threading (enable/disable).
• Limit CPUID Maximum Value to 3 - Restricts the number of 

CPUID functions reported by the microprocessor. Enable this 
feature if booting to WinNT.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you 
specify.

Onboard Devices Allows you to set resources for or disable onboard system devices 
(diskette controller, serial port, or parallel port).

PCI Devices • Lists currently installed PCI devices and their IRQ settings. 
• Allows you to reconfigure IRQ settings for these devices or to 

disable them entirely. These settings have no effect under an 
APIC-based operating system.

Bus Options* On some models, allows you to enable or disable:
• PCI SERR# Generation.
• PCI VGA palette snooping, which sets the VGA palette 

snooping bit in PCI configuration space; only needed when 
more than one graphics controller is installed.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced* 
(continued)
*For 
advanced 
users only

Device options Allows you to set: 
• Printer mode (bi-directional, EPP & ECP, output only).
• Num Lock state at power-on (off/on).
• S5 Wake on LAN (enable/disable).

• To disable Wake on LAN during the off state (S5), use the arrow 
(left and right) keys to select the Advanced > Device Options 
menu and set the S5 Wake on Lan feature to “Disable.” This 
obtains the lowest power consumption available on the computer 
during S5. It does not affect the ability of the computer to Wake on 
LAN from suspend or hibernation, but will prevent it from waking 
from S5 via the network. It does not affect operation of the network 
connection while the computer is on.

• If a network connection is not required, completely disable the 
network controller (NIC) by using the arrow (left and right) keys to 
select the Security > Device Security menu. Set the Network 
Controller option to “Device Hidden.” This prevents the network 
controller from being used by the operating system and reduces the 
power used by the computer in S5.

• Processor cache (enable/disable).
• Unique Sleep State Blink Patterns. Allows you to choose an LED 

blink pattern that uniquely identifies each sleep state.
• Integrated Video (enable/disable) Allows you to use integrated 

video and PCI Up Solution video at the same time (available on 
select models only).

✎ Inserting a PCI or PCI Express video card automatically disables 
Integrated Video. When PCI Express video is on, Integrated 
Video must remain disabled.

• Monitor Tracking (enable/disable). Allows ROM to save 
monitor asset information.

Allows you to set:
• NIC PXE Option ROM Download (enable/disable). The BIOS 

contains an embedded NIC option ROM to allow the unit to 
boot through the network to a PXE server. This is typically used 
to download a corporate image to a hard drive. The NIC 
option ROM takes up memory space below 1MB commonly 
referred to as DOS Compatibility Hole (DCH) space. This space 
is limited. This F10 option will allow users to disable the 
downloading of this embedded NIC option ROM thus giving 
more DCH space for additional PCI cards which may need 
option ROM space. The default will be to have the NIC option 
ROM enabled.

PCI VGA 
Configuration

Displayed only if there are multiple PCI video adapters in the 
system. Allows you to specify which VGA controller will be the 
“boot” or primary VGA controller.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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2.3 Diagnostics for Windows
The Diagnostics for Windows (DFW) utility is a component of HP Client Management Solutions 
that allows you to view information about the hardware and software configuration of the 
computer while running Microsoft Windows (Microsoft Windows 2000 and Microsoft Windows 
XP). It also allows you to perform hardware and software tests on the subsystems of the 
computer.

When you invoke Diagnostics for Windows, the current configuration of the computer is shown 
on the Overview screen. There is access from this screen to several categories of information 
about the computer and the Test tab. The information in every screen of the utility can be saved 
to a file or printed.

✎ To test all subsystems, you must log in as the administrator. If you do not log in as the 
administrator, you will be unable to test some subsystems. The inability to test a subsystem will 
be indicated by an error message under the subsystem name in the Test window or by shaded 
check boxes that cannot be selected.

Use Diagnostics for Windows in to determine if all the devices installed on the computer are 
recognized by the system and functioning properly. Running tests is optional but recommended 
after installing or connecting a new device.

Third party devices not supported by HP may not be detected by Diagnostics for Windows. Save, 
print, or display the information generated by the utility.
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2.3.1 Detecting Diagnostics for Windows
Some computers ship with the Diagnostics for Windows preloaded, but not preinstalled.

To determine whether Diagnostics for Windows is installed:

1. Access the location of the Diagnostics icons:

❏ In Windows 2000 Professional, select Start > Settings > Control Panel.

❏ In Windows XP Home or Windows XP Professional, select Start > Control Panel > 
Performance and Maintenance.

2. If icons for Configuration Record and Diagnostics for Windows are present, the Diagnostics 
for Windows utility is installed. If the icons are not present, the utility is either not preloaded 
or not installed. 

2.3.2 Installing Diagnostics for Windows 
If Diagnostics for Windows is not preloaded, you can download the Diagnostics for Windows 
SoftPaq from the following Web site:

http://www.hp.com/support/files

Once the software has been downloaded onto the hard drive it may be installed by performing 
these steps: 

1. Close all Windows applications.

2. Install the Diagnostics for Windows utility:

❏ In Windows XP, select Start > Software Setup icon. Select Diagnostics for Windows > 
Next button, then follow the instructions on the screen.

❏ In Windows 2000, select the Setup Software icon on the Desktop > Diagnostics for 
Windows > Next button, then follow the instructions on the screen.

❏ In either Windows XP or Windows 2000, if the Setup Software/Software Setup icon is 
not on the Desktop or in the Start menu, run the Setup program from the 
C:\CPQAPPS\DIAGS directory or select Start > Run and type the following in the 
command line: C:\CPQAPPS\DIAGS\SETUP.

3. Click Next to install Diagnostics for Windows.

4. After the program has finished installing, you may be prompted to restart the computer, or it 
may automatically restart. If prompted, click Finish to restart the computer or Cancel to exit 
the program. You must restart the computer to complete the installation of Diagnostics for 
Windows.

✎ If you want to upgrade an existing version of Diagnostics for Windows installed on the computer, 
visit http://www.hp.com/support/files and click on an applicable product. Locate the desired 
software and download the latest version. Execute the downloaded file and select Repair to 
update the installed version. This will cause the new version to overwrite the old version.
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2.3.3 Using Categories in Diagnostics for Windows 
To use categories:

1. Click Start > HP Information Center > Diagnostics for Windows. You can also select the 
Diagnostics for Windows icon, located in the Control Panel.

The screen displays the overview of the computer hardware and software.

❏ In Windows 2000 Professional, select Start > Settings > Control Panel, then select 
Diagnostics for Windows.

❏ In Windows XP Home and Windows XP Professional, select Start > Control Panel > 
Performance and Maintenance, then select Diagnostics for Windows.

2. For specific hardware and software information, select a category from the Categories 
pull-down menu or the appropriate icon on the toolbar.

✎ As the cursor moves over the toolbar icons, the corresponding category name is displayed.

3. To display more detailed information in a selected category, click More in the Information 
Level box in the lower left corner of the window or click Level at the top of the screen and 
select More.

4. Review, print, and/or save this information as desired.

❏ To print the information, click File > Print. Select one of the following options: 
Detailed Report (All Categories), Summary Report (All Categories), or Current 
Category. Click OK to print the report you selected.

❏ To save the information, click File > Save As. Select one of the following options: 
Detailed Report (All Categories), Summary Report (All Categories), or Current 
Category. Click OK to save the report you selected.

5. To exit Diagnostics for Windows, click File, and then click Exit.

Menu Bar—File, Categories, Navigation, Level, Tab, Help 
At the top of the Diagnostics for Windows screen is the Menu Bar consisting of six pull-down 
menus. Selecting an item will provide the following information on the system:

■ File—Save As, Print, Printer Setup, Exit

■ Categories

❏ System—System board, ROM, date, and time 

❏ Asset Control—Asset tag, system serial number, and processor 

❏ Input Devices—Keyboard, mouse, and joystick(s) 

❏ Communication—Ports 

❏ Storage—Storage drives

❏ Graphics—Graphics 

❏ Memory—System board and Windows memory 

❏ Multimedia—Optical storage (CD, DVD, and so on) and audio 

❏ Windows—Windows 

❏ Architecture—PCI Device 
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❏ Resources—IRQ, I/O, and Memory Map 

❏ Health—Status of system temperature and hard drives

❏ Miscellaneous—CMOS, DMI, BIOS, System, Product Name, and Serial Number

■ Navigation—Previous Category (F5), Next Category (F6)

■ Level—Less (F7), More (F8) <information on the screen>

■ Tab

❏ Overview—Displays general information about the computer. This window is displayed 
when first starting the utility. The left side of the window shows hardware information, 
while the right side shows software information.

❏ Test—Allows you to choose various parts of the system to test. You can also choose the 
type of test and testing mode.

❏ Status—Displays the status of each test in progress. You can cancel testing by clicking 
the Cancel Testing button.

❏ Log—Displays a log of tests for each device.

❏ Error—Displays any errors that occurred during device testing. The window lists the 
device being tested, the type and number of errors, and the error code.

■ Help—Contents, How to use Help, About

2.3.4 Running Diagnostic Tests in Diagnostics for Windows
To run diagnostic tests:

1. Click Start > HP Information Center > Diagnostics for Windows. 

Alternately, you can access Diagnostics for Windows via the control panel.

The screen displays the overview of the computer hardware and software. Five tabs are 
displayed below the row of icons: Overview, Test, Status, Log, and Error.

2. Click the Test tab, or click Tab at the top of the screen and select Test.

3. Select one of the following options:

❏ Quick Test—Runs a quick, general test on each device. Requires no user intervention if 
Unattended Mode is selected.

❏ Complete Test—Runs maximum testing of each device. The user can select Interactive 
Mode or Unattended Mode.

❏ Custom Test—Runs only the tests you select. To select specific devices or tests, find the 
device in the list, then select the check box beside each test. When selected, a red check 
mark is displayed in the box. Some tests selected may require user intervention.

✎ To test all subsystems, you must log in as the administrator. If you do not log in as the 
administrator, you will be unable to test some subsystems. The inability to test a subsystem will 
be indicated by an error message under the subsystem name in the Test window or by shaded 
boxes that cannot be checked.
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4. Select Interactive Mode or Unattended Mode. In Interactive Mode, the diagnostic software 
will prompt you for input during tests that require it. Some tests require interaction and will 
display errors or halt testing if selected in conjunction with Unattended Mode.

❏ Interactive Mode provides maximum control over the testing process. You determine 
whether the test passed or failed and may be prompted to insert or remove devices.

❏ Unattended Mode does not display prompts. If errors are found, they are displayed when 
testing is complete.

5. Click the Begin Testing button at the bottom of the window. Test Status is displayed, 
showing the progress and result of each test. For more details on the tests run, click the Log 
tab or click Tab at the top of the screen and select Log.

6. To view a test report, select one of three tabs: 

❏ Status—Summarizes the tests run, passed, and failed during the current testing session.

❏ Log—Lists tests run on the system, the numbers of times each test has run, the number 
of errors found on each test, and the total run time of each test.

❏ Error—Lists all errors found on the computer with their error codes.

7. To save a test report:

❏ Select the Log tab Save button to save a Log tab report.

❏ Select the Error tab Save button to save an Error tab report.

8. To print a test report:

❏ If the report is on the Log tab, select File > Save As, then print the file from the selected 
folder.

❏ If the report is on the Error tab, select the Error tab Print button.

9. If errors are found, click the Error tab to display more detailed information and 
recommended actions. 

10. Click Print or save the error information for future reference.

11. To exit Diagnostics for Windows, click File > Exit.

2.4 Configuration Record
The Configuration Record utility is a windows-based information-gathering tool that gathers 
critical hardware and software information from various computer subsystems. The information 
includes such things as the ROM, asset tag, processor, physical drives, PCI devices, memory, 
graphics, operating system version number, operating system parameters, and the operating 
system startup files to give a complete view of the computer. Configuration Record provides a 
means for automatically identifying and comparing configuration changes, and has the ability to 
maintain a configuration history. The information can be saved as a history of multiple sessions.

This utility allows the resolution of problems without taking the computer offline and assists in 
maximizing the computer availability. The information obtained by the utility is useful in 
troubleshooting system problems, and streamlines the service process by enabling quick and easy 
identification of system configurations.

The utility displays it findings in a Now.log file. If the original Base.log file is present in the 
cpqdiags directory, the Base.log file is displayed next to the Now.log file in a split window with 
the differences between the two highlighted in the color red.
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2.4.1 Installing Configuration Record 
The Configuration Record is part of Diagnostics for Windows and is automatically installed at 
the same time as Diagnostics for Windows.

2.4.2 Running Configuration Record
To run this program:

1. Click Start > HP Information Center > Configuration Record. 

Alternately, you can access Diagnostics for Windows via the control panel.

✎ The Configuration Record utility has two view options: Show Changed Items Only and Show 
All. The default view is Show Changed Items Only, therefore all the text is displayed in the 
color red since it shows only the differences. Switching to Show All displays the complete, 
comprehensive view of the system.

2. The default view is Show Changed Items Only. To view all the information gathered by 
Configuration Record, click View at the top of the window and select Show All, or click the 
Show All Items icon.

3. To save the information in the left or right window, select File > Save Window File and then 
select Left Window File or Right Window File.

✎ Saving the configuration of the computer periodically allows the user to keep a history of the 
configuration. This history may be useful to you in the future if the system ever encounters a 
problem that needs debugging.

4. To exit Configuration Record, click File, then click Exit.
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3
Desktop Management

HP Client Management Solutions provides standards-based solutions for managing and 
controlling desktops, workstations, and notebook PCs in a networked environment. 

The key capabilities and features of desktop management are:

■ Initial configuration and deployment

■ Remote system installation

■ Software updating and management

■ ROM flash

■ Asset tracking and security

■ Fault notification and recovery

✎ Support for specific features described in this guide may vary by model or software version.

3.1 Initial Configuration and Deployment
HP computers come with a preinstalled system software image. After a brief software 
“unbundling” process, the computer is ready to be used.

A customized software image may be deployed by: 

■ Installing additional software applications after unbundling the preinstalled software image.

■ Using software deployment tools, such as Altiris Deployment Solution, to replace the 
preinstalled software with a customized software image.

■ Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and 
processes. The PC Deployment section of the Solutions and Services Web site 
(http://whp-sp-orig.extweb.hp.com/country/us/en/solutions.html provides information to help 
you select the best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with 
recovery of system software, configuration management and troubleshooting, and power 
management.
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3.2 Remote System Installation
Remote System Installation allows you to start and set up your system using the software and 
configuration information located on a network server by initiating the Preboot Execution 
Environment (PXE). The Remote System Installation feature is usually used as a system setup 
and configuration tool, and can be used for the following tasks:

■ Formatting a hard drive.

■ Deploying a software image on one or more new PCs.

■ Remotely updating the system BIOS in flash ROM. See Section 3.3.7, “Remote ROM 
Flash.”

■ Configuring the system BIOS settings.

To initiate Remote System Installation, press F12 when the F12 = Network Service Boot 
message appears in the lower-right corner of the HP logo screen. Follow the instructions on the 
screen to continue the process. The default boot order is a BIOS configuration setting that can be 
changed to always attempt to PXE boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC 
deployment and management easier and less time-consuming, ultimately lowering the total cost 
of ownership and making HP PCs the most manageable client PCs in the enterprise environment. 

3.3 Software Updating and Management
HP provides several tools for managing and updating software on desktops and 
workstations—HP Client Manager Software, Altiris Client Management Solutions, System 
Software Manager; Proactive Change Notification; and Subscriber's Choice.

3.3.1 HP Client Manager Software
HP Client Manager Software (HP CMS) assists HP customers in managing the hardware aspects 
of their client computers with features that include:

■ Detailed views of hardware inventory for asset management

■ PC health check monitoring and diagnostics

■ Proactive notification of changes in the hardware environment

■ Web-accessible reporting of business critical details such as machines with thermal 
warnings, memory alerts, and more

■ Remote updating of system software such as device drivers and ROM BIOS

■ Remote changing of boot order

For more information on the HP Client Manager, visit 
http://h18000.www1.hp.com/im/client_mgr.html.
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3.3.2 Altiris Client Management Solutions
HP and Altiris have partnered to provide comprehensive, tightly integrated systems management 
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the 
foundation for additional Altiris Client Management Solutions that address:

■ Inventory and Asset Management

❏ SW license compliance

❏ PC tracking and reporting

❏ Lease contract, fixing asset tracking

■ Deployment and Migration

❏ Windows XP Professional migration

❏ System deployment

❏ Personality migrations

■ Help Desk and Problem Resolution

❏ Managing help desk tickets

❏ Remote troubleshooting

❏ Remote problem resolution

❏ Client disaster recovery

■ Software and Operations Management

❏ Ongoing desktop management

❏ HP system SW deployment

❏ Application self-healing

For more information and details on how to download a fully-functional 30-day evaluation 
version of the Altiris solutions, visit http://h18000.www1.hp.com/im/prodinfo.html#deploy.

On selected desktop and notebook models, an Altiris management agent is included as part of the 
factory loaded image. This agent enables communication with the Altiris development Solution 
which can be used to complete new hardware deployment or personality migration to a new OS 
using easy-to-follow wizards. Altiris solutions provide easy-to-use software distribution 
capabilities. When used in conjunction with System Software Manager (Section 3.3.3), or HP 
Client Manager Software, administrators can also update ROM BIOS and device driver software 
from a central console.

For more information, visit http://h18000.www1.hp.com/im/index.html.

3.3.3 System Software Manager
System Software Manager (SSM) is a utility that lets you update system-level software on 
multiple systems simultaneously. When executed on a PC client system, SSM detects both 
hardware and software versions, then updates the appropriate software from a central repository, 
also known as a file store. Driver versions that are supported by SSM are denoted with a special 
icon on the driver download Web site and on the Support Software CD. To download the utility 
or to obtain more information on SSM, visit 
http://www.hp.com/go/ssm.
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3.3.4 Proactive Change Notification (PCN)
The Proactive Change Notification program uses the Subscriber's Choice Web site in order to 
proactively and automatically:

■ Send you Proactive Change Notification (PCN) e-mails informing you of hardware and 
software changes to most commercial computers and servers, up to 60 days in advance.

■ Send you e-mail containing Customer Bulletins, Customer Advisories, Customer Notes, 
Security Bulletins, and Driver alerts for most commercial computers and servers.

You create your own profile to ensure that you only receive the information relevant to a specific 
IT environment. To learn more about the Proactive Change Notification program and create a 
custom profile, visit http://h30046.www3.hp.com/subhub.php?jumpid=go/pcn.

3.3.5 Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply 
you with personalized product tips, feature articles, and/or driver and support 
alerts/notifications. Subscriber’s Choice Driver and Support Alerts/Notifications will deliver 
e-mails notifying you that the information you subscribed to in your profile is available for 
review and retrieval. To learn more about Subscriber’s Choice and create a custom profile, visit 
http://h30046.www3.hp.com/subhub.php.

3.3.6 ROM Flash
The computer comes with a reprogrammable flash ROM (read only memory). By establishing a 
setup password in Computer Setup (F10) Utility, you can protect the ROM from being 
unintentionally updated or overwritten. This is important to ensure the operating integrity of the 
computer. Should you need or want to upgrade your ROM, you may:

■ Order an upgraded ROMPaq™ diskette from HP.

■ Download the latest ROMPaq images the HP driver and support page, 
http://www.hp.com/support/files.

CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password 
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to set 
the setup password on one or more PCs simultaneously. For more information, visit 
http://www.hp.com/go/ssm.

3.3.7 Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
computers directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely, on multiple computers and personal computers, 
results in a consistent deployment of and greater control over HP PC ROM images over the 
network. It also results in greater productivity and lower total cost of ownership.

✎ The computer must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager Software or 
System Software Manager at http://h18000.www1.hp.com/im/prodinfo.html.
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3.3.8 HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on individual PCs 
through a Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the name 
of the computer when prompted.

3.3.9 FailSafe Boot Block ROM
The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash 
failure, for example, if a power failure were to occur during a ROM upgrade. The Boot Block is 
a flash-protected section of the ROM that checks for a valid system ROM flash when power to 
the system is turned on.

■ If the system ROM is valid, the system starts normally.

■ If the system ROM fails the validation check, the FailSafe Boot Block ROM provides 
enough support to start the system from a ROMPaq diskette, which will program the system 
ROM with a valid image.

✎ Some models also support recovery from a ROMPaq CD. ISO ROMPaq images are included 
with selected models in the downloadable ROM softpaqs.

When the boot block detects an invalid system ROM, the System Power LED blinks RED 8 
times, one every second, followed by a 2-second pause. Also 8 simultaneous beeps will be heard. 
A Boot Block recovery mode message is displayed on the screen (some models). 

To recover the system after it enters Boot Block recovery mode, complete the following steps:

1. If there is a diskette in the diskette drive or a CD in the CD drive, remove the diskette and CD 
and turn off the power.

2. Insert a ROMPaq diskette into the diskette drive or, if permitted on this computer, a ROMPaq 
CD into the CD drive.

3. Turn on the computer.

If no ROMPaq diskette or ROMPaq CD is found, you will be prompted to insert one and 
restart the computer.

If a setup password has been established, the Caps Lock light will turn on and you will be 
prompted to enter the password.

4. Enter the setup password.

If the system successfully starts from the diskette and successfully reprograms the ROM, 
then the three keyboard lights will turn on. A rising tone series of beeps also signals 
successful completion.

5. Remove the diskette or CD and turn the power off.

6. Turn the power on again to restart the computer.
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The following table lists the various keyboard light combinations used by the Boot Block ROM 
(when a PS/2 keyboard is attached to the computer), and explains the meaning and action 
associated with each combination.

3.3.10 Replicating the Setup
The following procedures give an administrator the ability to easily copy one setup configuration 
to other computers of the same model. This allows for faster, more consistent configuration of 
multiple computers. 

✎ Both procedures require a diskette drive or a supported USB flash media device, such as an HP 
Drive Key.

Copying to Single Computer

Ä
CAUTION: A setup configuration is model-specific. File system corruption may result if source and target 
computers are not the same model. For example, do not copy the setup configuration from a dc7100 
Ultra-Slim Desktop to a dx6100 Slim Tower.

1. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click 
Start > Shut Down > Shut Down.

2. If you are using a USB flash media device, insert it now.

3. Turn on the computer.

4. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

5. If you are using a a diskette, insert it now.

Keyboard Light Combinations Used by Boot Block ROM 

Failsafe Boot 
Block Mode

Keyboard 
LED Color

Keyboard 
LED Activity State/Message

Num Lock Green On ROMPaq diskette or ROMPaq CD not 
present, is bad, or drive not ready.

Caps Lock Green On Enter password.

Num, Caps, 
Scroll Lock

Green Blink on in 
sequence, 
one-at-a-time— 
N, C, SL

Keyboard locked in network mode.

Num, Caps, 
Scroll Lock

Green On Boot Block ROM Flash successful. Turn 
power off, then on to reboot.

✎ Diagnostic lights do not flash on USB keyboards.
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6. Click File > Replicated Setup > Save to Removable Media. Follow the instructions on the 
screen to create the configuration diskette or USB flash media device.

7. Turn off the computer to be configured and insert the configuration diskette or USB flash 
media device.

8. Turn on the computer to be configured.

9. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

10. Click File > Replicated Setup > Restore from Removable Media, and follow the 
instructions on the screen.

11. Restart the computer when the configuration is complete.

Copying to Multiple Computers

Ä
CAUTION: A setup configuration is model-specific. File system corruption may result if source and target 
computers are not the same model. For example, do not copy the setup configuration from a dc7100 
Ultra-Slim Desktop to a dx6100 Slim Tower.

This method takes a little longer to prepare the configuration diskette or USB flash media device, 
but copying the configuration to target computers is significantly faster.

✎ A bootable diskette is required for this procedure or to create a bootable USB flash media device. 
If Windows XP is not available to use to create a bootable diskette, use the method for copying to 
a single computer instead (see “Copying to Single Computer” on page 6).

1. Create a bootable diskette or USB flash media device. See “Supported USB Flash Media 
Device” on page 8 or “Unsupported USB Flash Media Device” on page 10.

Ä
CAUTION: Not all computers can be booted from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be booted 
from a USB flash media device. Otherwise, a bootable diskette must be used.

2. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click 
Start > Shut Down > Shut Down.

3. If you are using a USB flash media device, insert it now.

4. Turn on the computer.

5. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

6. If you are using a a diskette, insert it now.

7. Click File > Replicated Setup > Save to Removable Media. Follow the instructions on the 
screen to create the configuration diskette or USB flash media device.
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8. Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration 
diskette or USB flash media device. To obtain this utility, go to 
http://welcome.hp.com/support/files and enter the model number of the computer.

9. On the configuration diskette or USB flash media device, create an autoexec.bat file 
containing the following command:

repset.exe

10. Turn off the computer to be configured. Insert the configuration diskette or USB flash media 
device and turn the computer on. The configuration utility will run automatically.

11. Restart the computer when the configuration is complete.

Creating a Bootable Device

Supported USB Flash Media Device

Supported devices, such as an HP Drive Key or a DiskOnKey, have a preinstalled image to 
simplify the process of making them bootable. If the USB flash media device being used does not 
have this image, use the procedure later in this section (see “Unsupported USB Flash Media 
Device” on page 10).

Ä
CAUTION: Not all computers can be booted from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be booted 
from a USB flash media device. Otherwise, a bootable diskette must be used.

To create a bootable USB flash media device, you must have:

■ One of the following systems:

❏ HP Compaq Business Desktop dc7100 series

❏ HP Compaq Business Desktop dx6100 series

❏ HP Compaq Business Desktop d530 Series - Ultra-Slim Desktop, Small Form Factor, or 
Convertible Minitower

❏ Compaq Evo D510 Ultra-slim Desktop

❏ Compaq Evo D510 Convertible Minitower/Small Form Factor

Depending on the individual BIOS, future systems may also support booting to a USB flash 
media device.

Ä
CAUTION: If you are using a computer other than one named above, make sure the default boot order 
in the Computer Setup (F10) Utility lists the USB device before the hard drive.

■ One of the following storage modules:

❏ 16MB HP Drive Key

❏ 32MB HP Drive Key

❏ 32MB DiskOnKey

❏ 64MB HP Drive Key

❏ 64MB DiskOnKey

❏ 128MB HP Drive Key

❏ 128MB DiskOnKey
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❏ 256MB HP Drive Key

❏ 256MB DiskOnKey

■ A bootable DOS diskette with the FDISK and SYS programs. If SYS is not available, 
FORMAT may be used, but all existing files on the USB flash media device will be lost.

1. Turn off the computer.

2. Insert the USB flash media device into one of the computer's USB ports and remove all other 
USB storage devices except USB diskette drives.

3. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

4. Run FDISK from the A:\ prompt by typing FDISK and pressing Enter. If prompted, click Yes 
(Y) to enable large disk support.

5. Enter Choice [5] to display the drives in the system. The USB flash media device will be the 
drive that closely matches the size of one of the drives listed. It will usually be the last drive 
in the list. Note the letter of the drive.

USB flash media device drive: __________

Ä
CAUTION:   If a drive does not match the USB flash media device, do not proceed. Data loss can occur. 
Check all USB ports for additional storage devices. If any are found, remove them, reboot the computer, 
and proceed from step 4. If none are found, either the system does not support the USB flash media 
device or the USB flash media device is defective. DO NOT proceed in attempting to make the USB flash 
media device bootable.

6. Exit FDISK by pressing the Esc key to return to the A:\ prompt.

7. If your bootable DOS diskette contains SYS.COM, go to step 8. Otherwise, go to step 9.

8. At the A:\ prompt, enter SYS x: where x represents the drive letter noted above.

Ä
CAUTION:   Be sure that you have entered the correct drive letter for the USB flash media device.

After the system files have been transferred, SYS will return to the A:\ prompt. Go to 
step 13.

9. Copy any files you want to keep from your USB flash media device to a temporary directory 
on another drive (for example, the system's internal hard drive).

10. At the A:\ prompt, enter FORMAT /S X: where X represents the drive letter noted before.

Ä
CAUTION:  Be sure that you have entered the correct drive letter for the USB flash media device.

FORMAT will display one or more warnings and ask you each time whether you want to 
proceed. Enter Y each time. FORMAT will format the USB flash media device, add the 
system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Copy any files you saved in step 9 back to your USB flash media device.

13. Remove the diskette and reboot the computer. The computer will boot to the USB flash 
media device as drive C.
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✎ The default boot order varies from computer to computer, and it can be changed in the Computer 
Setup (F10) Utility. 
 
If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

Return to “Copying to Multiple Computers” on page 7.

Unsupported USB Flash Media Device

Ä
CAUTION: Not all computers can be booted from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be booted 
from a USB flash media device. Otherwise, a bootable diskette must be used.

To create a bootable USB flash media device, you must have:

■ One of the following systems:

❏ HP Compaq Business Desktop dc7100 series

❏ HP Compaq Business Desktop dx6100 series

❏ HP Compaq Business Desktop d530 Series—Ultra-Slim Desktop, Small Form Factor, or 
Convertible Minitower

❏ Compaq Evo D510 Ultra-Slim Desktop

❏ Compaq Evo D510 Convertible Minitower/Small Form Factor

Depending on the individual BIOS, future systems may also support booting to a USB flash 
media device.

Ä
CAUTION: If you are using a computer other than one named above, make sure the default boot order 
in the Computer Setup (F10) Utility lists the USB device before the hard drive.

■ A bootable DOS diskette with the FDISK and SYS programs. If SYS is not available, 
FORMAT may be used, but all existing files on the USB flash media device will be lost.

1. If there are any PCI cards in the system that have SCSI, ATA RAID or SATA drives attached, 
turn off the computer and unplug the power cord.

Ä
CAUTION: The power cord MUST be unplugged.

2. Open the computer and remove the PCI cards.

3. Insert the USB flash media device into one of the computer's USB ports and remove all other 
USB storage devices except USB diskette drives. Close the computer cover.

4. Plug in the power cord and turn on the computer.
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5. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

6. Go to Advanced > PCI Devices to disable both the PATA and SATA controllers. When 
disabling the SATA controller, note the IRQ to which the controller is assigned. You will 
need to reassign the IRQ later. Exit setup, confirming the changes.

SATA IRQ: __________

7. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

8. Run FDISK and delete any existing partitions on the USB flash media device. Create a new 
partition and mark it active. Exit FDISK by pressing the Esc key.

9. If the system did not automatically restart when exiting FDISK, press Ctrl+Alt+Del to 
reboot to the DOS diskette.

10. At the A:\ prompt, type FORMAT C: /S and press Enter. Format will format the USB flash 
media device, add the system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Turn off the computer and unplug the power cord. Open the computer and re-install any PCI 
cards that were previously removed. Close the computer cover.

13. Plug in the power cord, remove the diskette, and turn on the computer.

14. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

15. Go to Advanced > PCI Devices and re-enable the PATA and SATA controllers that were 
disabled in step 6. Put the SATA controller on its original IRQ.

16. Save the changes and exit. The computer will boot to the USB flash media device as drive C.

✎ The default boot order varies from computer to computer, and it can be changed in the Computer 
Setup (F10) Utility. Refer to the Computer Setup Guide on the Documentation CD for 
instructions. 
 
If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

Return to “Copying to Multiple Computers” on page 7.
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3.3.11 Dual-State Power Button
With Advanced Configuration and Power Interface (ACPI) enabled, the power button can 
function either as an on/off switch or as a suspend button. The suspend feature does not 
completely turn off power, but instead causes the computer to enter a low-power standby. This 
allows you to power down quickly without closing applications and to return quickly to the same 
operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Power Options.

2. In the Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Stand by.

After configuring the power button to function as a suspend button, press the power button to put 
the system in a very low power state (standby). Press the button again to bring the system out of 
suspend to full power status quickly. To completely turn off all power to the system, press and 
hold the power button for four seconds.

Ä
CAUTION: Do not use the power button to turn off the computer unless the system is not responding; 
turning off the power without operating system interaction could cause damage to or loss of data on the 
hard drive.

3.3.12 World Wide Web Site
When making the transition to new or revised operating systems, it is important to implement the 
support software designed for that operating system. If you plan to run a version of Microsoft 
Windows that is different from the version included with the computer, you must install 
corresponding device drivers and utilities to ensure that all features are supported and 
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from http://www.hp.com/support. The Web site contains 
the latest device drivers, utilities, and flashable ROM images needed to run the latest Microsoft 
Windows operating system on the HP computer.

3.3.13 Building Blocks and Partners
HP management solutions integrate with other systems management applications, and are based 
on industry standards, such as:

■ Web-Based Enterprise Management (WBEM)

■ Windows Management Interface (WMI)

■ Wake on LAN Technology

■ ACPI

■ SMBIOS

■ Pre-boot Execution (PXE) support
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3.4 Asset Tracking and Security
Asset tracking features incorporated into the computer provide key asset tracking data that can be 
managed using HP Insight Manager, HP Client Manager or other system management 
applications. Seamless, automatic integration between asset tracking features and these products 
enables you to choose the management tool that is best suited to your environment and to 
leverage your investment in existing tools. 

HP also offers several solutions for controlling access to valuable components and information. 
ProtectTools Embedded Security, if installed, prevents unauthorized access to data and checks 
system integrity and authenticates third-party users attempting system access. (Refer to HP 
ProtectTools Embedded Security Guide, on the Documentation CD for more information.) 
Security features such as ProtectTools, the Smart Cover Sensor and the Smart Cover Lock, 
available on select models, help to prevent unauthorized access to the internal components of the 
personal computer. By disabling parallel, serial, or USB ports, or by disabling removable media 
boot capability, you can protect valuable data assets. Memory Change and Smart Cover Sensor 
alerts can be automatically forwarded to system management applications to deliver proactive 
notification of tampering with a computer’s internal components.

✎ ProtectTools, the Smart Cover Sensor, and the Smart Cover Lock are available as options on 
select systems.

Use the following utilities to manage security settings on your HP computer:

■ Locally, using the Computer Setup Utilities. See the Computer Setup (F10) Utility Guide 
included with the computer for additional information and instructions on using the 
Computer Setup Utilities.

■ Remotely, using HP Client Manager Software or System Software Manager. This software 
enables the secure, consistent deployment and control of security settings from a simple 
command-line utility.

Computer Setup Utilities (F10) Security Features  

Feature Description

Setup Password Allows you to set and enable setup (administrator) password.

✎ If the setup password is set, it is required to change 
Computer Setup options, flash the ROM, and make changes 
to certain plug and play settings under Windows.

See the Troubleshooting Guide on the Documentation CD for 
more information.

Power-On Password Allows you to set and enable power-on password.
See the Troubleshooting Guide on the Documentation CD for 
more information.

Password Options
(This selection will appear only 
if a power-on password is set.)

Allows you to specify whether the password is required for 
warm boot (CTRL+ALT+DEL).
See the Desktop Management Guide on the Documentation 
CD for more information.

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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Pre-Boot Authorization Allows you to enable/disable the Smart Card to be used in 
place of the Power-On Password.

Smart Cover Allows you to:
• Enable/disable the Cover Lock.
• Enable/disable the Cover Removal Sensor.

✎ Notify User alerts the user that the sensor has detected that 
the cover has been removed. Setup Password requires that 
the setup password be entered to boot the computer if the 
sensor detects that the cover has been removed.

This feature is supported on select models only. See the 
Desktop Management Guide on the Documentation CD for 
more information.

Embedded Security Allows you to:
• Enable/disable the Embedded Security device.
• Reset the device to Factory Settings.

This feature is supported on select models only.  
See HP ProtectTools Embedded Security Guide, on the 
Documentation CD for more information.

Device Security Enables/disables serial ports, parallel port, front USB ports, 
system audio, network controllers (some models), MultiBay 
devices (some models), and SCSI controllers (some models).

Network Service Boot Enables/disables the computer’s ability to boot from an 
operating system installed on a network server. (Feature 
available on NIC models only; the network controller must 
reside on the PCI bus or be embedded on the system board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte 

identifier displayed during POST). 
 
See the Desktop Management Guide on the 
Documentation CD for more information.

• Chassis serial number or Universal Unique Identifier 
(UUID) number. The UUID can only be updated if the 
current chassis serial number is invalid. (These ID numbers 
are normally set in the factory and are used to uniquely 
identify the system.)

Keyboard locale setting (for example, English or German) for 
System ID entry.

Computer Setup Utilities (F10) Security Features  (Continued)

Feature Description

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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DriveLock Allows you to assign or modify a master or user password for 
MultiBay hard drives (not supported on SCSI hard drives). 
When this feature is enabled, the user is prompted to provide 
one of the DriveLock passwords during POST. If neither is 
successfully entered, the hard drive will remain inaccessible 
until one of the passwords is successfully provided during a 
subsequent cold-boot sequence.

✎ This selection will only appear when at least one MultiBay 
drive that supports the DriveLock feature is attached to the 
system.

See the Desktop Management Guide on the Documentation 
CD for more information.

Master Boot Record Security Allows you to enable or disable Master Boot Record (MBR) 
Security.
When enabled, the BIOS rejects all requests to write to the 
MBR on the current bootable disk. Each time the computer is 
powered on or rebooted, the BIOS compares the MBR of the 
current bootable disk to the previously-saved MBR. If changes 
are detected, you are given the option of saving the MBR on 
the current bootable disk, restoring the previously-saved MBR, 
or disabling MBR Security. You must know the setup password, 
if one is set.

✎ Disable MBR Security before intentionally changing the 
formatting or partitioning of the current bootable disk. 
Several disk utilities (such as FDISK and FORMAT) attempt 
to update the MBR.
If MBR Security is enabled and disk accesses are being 
serviced by the BIOS, write requests to the MBR are 
rejected, causing the utilities to report errors.

If MBR Security is enabled and disk accesses are being 
serviced by the operating system, any MBR change will be 
detected by the BIOS during the next reboot, and an MBR 
Security warning message will be displayed.

Computer Setup Utilities (F10) Security Features  (Continued)

Feature Description

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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Save Master Boot Record Saves a backup copy of the Master Boot Record of the current 
bootable disk.
Only appears if MBR Security is enabled.

Restore Master Boot Record Restores the backup Master Boot Record to the current 
bootable disk.

✎ Only appears if all of the following conditions are true:

•MBR Security is enabled.
•A backup copy of the MBR has been previously saved.
•The current bootable disk is the same disk from which the 

backup copy of the MBR was saved.

Ä CAUTION: Restoring a previously saved MBR after a disk 
utility or the operating system has modified the MBR may 
cause the data on the disk to become inaccessible. Only 
restore a previously saved MBR if you are confident that the 
current bootable disk’s MBR has been corrupted or infected 
with a virus.

Computer Setup Utilities (F10) Security Features  (Continued)

Feature Description

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.

Mechanical Security Features  

Feature Purpose How It Is Established

Memory Change Alerts Detects when memory modules 
have been added, moved, or 
removed; notifies user and 
system administrator.

For information on enabling 
Memory Change Alerts, refer 
to the online Desktop 
Management Guide on the 
Documentation CD.

Cable Lock Provision Inhibits access to the interior of 
the computer to prevent 
unwanted configuration 
changes or component 
removal. Can also be used to 
secure the computer to a fixed 
object to prevent theft.

Install a cable lock to secure 
the computer to a fixed 
object.

Security Loop Provision Inhibits access to the interior of 
the computer to prevent 
unwanted configuration 
changes or component 
removal.

Install a lock in the security 
loop to prevent unwanted 
configuration changes or 
component removal.
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3.4.1 Password Security
The power-on password prevents unauthorized use of the computer by requiring entry of a 
password to access applications or data each time the computer is turned on or restarted. The 
setup password specifically prevents unauthorized access to Computer Setup, and can also be 
used as an override to the power-on password. That is, when prompted for the power-on 
password, entering the setup password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to 
all network systems to perform maintenance without having to know the power-on password, 
even if one has been established.

3.4.2 Establishing a Setup Password Using Computer Setup
If the system is equipped with an embedded security device, refer to HP ProtectTools Embedded 
Security Guide, on the Documentation CD. Establishing a setup password through Computer 
Setup prevents reconfiguration of the computer (use of the Computer Setup (F10) utility) until 
the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

3.4.3 Establishing a Power-On Password Using Computer Setup
Establishing a power-on password through Computer Setup prevents access to the computer 
when power is turned on, unless the password is entered. When a power-on password is set, 
Computer Setup presents Password Options under the Security menu. Password options include 
Password Prompt on Warm Boot. When Password Prompt on Warm Boot is enabled, the 
password must also be entered each time the computer is rebooted. 

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.
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Entering a Power-On Password
To enter a power-on password, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart. 

2. When the key icon appears on the monitor, type your current password, then press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.

Entering a Setup Password
If the system is equipped with an embedded security device, refer to HP ProtectTools Embedded 
Security Guide, on the Documentation CD.

If a setup password has been established on the computer, you will be prompted to enter it each 
time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart. 

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears on the monitor, type the setup password, then press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.

Changing a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to HP ProtectTools Embedded 
Security Guide, on the Documentation CD.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart 
the Computer. 

2. To change the Power-On password, go to step 3.

To change the Setup password, as soon as the computer is turned on, press and hold the F10 
key until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.
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3. When the key icon appears, type the current password, a slash (/) or alternate delimiter 
character, the new password, another slash (/) or alternate delimiter character, and the new 
password again as shown: 
current password/new password/new password

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

4. Press Enter.

5. The new password takes effect the next time you turn on the computer.

✎ Refer to “National Keyboard Delimiter Characters” for information about the alternate delimiter 
characters. The power-on password and setup password may also be changed using the Security 
options in Computer Setup.

Deleting a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to HP ProtectTools Embedded 
Security Guide, on the Documentation CD.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart 
the Computer. 

2. To delete the Power-On password, go to step 3.

To delete the Setup password, as soon as the computer is turned on, press and hold the F10 
key until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears, type the current password followed by a slash (/) or alternate 
delimiter character as shown: 
current password/

4. Press Enter.

✎ Refer to “National Keyboard Delimiter Characters” on page 20 for information about the 
alternate delimiter characters. The power-on password and setup password may also be changed 
using the Security options in Computer Setup.
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National Keyboard Delimiter Characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you 
use for changing or deleting your password depend on the keyboard that came with your 
computer.

Clearing Passwords 
If you forget the password, you cannot access the computer. Refer to the Troubleshooting Guide 
on the Documentation CD for instructions on clearing passwords.

If the system is equiped with an embedded security device, refer to HP ProtectTools Embedded 
Security Guide, on the Documentation CD.

3.4.4 DriveLock
DriveLock is an industry-standard security feature that prevents unauthorized access to the data 
on specific hard drives. DriveLock has been implemented as an extension to Computer Setup. It 
is only available on certain systems and only when DriveLock-capable hard drives are detected. 

DriveLock is intended for HP customers for whom data security is the paramount concern. For 
such customers, the cost of the hard drive and the loss of the data stored on it is inconsequential 
when compared with the damage that could result from unauthorized access to its contents. In 
order to balance this level of security with the practical need to accommodate a forgotten 
password, the HP implementation of DriveLock employs a two-password security scheme. One 
password is intended to be set and used by a system administrator while the other is typically set 
and used by the end-user. There is no “back-door” that can be used to unlock the drive if both 
passwords are lost. Therefore, DriveLock is most safely used when the data contained on the 
hard drive is replicated on a corporate information system or is regularly backed up.

In the event that both DriveLock passwords are lost, the hard drive is rendered unusable. For 
users who do not fit the previously defined customer profile, this may be an unacceptable risk. 
For users who do fit the customer profile, it may be a tolerable risk given the nature of the data 
stored on the hard drive.

National Keyboard Delimiter Characters
Arabic / Greek - Russian /
Belgian = Hebrew . Slovakian -
BHCSY* - Hungarian - Spanish -
Brazilian / Italian - Swedish/Finnish /
Chinese / Japanese / Swiss -
Czech - Korean / Taiwanese /
Danish - Latin American - Thai /
French ! Norwegian - Turkish .
French Canadian é Polish - U.K. English /
German - Portuguese - U.S. English /
* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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Using DriveLock
The DriveLock option appears under the Security menu in Computer Setup. The user is 
presented with options to set the master password or to enable DriveLock. A user password must 
be provided in order to enable DriveLock. Since the initial configuration of DriveLock is 
typically performed by a system administrator, a master password should be set first. HP 
encourages system administrators to set a master password whether they plan to enable 
DriveLock or keep it disabled. This will give the administrator the ability to modify DriveLock 
settings if the drive is locked in the future. Once the master password is set, the system 
administrator may enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a 
power-on password is set and it matches the device’s user password, POST will not prompt the 
user to re-enter the password. Otherwise, the user will be prompted to enter a DriveLock 
password. Either the master or the user password may be used. Users will have two attempts to 
enter a correct password. If neither attempt succeeds, POST will continue but the drive will 
remain inaccessible.

DriveLock Applications
The most practical use of the DriveLock security feature is in a corporate environment where a 
system administrator provides users with multibay hard drives for use in some computers. The 
system administrator would be responsible for configuring the multibay hard drive which would 
involve, among other things, setting the DriveLock master password. In the event that the user 
forgets the user password or the equipment is passed on to another employee, the master 
password can always be used to reset the user password and regain access to the hard drive.

HP recommends that corporate system administrators who choose to enable DriveLock also 
establish a corporate policy for setting and maintaining master passwords. This should be done to 
prevent a situation where an employee intentionally or unintentionally sets both DriveLock 
passwords before leaving the company. In such a scenario, the hard drive would be rendered 
unusable and require replacement. Likewise, by not setting a master password, system 
administrators may find themselves locked out of a hard drive and unable to perform routine 
checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. 
Users in this category include personal users or users who do not maintain sensitive data on their 
hard drives as a common practice. For these users, the potential loss of a hard drive resulting 
from forgetting both passwords is much greater than the value of the data DriveLock has been 
designed to protect. Access to Computer Setup and DriveLock can be restricted through the 
Setup password. By specifying a Setup password and not giving it to end users, system 
administrators are able to restrict users from enabling DriveLock.
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3.4.5 Smart Cover Sensor
Cover Removal Sensor, available on select models, is a combination of hardware and software 
technology that can alert you when the computer cover or side panel has been removed. There are 
three levels of protection, as described in the following table. 

Setting the Smart Cover Sensor Protection Level
To set the Smart Cover Sensor protection level, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Smart Cover > Cover Removal Sensor, and select the desired security 
level.

4. Before exiting, click File > Save Changes and Exit.

Smart Cover Lock
The Smart Cover Lock is a software-controllable cover lock featured on select HP computers. 
This lock prevents unauthorized access to the internal components. Computers ship with the 
Smart Cover Lock in the unlocked position.

Ä
CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup password 
prevents unauthorized access to the Computer Setup utility.

✎ The Smart Cover Lock is available as an option on select systems.

Smart Cover Sensor Protection Levels

Level Setting Description

Level 0 Disabled Smart Cover Sensor is disabled (default).

Level 1 Notify User When the computer is restarted, the screen 
displays a message indicating that the 
computer cover or side panel has been 
removed.

Level 2 Setup Password When the computer is restarted, the screen 
displays a message indicating that the 
computer cover or side panel has been 
removed. You must enter the setup 
password to continue.

✎ These settings can be changed using Computer Setup. For more information about Computer 
Setup, see the Computer Setup (F10) Utility Guide.
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Locking the Smart Cover Lock
To activate and lock the Smart Cover Lock, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Smart Cover > Cover Lock > Lock option.

4. Before exiting, click File > Save Changes and Exit.

Unlocking the Smart Cover Lock
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Smart Cover > Cover Lock > Unlock.

4. Before exiting, click File > Save Changes and Exit.

Using the Smart Cover FailSafe Key
If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will 
need a Smart Cover FailSafe Key to open the computer cover. You will need the key in any of the 
following circumstances:

■ Power outage

■ Startup failure

■ PC component failure (such as processor or power supply)

■ Forgotten password

Ä
CAUTION: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order 
this key before you need one (Tamper-resistant wrench PN 166527-001 or tamper-resistant bits PN 
166527-002).

To obtain the FailSafe Key, do any one of the following:

■ Contact an authorized HP reseller or service provider.

■ Call the appropriate number listed in the warranty.

For more information about using the Smart Cover FailSafe Key, consult the Hardware 
Reference Guide.
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3.4.6 Master Boot Record Security
The Master Boot Record (MBR) contains information needed to successfully boot from a disk 
and to access the data stored on the disk. Master Boot Record Security may prevent unintentional 
or malicious changes to the MBR, such as those caused by some computer viruses or by the 
incorrect use of certain disk utilities. It also allows you to recover the “last known good” MBR, 
should changes to the MBR be detected when the system is restarted.

To enable MBR Security, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Master Boot Record Security > Enabled.

4. Select Security > Save Master Boot Record.

5. Before exiting, click File > Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the 
current bootable disk while in MS-DOS or Windows Safe Mode. 

✎ Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that may occur while the operating system is running.

Each time the computer is turned on or restarted, the BIOS compares the MBR of the current 
bootable disk to the previously saved MBR. If changes are detected and if the current bootable 
disk is the same disk from which the MBR was previously saved, the following message is 
displayed:

1999—Master Boot Record has changed.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must

■ Save the MBR of the current bootable disk;

■ Restore the previously saved MBR; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists.

If changes are detected and if the current bootable disk is not the same disk from which the MBR 
was previously saved, the following message is displayed:

2000—Master Boot Record Hard Drive has changed.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must 

■ Save the MBR of the current bootable disk; or

■ Disable the MBR Security feature.
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You must know the setup password, if one exists.

In the unlikely event that the previously saved MBR has been corrupted, the following message is 
displayed:

1998—Master Boot Record has been lost.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must 

■ Save the MBR of the current bootable disk; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists.

3.4.7 Before You Partition or Format the Current Bootable Disk
Ensure that MBR Security is disabled before you change partitioning or formatting of the current 
bootable disk. Some disk utilities, such as FDISK and FORMAT, attempt to update the MBR. If 
MBR Security is enabled when you change partitioning or formatting of the disk, you may 
receive error messages from the disk utility or a warning from MBR Security the next time the 
computer is turned on or restarted. To disable MBR Security, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Master Boot Record Security > Disabled.

4. Before exiting, click File > Save Changes and Exit.

3.4.8 Cable Lock Provision
The rear panel of the computer accommodates a cable lock so that the computer can be 
physically secured to a work area.

For illustrated instructions, please see the Removal and Replacement Chapter for the specific 
chassis.

3.4.9 Fingerprint Identification Technology
Eliminating the need to enter user passwords, HP Fingerprint Identification Technology tightens 
network security, simplifies the login process, and reduces the costs associated with managing 
corporate networks. Affordably priced, it is not just for high-tech, high-security organizations 
anymore. 

✎ Support for Fingerprint Identification Technology varies by model.

For more information, visit http://h18004.www1.hp.com/products/security.
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3.5 Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology 
to prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network managed by HP Client Manager, the computer sends a 
fault notice to the network management application. With HP Client Manager Software, you can 
also remotely schedule diagnostics to automatically run on all managed PCs and create a 
summary report of failed tests.

3.5.1 Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in 
select HP computers. DPS is designed to help diagnose problems that might result in 
unwarranted hard drive replacement. 

When HP computers are built, each installed hard drive is tested using DPS, and a permanent 
record of key information is written onto the drive. Each time DPS is run, test results are written 
to the hard drive. Your service provider can use this information to help diagnose conditions that 
caused you to run the DPS software. Refer to the Troubleshooting Guide for instructions on using 
DPS.

3.5.2 Surge-Tolerant Power Supply
An integrated surge-tolerant power supply provides greater reliability when the computer is hit 
with an unpredictable power surge. This power supply is rated to withstand a power surge of up 
to 2000 volts without incurring any system downtime or data loss.

3.5.3 Thermal Sensor
The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
computer. This feature displays a warning message when the normal range is exceeded, which 
gives you time to take action before internal components are damaged or data is lost.
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4
Serial and Parallel ATA Drive Guidelines and 

Features

✎ Serial ATA = SATA 
Parallel ATA = PATA 
 
HP does not support the use of PATA (IDE) hard drives when SATA hard drives are installed on 
the computer.

4.1 SATA and PATA Device Information

SATA connectors on the system board are color coded to make identification easier.

Characteristic SATA PATA

Number of pins/conductors in data cable 7/7 40/80

Number of pins in power cable 15 4

Maximum data cable length 39.37 in (100 cm) 18 in (45.7 cm)

Data interface voltage differential 600 mV 5 V

Drive motor voltages 3.3 V, 12 V 5 V, 12 V

Jumpers for configuring drive N/A Required

Data transfer rate 150 MB/s up to 100 MB/s

SATA Identification Color

Primary channel, device 0 Dark blue

Primary channel, device 1 Light Blue 

Secondary channel, device 0 White

Secondary channel, device 1 Orange
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4.2 ATA Cables

4.2.1 SATA Data Cable
The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As 
shown in the table, each cable has 3 grounds, and 4 transmit/receive pins.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and 
never bend it tighter than a 30 mm (1.18 in) radius. 

4.2.2 SATA Power Cable

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2* A+ Transmit data Receive data

P3* A- Transmit data Receive data

P4 Ground Ground Ground

P5** B- Receive data Transmit data

P6** B+ Receive data Transmit data

P7 Ground Ground Ground

*P2 and P3 differential signal pair
**P5 and P6 differential signal pair

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5 V power

P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3 V power P11 Reserved

P4 Ground P12 Ground

P5 Ground P13 V 12 12 V power

P6 Ground P14 V12 12 V power

P7 V5 5 V power P15 V12 12 V power

P8 V5 5 V power
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4.2.3 PATA Data Cable

4.2.4 PATA Power Cable

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
 

Pin Usage

1 +12 V

2 Ground

3 Ground

4 +5 V
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4.2.5 PATA Cable Layout
The faces of industry-standard cable connectors are color-coded for easy recognition:

■ System board connector = blue face

■ Device 0 connector = black face

■ Device 1 connector = gray face

✎ The color code of an industry-standard cable is applicable only if the drive’s jumper is in the 
cable-select position.

Single-Drive Cable

Two-Drive Cable

On a two-drive cable, the Drive/Device 0 connector is always the farthest one from the system 
board connector and the Drive/Device 1 connector is always the closest to the system board 
connector. 

✎ Some cables may be labeled “Drive 0” instead of “Device 0” and “Drive 1” instead of 
“Device 1”. 

System 
Board

Device 0

Black 
Face

Blue 
Face

System 
Board

Device 1 Device 0

Black 
Face

Blue 
Face

Gray 
Face
4–4 361288-003 Service Reference Guide, dc7100



Serial and Parallel ATA Drive Guidelines and Features
4.3 PATA Drive Installation Guidelines
Most computer system boards have two or fewer Parallel ATA (PATA) channels with a dedicated 
connector for each channel. When two channels are present, one is designated as the Primary and 
the other as the Secondary Channel. 

Each of the two channels can have up to two devices attached to it. All drives are connected to a 
channel using an industry-standard 80-conductor cable.

✎ The industry standard 1.44 MB diskette drive has its own separate channel and is not included as 
a part of the maximum four drives. 
 
HP does not support the use of PATA (IDE) hard drives when SATA hard drives are installed on 
the computer.

Each drive attached to a channel must have a drive designation. If a drive is attached to the 
Device 0 cable position and its cable-select jumper is present, the drive is designated as Device 0. 
Similarly, if a drive is attached to the Device 1 cable position and its cable-select jumper is 
present, the drive is designated as Device 1.

For optimal performance of a computer system, all drives need to be attached to the PATA 
channel(s) in a specified sequence. This sequence is determined by the device class of the drives 
and by specific attach sequence rules.

4.3.1 PATA Device Classes
In order to determine the best drive attach sequence, ATA/ATAPI drives are segregated into four 
different classes based upon the bandwidth demands they place on an ATA channel. The most 
demanding devices are in Class 1 and the least demanding are in Class 4.

General Attach Guidelines
■ The lower the device class number, the faster the device and the more bandwidth required. 

■ Drives installed in the Device 0 positions on both the primary and secondary channels 
receive the greatest possible bandwidth.

■ The bootable ATA hard drive should always be installed on the primary channel in the 
Device 0 position.

Class 1 
Hard 
Drives

Class 2 
High Speed 

Optical Drives

Class 3
Optical Storage 

Drives

Class 4
Magnetic 

Storage Drives

ATA-100 
ATA-66 
ATA-33

DVD 
DVD-CD R/W

R/W CD-ROM  
CD-ROM 

LS-120 
Tape  
Zip 
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4.3.2 PATA Attach Sequence Rules by Class Priority
Drives should be attached in the sequence shown for optimum performance starting at 
position 1.

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary channel first before following the General Attach Sequence Rule. 

The attach sequence rule may also be stated in table format:

✎ Cable lengths may restrict drive usage.

The rules allow for:

■ Keeping the hard drive on a separate channel to maximize drive performance until a fourth 
device is added.

■ Keeping the hard drives and removable media drives on separate channels to maximize 
compatibility.

■ Keeping the hard drive and the writable optical drive on separate channels to maximize 
optical drive reliability.

General Attach Sequence Rule*

Sequence Description

1 The lowest class drive—bootable hard drive recommended.

2 If only two drives, the last drive goes here; otherwise the lowest class of the 
remaining drives.

3 If only three drives, attach the final drive here. If a fourth drive exists, attach the 
lowest class drive here.

4 If there is a fourth drive, attach the final drive here—the drive with the highest 
class number of all devices. 

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary controller first before following the General Attach Sequence Rule. 

1

2

4

3

Primary 
Channel*

4 1

Secondary 
Channel

3 2

Device 1 Device 0
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4.3.3 PATA Attach Sequence Worksheet
Use the worksheet below for obtaining optimum system performance when setting up a computer 
with multiple drives. Use the General Attach Sequence Rule to determine the best drive 
installation sequence.

Two examples of how to use the worksheet are:

■ Three-device installation

■ Four-device installation

Attach Sequence Worksheet

Device Name Device Class
Position 
Number

Channel 
Name

Device 
Number
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Example 1: Three-Device Installation Sample
A system has three devices: Ultra ATA-100 hard drive, CD-ROM drive, and a DVD drive. Using 
the Device Class Table in Section 4.3.1, the devices may be identified as:

■ Ultra ATA-100 hard drive = Class 1

■ DVD drive = Class 2

■ CD-ROM drive = Class 3

✎ Cable lengths may restrict drive usage.

Attach Sequence Worksheet—Three-Device Installation (Sample)

Device Name
Device 
Class

Position 
Number

Channel 
Name

Device 
Number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD drive 2 2 Secondary 0

CD-ROM drive 3 3 Secondary 1

1

2

4

3

Primary 
Channel*

4 1

Secondary 
Channel

3 2

Device 1 Device 0
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Example 2: Four-Device Installation Sample
A system has four devices: two Ultra ATA-100 hard drives, one DVD-CDR/W drive, and a 
ZIP-250 drive. Using the Device Class Table in Section 4.3.1, the devices may be reidentified as:

■ Ultra ATA-100 hard drive = Class 1

■ Ultra ATA-100 hard drive = Class 1

■ DVD-CDR/W drive = Class 2

■ ZIP-250 drive = Class 4

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary channel first before following the General Attach Sequence Rule.

✎ Cable lengths may restrict drive usage.

4.3.4 PATA Additional Drive Application Notes
■ When replacing a hard drive, the replacement should be of the same type (Ultra ATA -33, 

-66, or -100) as that being removed to retain the same level of performance.

■ When Ultra ATA and SCSI hard drives are mixed in the same system, the Ultra ATA drive 
will become the boot drive unless the boot order is changed in Computer (F10) Setup.

Attach Sequence Worksheet—Four-Device Installation (Sample)

Device Name
Device 
Class

Position 
Number

Channel 
Name

Device 
Number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD-CDR/W drive 2 2 Secondary 0

ZIP-250 drive 4 3 Secondary 1

Ultra ATA-100 hard 
drive*

1 4 Primary 1

1

2

4

3

Primary 
Channel*

4 1

Secondary 
Channel

3 2

Device 1 Device 0
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4.4 ATA SMART Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP 
Personal Computers have built-in drive failure prediction that warns the user or network 
administrator of an impending failure or crash of the hard drive. The SMART drive tracks fault 
prediction and failure indication parameters such as reallocated sector count, spin retry count, 
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert.

4.5 Drive Capacities
The combination of the file system and the operating system used in the computer determines the 
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that 
may be properly accessed by the operating system. A single hard drive may therefore be 
subdivided into a number of unique drive partitions in order to make use of all of its space. 

Because of the differences in the way that drive sizes are calculated, the size reported by the 
operating system may differ from that marked on the hard drive or listed in the computer 
specification. Drive size calculations by drive manufacturers are bytes to the base 10 while 
calculations by Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

Maximum Size

File 
System

Controller 
Type Operating System

 
Partition Drive 

FAT 32 ATA Windows 2000/ XP 32 GB 128 PB

FAT 32 SCSI Windows 2000/ XP 32 GB 2 TB

NTFS ATA Windows NT/2000/XP 2 TB 128 PB

NTFS SCSI Windows NT/2000/XP 2 TB 2 TB
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4.6 SATA BIOS

4.6.1 Legacy Mode
The Legacy mode is used to access devices attached to the embedded IDE controllers. Each 
channel requires two fixed I/O address ranges and an IRQ for each.

■ Primary Channel

❏ Command block: 1F0h - 1F7h

❏ Control block: 3F6h

❏ IRQ: 14

■ Secondary Channel

❏ Command block: 170h - 177h

❏ Control block: 376h

❏ IRQ: 15

4.6.2 Native Mode
The native mode is used to access devices attached to add-in cards and is not supported by many 
legacy operating systems. Addresses are assigned by PCI Plug-n-Play BIOS and the IRQ is 
shared with multiple controllers. Base Address Registers for the Command and Control Block 
are found in the PCI Configuration Space.

■ Offset 10h—Primary Command base address

■ Offset 14h—Primary Control base address

■ Offset 18h—Secondary Command base address

■ Offset 1Ch—Secondary Control base address

Windows 2000 and XP Windows 9x, NT, and Linux

Enhanced Mode (default BIOS Setting) 
—Separate IDE controller

Compatibility Mode (non-default BIOS Setting) 
—Combined IDE controller

•PATA Controller in Legacy Mode 
- Device 0 is accessible as Device 0 of 
PATA controller’s Primary Channel 
- Device 1 is accessible as Device 1of 
PATA controller’s Primary Channel

•SATA Controller in Native Mode 
- SATA 0 is accessible as Device 0 of 
SATA controller’s Primary Channel 
- SATA 1 is accessible as Device 0 of 
SATA controller’s Secondary Channel 
SATA 2 is accessible as Device 1of 
SATA controller’s Primary Channel 
- SATA 3 is accessible as Device 1 of 
SATA controller’s Secondary Channel

•PATA Controller in Legacy Mode 
- Device 0 is accessible as Device 0 of the 
combined controller’s Secondary 
Channel 
- Device 1 is accessible as Device 1of the 
combined controller’s Secondary 
Channel

•SATA Controller in Legacy Mode 
- SATA 0 is accessible as Device 0 of the 
combined controller’s Primary Channel 
- SATA 1 is inaccessible 
- SATA 2 is accessible as device 1 of the 
combined controller’s Primary Channel 
- SATA 3 is inaccessible
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4.7 Mixed Devices Boot and Drive Letter Ordering

SATA Emulation* Hard Drive Order
HDD Boot and Drive 

Letter Ordering

Separate IDE Controller 
(default). Used with Windows 
2000 and XP.

A. Integrated SATA
B. Integrated IDE

A1. SATA 0 
A2. SATA 2
A3. SATA 1 
A4. SATA 3
B1. IDE Device 0
B2. IDE Device 1

Separate IDE Controller. Used 
with Windows 2000 and XP.

A. Integrated IDE
B. Integrated SATA

A1. IDE Device 0
A2. IDE Device 1
B1. SATA 0
B2. SATA 2
B3. SATA 1
B4. SATA 3

Combined with IDE 
Controller. Used with 
Windows 9x, NT, and Linux.

A. Integrated SATA
B. Integrated IDE

A1. SATA 0 
A2. SATA 2
B1. IDE Device 0
B2. IDE Device 1

Combined with IDE 
Controller. Used with 
Windows 9x, NT, and Linux.

A. Integrated IDE
B. Integrated SATA

A1. IDE Device 0
A2. IDE Device 1
B1. SATA 0 
B2. SATA 2

*Refer to section 4.3.2 for PATA attach sequence rules.
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5
Identifying the Chassis, Routine Care, and 

Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures 
and precautions described in this chapter is essential for proper service.

Ä
CAUTION: When the computer is plugged into an AC power source voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage. 

5.1 Chassis Designations

5.1.1 Convertible Minitower (CMT)
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5.1.2 Small Form Factor (SFF)

5.1.3 Ultra-Slim Desktop (USDT)
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5.2 Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy 
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage 
occurs. An electronic device exposed to electrostatic discharge (ESD) may not appear to be 
affected at all and can work perfectly throughout a normal cycle. The device may function 
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the 
discharge contains enough power to alter device parameters or melt silicon junctions.

5.2.1 Generating Static
The following table shows that:

■ Different activities generate different amounts of static electricity. 

■ Static electricity increases as humidity decreases. 

✎ 700 volts can degrade a product.

5.2.2 Preventing Electrostatic Damage to Equipment 
Many electronic components are sensitive to ESD. Circuitry design and structure determine the 
degree of sensitivity. The following packaging and grounding precautions are necessary to 
prevent damage to electric components and accessories.

■ To avoid hand contact, transport products in static-safe containers such as tubes, bags, or 
boxes.

■ Protect all electrostatic parts and assemblies with conductive or approved containers or 
packaging.

■ Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Avoid contact with pins, leads, or circuitry.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging or 
conductive foam.

Relative Humidity

Event 55% 40% 10%

Walking across carpet 
Walking across vinyl floor 
Motions of bench worker 
Removing DIPs* from plastic tube

7,500 V 
3,000 V 
400 V 
400 V

15,000 V 
5,000 V 
800 V 
700 V

35,000 V 
12,000 V 
6,000 V 
2,000 V

Removing DIPs* from vinyl tray 
Removing DIPs* from Styrofoam 
Removing bubble pack from PCB 
Packing PCBs in foam-lined box

2,000 V 
3,500 V 
7,000 V 
5,000 V

4,000 V 
5,000 V 
20,000 V 
11,000 V

11,500 V 
14,500 V 
26,500 V 
21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.
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5.2.3 Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

■ Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the 
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The 
ground cord must be connected and fit snugly into the banana plug connector on the 
grounding mat or workstation.

■ Heel straps/Toe straps/Boot straps can be used at standing workstations and are 
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, 
use them on both feet with a maximum of one-megohm ± 10% resistance between the 
operator and ground.

5.2.4 Grounding the Work Area
To prevent static damage at the work area, use the following precautions:

■ Cover the work surface with approved static-dissipative material. Provide a wrist strap 
connected to the work surface and properly grounded tools and equipment.

■ Use static-dissipative mats, foot straps, or air ionizers to give added protection.

■ Handle electrostatic sensitive components, parts, and assemblies by the case or PCB 
laminate. Handle them only at static-free work areas.

■ Turn off power and input signals before inserting and removing connectors or test 
equipment.

■ Use fixtures made of static-safe materials when fixtures must directly contact dissipative 
surfaces.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly aids and 
Styrofoam.

■ Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

5.2.5 Recommended Materials and Equipment
Materials and equipment that are recommended for use in preventing static electricity include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

Static Shielding Protection Levels

Method Voltage

Antistatic plastic 
Carbon-loaded plastic 
Metallized laminate

1,500 
7,500  
15,000
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■ Static awareness labels

■ Wrist straps and footwear straps providing one-megohm +/- 10% resistance

■ Material handling packages

■ Conductive plastic bags

■ Conductive plastic tubes

■ Conductive tote boxes

■ Opaque shielding bags

■ Transparent metallized shielding bags

■ Transparent shielding tubes

5.3 Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

■ Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and 
cold. 

■ Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all 
vented sides of the computer and above the monitor to permit the required airflow.

■ Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place 
the keyboard, with the keyboard feet down, directly against the front of the desktop unit as 
this also restricts airflow.

■ Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other 
foreign matter can block the vents and limit the airflow.

■ Never operate the computer with the cover or side panel removed.

■ Do not stack computers on top of each other or place computers so near each other that they 
are subject to each other’s re-circulated or preheated air.

■ If the computer is to be operated within a separate enclosure, intake and exhaust ventilation 
must be provided on the enclosure, and the same operating guidelines listed above will still 
apply.

■ The computer is designed to operate continuously (24x7), provided that the operating 
guidelines listed above are met.

■ Install or enable power management functions of the operating system or other software, 
including sleep states.

5.4 Routine Care

5.4.1 General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth 
and then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
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5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

5.4.2 Cleaning the Computer Case
Follow all safety precautions in Section 5.4.1 before cleaning the computer.

To clean the computer case, follow the procedures described below:

■ To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

■ For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it 
with a cloth or swab dampened with clear water.

■ For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will 
evaporate quickly and not leave a residue.

■ After cleaning, always wipe the unit with a clean, lint-free cloth.

■ Occasionally clean the air vents on the computer. Lint and other foreign matter can block the 
vents and limit the airflow.
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5.4.3 Cleaning the Keyboard
Follow all safety precautions in Section 5.4.1 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Section 
5.4.2.

When cleaning debris from under the keys, review all rules in Section 5.4.1 before following 
these procedures:

Ä
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys. 

■ Visible debris underneath or between the keys may be removed by vacuuming or shaking.

■ Canned, pressurized air may be used to clean debris from under the keys. Caution should be 
used as too much air pressure can dislodge lubricants applied under the wide keys.

■ If you remove a key, use a specially designed key puller to prevent damage to the keys. This 
tool is available through many electronic supply outlets.

Ä
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

■ Cleaning under a key may be done with a swab moistened with isopropyl alcohol and 
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Use 
tweezers to remove any fibers or dirt in confined areas. Allow the parts to air dry before 
reassembly.

5.4.4 Cleaning the Monitor
■ Wipe the monitor screen with a clean cloth moistened with water or with a towelette 

designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the 
liquid may seep into the housing and damage a component. Never use solvents or flammable 
liquids on the monitor.

■ To clean the monitor body follow the procedures in Section 5.4.2.    

5.4.5 Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

■ Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull 
out any debris from the ball socket and wipe the ball with a clean, dry cloth before 
reassembly. 

■ To clean the mouse body, follow the procedures in Section 5.4.2.
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5.5 Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly 
and assembly of the computer.

5.5.1 Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

Ä
CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is off 
when the computer is in “Standby,” “Suspend,” or “Off” modes. 
You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage. 

5.5.2 Tools and Software Requirements
To service the computer, you need the following:

■ Torx T-15 screwdriver (Compaq screwdriver with bits, PN 161946-001)

■ Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

■ Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

■ Phillips #0 screwdriver

■ Phillips #2 screwdriver

■ Diagnostics software

■ Compaq tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or 
Compaq tamper-resistant bits (Smart Cover FailSafe Key, PN 166527-002)

5.5.3 Screws
The screws used in the computer are not interchangeable. They may have standard or metric 
threads and may be of different lengths. If an incorrect screw is used during the reassembly 
process, it can damage the unit. HP strongly recommends that all screws removed during 
disassembly be kept with the part that was removed, then returned to their proper locations.

✎ Metric screws have a black finish. 
U.S. screws have a silver finish.

✎ As each subassembly is removed from the computer, it should be placed away from the work 
area to prevent damage.
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5.5.4 Cables and Connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with 
care to avoid damage. Apply only the tension required to seat or unseat the cables during 
insertion or removal from the connector. Handle cables by the connector whenever possible. In 
all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such a way 
that they cannot be caught or snagged by parts being removed or replaced.

Ä
CAUTION: When servicing this computer, ensure that cables are placed in their proper location during 
the reassembly process. Improper cable placement can damage the computer. 

5.5.5 Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. 
This applies to failed drives as well as replacement spares.

■ If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

■ Do not remove hard drives from the shipping package for storage. Keep hard drives in their 
protective packaging until they are actually mounted in the CPU.

■ Avoid dropping drives from any height onto any surface.

■ If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard 
drive while the computer is on or in standby mode.

■ Before handling a drive, ensure that you are discharged of static electricity. While handling a 
drive, avoid touching the connector. For more information about preventing electrostatic 
damage, refer to Section 5.2, “Electrostatic Discharge Information.”

■ Do not use excessive force when inserting a drive.

■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic 
fields such as monitors or speakers.

5.5.6 Lithium Coin Cell Battery
The battery that comes with the computer provides power to the real-time clock and has a 
lifetime of about three years. 

See the appropriate removal and replacement chapter for the chassis you are working on in this 
guide for instructions on the replacement procedures. 

Å
WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burn if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 140ºF (60ºC).

Ä
CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the 
general household waste. 
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6
Removal and Replacement Procedures - 

Convertible Minitower (CMT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

6.1 Preparation for Disassembly 
See Chapter 5, 'Identifying the Chassis, Routine Care, and Disassembly Preparation' for initial 
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 6.2, 
“Unlocking the Smart Cover Lock” and Section 6.4, “External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or MultiBay device from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

8. Lay the computer down on its side to achieve a safe working position.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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6.2 Unlocking the Smart Cover Lock 
If you have locked the Smart Cover Lock use Computer Setup to unlock the lock. Refer to the 
Desktop Management Guide on the Documentation Library CD for more information about the 
Smart Cover Lock.

If you cannot access Computer Setup to unlock the cover you will need to remove the locking 
solenoid by using the Smart Cover FailSafe Key (Spare part number 166527-001 or 
166527-002). Once the solenoid has been deactivated or removed the access panel can be 
removed.

The Smart Cover FailSafe Key will be needed in any of the following circumstances:

■ Power outage

■ Startup failure

■ Processor or power supply failure

■ Lost password

1. Using the Smart Cover FailSafe Key, remove the two tamper-proof screws that secure the Smart 
Cover Lock to the inside of the chassis.

2. Remove the computer cover.

To reattach the Smart Cover Lock, secure the lock in place with the two tamper-proof screws.
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6.3 Hood Sensor 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel (Section 6.5).

3. Disconnect the hood sensor cable from the system board.

4. Slide the hood sensor switch towards the front of the computer 1 and lower it down through 
the slot 2. 

To install the hood sensor, reverse the removal procedure.
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6.4 External Security Devices

6.4.1 Cable Lock 
The cable lock may be used to secure the computer access panel to the chassis and, at the same 
time, secure the computer to a fixed object. 
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6.4.2 Padlock 
A padlock may be used by itself to secure the access panel to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I
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6.5 Computer Access Panel 
1. Prepare the computer for disassembly (Section 6.1).

Ä
CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that 
the power cord is disconnected from the electrical outlet.

2. Lift up on the access panel handle 1, slide the access panel back about 1 inch (2.5 cm), then 
lift it off the unit 2.

To install the computer cover, reverse the removal procedure.
6–6 361288-003 Service Reference Guide, dc7100



Removal and Replacement Procedures - Convertible Minitower (CMT) Chassis
6.6 Front Bezel 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Push up on the two release tabs 1, then rotate the front bezel away from the chassis to 
release it 2.

To reinstall the front bezel, reverse the removal procedure 
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6.7 Front Drive Bezels 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel (Section 6.5).

3. Remove the front bezel (Section 6.6).

6.7.1 5.25” Drive Bezel Blank 
Gently pull the subpanel, with the bezel blanks secured in it, away from the front bezel, then 
remove the desired bezel blank. 

Ä
CAUTION: Hold the subpanel straight when pulling it away from the front bezel. Pulling the subpanel 
away at an angle could damage the pins that align it with the front bezel.

To install a bezel blank, reverse the removal procedure.

✎ When replacing the subpanel, ensure that the aligning pins and any remaining bezel blanks are in 
their proper orientation. The logo in the subpanel should be located at the bottom of the subpanel 
when properly oriented.
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6.7.2 Diskette Drive Bezel or Bezel Blank 
Press up on the two small retaining clips 1 on the bottom of the bezel insert, press down on the 
two small retaining clips 2 on the top of the insert, and push the cover out of the front bezel 3. 

To install a bezel or a bezel blank, reverse the removal procedure.
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6.8 Cable Management 
Always follow good cable management practices when working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules.Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of sliding or moveable parts to prevent their being cut or crimped when the 
parts are moved.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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6.9 Memory 
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Chapter 5 for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 
6.2).

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the computer access panel (Section 6.5).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

4. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Begin by installing a module into the socket nearest the preinstalled module, and 
install the modules following the numerical order of the sockets.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 

5. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position 3.

6. Repeat steps 4 and 5 for any additional modules that you want to install.
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✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

✎ If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and enable 
the Smart Cover Sensor.
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6.10 Expansion Cards 
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 

6.2).

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the computer access panel (Section 6.5).

4. Locate the correct vacant expansion socket on the system board and the corresponding 
expansion slot on the back of the computer chassis.

5. Push down and out on the two green thumb tabs inside the chassis and rotate the expansion 
card retention latch up.

6. If you are installing an expansion card in a vacant socket, remove the appropriate expansion 
slot cover on the back of the chassis. Pull the slot cover straight up to release it from the 
chassis frame.
Service Reference Guide, dc7100 361288-003 6–13



Removal and Replacement Procedures - Convertible Minitower (CMT) Chassis
7. If you are removing an expansion card from a standard expansion socket, hold the card at 
each end and carefully rock it back and forth until the connectors pull free from the socket. 
Lift the expansion card straight up to release it from the chassis frame. Be sure not to scrape 
the card against other components.

✎ Before removing an installed expansion card, disconnect any cables that may be attached to the 
expansion card.
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8. If you are removing a PCI Express card from a x16 PCI Express socket with a retention 
mechanism, pull the retention arm away from the socket then carefully rock the card back 
and forth until the connectors pull free from the socket. Lift the expansion card straight up 
then pull it in toward the center of the chassis to release it from the chassis frame. Be sure not 
to scrape the card against other components.

9. Store the removed card in anti-static packaging.

10. If you are not installing a new expansion card, install an expansion slot cover to close the 
open slot and continue with step 12.

If you are installing a new expansion card, continue with step 11.

Ä
CAUTION: After removing an expansion card, you must replace it with a new card or cover the open 
slot (for example, with a metal slot cover or a piece of duct tape) for proper cooling of internal 
components during operation.
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11. Slide the bracket on the end of the expansion card down into the slot on the back of the 
chassis and press the card down firmly into the socket on the system board. 

✎ When you install an expansion card, make sure you press firmly on the card so that the whole 
connector seats properly in the expansion card socket on the system board.

12. Close the expansion slot latch, making sure that it snaps firmly into place. 

13. Connect external cables to the installed card and internal cables to the system board as 
needed. 

14. Replace the computer access panel.

15. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor.

16. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide on 
the Documentation Library CD for instructions about using Computer Setup.
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6.11 PCI Retainer Latch 
If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 6.2).

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Locate the correct vacant expansion socket on the system board and the corresponding 
expansion slot on the back of the computer chassis.

4. Push down and out on the two green thumb tabs inside the chassis and rotate the expansion 
card retention latch up.

5. Use a thin flat blade screwdriver to pry up on the broken plastic latches 1 then, complete the 
removal by pulling the latches off the pivoting bar 2.
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6. Slide the pivoting bar to the right 1 then, lift the left end 2 to remove it from the chassis. To 
replace the bar, slide it into the socket on the right 1, lower it into position 3, and slide it to 
the left 4 to secure it in place.

7. With the bar in a slightly rotated position, install the latches through the openings in the back 
of the chassis and press them firmly in place on the rotating bar.

✎ The green latches are marked “R” and “L” for your convenience.
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6.12 Expansion Card Guide 
If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 6.2).

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Remove any expansion cards that might be in the way (Section 6.10).

4. Compress the retaining tabs that secure the card guide to the chassis and remove the guide 
from the chassis 2.

To install the expansion card guide, reverse the removal procedure.
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6.13 Drives
The computer supports up to six drives that may be installed in various configurations.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15 
screwdriver is needed to remove and install the guide screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the Compaq factory-installed files.

6.13.1 Drive Positions 

To verify the type and size of the storage device installed in the computer, run Computer Setup.

Drive Positions

Item Description Item Description

1 *Three 5.25-inch, half-height bays for 
optional drive.

3 Two internal 3.5-inch, one-third height 
bay for hard drives)

2 **One standard 3.5-inch, one-third 
height bay (1.44-MB diskette drive 
shown)*

*The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom bay supports a 
drive that is no more than 6.7 inches in depth, including the cables that attach to the back of the drive. Do 
not try to force a larger drive into the bottom bay as it could damage the drive and the system board.

**Depending on the computer configuration, you may have a bezel blank in this position. If you 
do not have a drive in this slot, you may choose to install a 3.5-inch device (such as a diskette 
drive, hard drive, or Zip drive).
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6.13.2 Hard Drive 

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. For more information about preventing electrostatic damage, refer to 
Chapter 5 for more information

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 
6.2).

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the computer access panel (Section 6.5). 

4. Remove the front bezel (Section 6.6).

5. Disconnect the power 1 and data 2 cables from the back of the drive.

✎ Some hard drives use a right angle connection on the SATA drive data cable 2.
Service Reference Guide, dc7100 361288-003 6–21



Removal and Replacement Procedures - Convertible Minitower (CMT) Chassis
6. Pull up on the green hard drive drivelock mechanism 1 for that drive and slide the drive from 
the drive bay 2. 

7. Remove the four guide screws (two on each side) from the old drive and install them in the 
replacement drive. 

✎ Extra guide screws are provided on the chassis. Optical drives use M3 metric screws. The 
HP-supplied metric screws are black. The HP-supplied standard screws are silver.
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8. Store the removed drive in anti-static packaging.

9. Install the new drive by sliding it into the appropriate drive bay on the front of the chassis. 
The drivelock automatically secures the drive in the bay.
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6.13.3 Optical Drive 

✎ An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD-R/RW, or CD-RW/DVD Combo 
drive. A removable storage drive is a diskette or Zip drive.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 
6.2).

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the computer access panel (Section 6.5).

4. Remove the front bezel (Section 6.6).

✎ If you are adding a drive in a bay that was previously empty, you must remove the corresponding 
bezel blank from the front bezel.

5. Disconnect the audio, power, and data cables on the back of the drive. Install four guide 
screws in the lower holes on each side of the drive.

Ä
CAUTION: When removing cables, pull the tab or connector instead of the cable itself to prevent 
damaging the cable.

6. If the computer is in the desktop mode, continue with step 7.

If the computer is in the minitower mode, continue with step 8.

7. In the desktop mode, press down on the yellow drivelock mechanism 1 and slide the drive 
from the drive bay 2.
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8. In the minitower mode, pull up on the green drivelock mechanism 1 for that specific drive 
and slide the drive from the drive bay 2.

9. Remove the four guide screws (two on each side) from the old drive and install them in the 
lower set of holes on the optical drive. 

✎ Extra guide screws are provided on the chassis on the side of the fourth drive bay. Optical drives 
use M3 metric screws. The HP-supplied metric screws are black. The HP-supplied standard 
screws are silver.
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10. Install the drive by sliding it into the appropriate drive bay on the front of the chassis. The 
drivelock automatically secures the drive in the bay.

Ä
CAUTION: Make sure the guide screws line up with the guide slots in the drive cage. The use of 
unnecessary force when installing any drive into the drive bay may result in damage to the drive.

11. When installing an optical drive, the default audio solution is digital audio. No separate 
audio cable is required for Windows XP applications. 

12. Connect the data and power cables on the to the drive.

✎ Refer to Chapter 4, “Serial and Parallel ATA Drive Guidelines and Features” for information on 
attaching the cabling to get optimum performance.

13. Replace the front bezel (Section 6.6).

14. Replace the computer access panel (Section 6.5)

15. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor (Section 6.2).
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6.13.4 Diskette Drive 
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 

6.2).

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the computer access panel (Section 6.5). 

4. Remove the front bezel (Section 6.6).

5. Pull up on the green hard drive drivelock mechanism 1 and slide the drive from the bay. 

6. Remove the four guide screws (two on each side) from the old drive and install them in the 
replacement drive. Install four guide screws, two on each side of the drive.

✎ Extra guide screws are provided on the side of the drive bay under the access panel. The diskette 
drive use M3 metric screws. The HP-supplied metric screws are black. The HP-supplied standard 
screws are silver.

7. Insert the diskette drive into the bay from the front of the chassis. Push it in until it locks into 
place.

Ä
CAUTION: Make sure the guide screws line up with the guide slots in the drive cage. The use of 
unnecesary force when installing any drive into the drive bay may result in damage to the drive.

8. Connect the data and power cables to the drive.

9. Replace the front bezel (Section 6.6).

10. Replace the computer access panel (Section 6.5)

11. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor (Section 6.2).
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6.14 Front I/O Device 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the two I/O device cables from the system board: the front USB cable pair and 
the front audio cable.

4. Remove the two screws that secure the front I/O device to the mounting bracket 1.

5. Remove the two screws that secure the mounting bracket to the chassis 2.

6. Lift the mounting bracket off the chassis 3.

7. Carefully pull the cables from the front of the chassis making sure that they do not snag on 
the lower drive cage.

To reinstall the I/O device:

1. Thread the cables through the opening and down the space in front of the lower drive cage. 
This step may be easier if you thread a single cable at a time through the opening.

Ä
CAUTION: Be careful when threading the cables in the chassis so the cable ends are not damaged.

2. Position the I/O device and the mounting bracket on the front of the chassis and install the 
two screws that secure the bracket to the chassis.

3. Install the two screws that secure the I/O device to the mounting bracket.

Complete the reassembly by reinstalling the other parts that had been removed.
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6.15 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the power switch/LED cable from the system board. 

4. Squeeze the switch holder retaining clips together at the front of the chassis 1 and pull the 
switch assembly out of the chassis 2.

To install the power switch assembly, reverse the removal procedure. 

✎ When installing the power switch cable it may be necessary to disconnect a data cabe from one 
of the drives to make it easier to grab the free end of the cable.
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6.16 System Board 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Remove all PCI expansion boards (Section 6.10).

4. Remove the x16 PCI Express graphics card (Section 6.10).

5. Disconnect all cables connected to the system board, noting their location for reinstallation.

6. Compress the system board tray handle 1 to release the latch and slide the system board tray 
towards the front of the computer 2 to free it from the back of the chassis.

To install the system board with its tray, press down on the board to ensure its latching 1 and 
then, push the board into its locked position 2. 
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6.17 Battery
The 3-volt lithium coin cell battery that comes with this computer provides power to the 
real-time clock and has a lifetime of about three years. When replacing the battery, use a battery 
equivalent to the battery originally installed on the computer. 

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C) 
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP/Compaq spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting 
Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP/Compaq, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

✎ It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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6.17.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer cover or access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.17.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp 1 that extends above one 

edge of the battery. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

✎ After the battery has been replaced, use the following steps to complete this procedure.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup. 
Service Reference Guide, dc7100 361288-003 6–33



Removal and Replacement Procedures - Convertible Minitower (CMT) Chassis
6.18 Heatsink 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the heatsink control cable from the system board.

4. Uncrew the four captive screws 1 that secure the heatsink to the system board.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

5. Remove the heatsink 2 from atop the processor.

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe 
and fresh thermal grease has been applied to the top of the processor.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.
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6.19 Processor 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 6.5, “Computer Access Panel”).

3. Disconnect the heatsink control cable from the system board and remove the heatsink 
Section 6.18, “Heatsink”. 

4. Rotate the locking lever to its full open position 1.

5. Raise and rotate the microprocessor retainer to its fully open position 2.

6. Carefully lift the processor from the socket 3. 

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 5.

3. If reusing the existing heatsink, apply the thermal grease provided in the spares kit to the top 
of the processor.

4. Clean the bottom of the heatsink with the provided alcohol pad and place it atop the 
processor.
Service Reference Guide, dc7100 361288-003 6–35



Removal and Replacement Procedures - Convertible Minitower (CMT) Chassis
Go to step 5.

5. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

6. Secure the heatsink to the system board and system board tray with the 4 captive screws and 
attach the heatsink control cable to the system board.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system ROMPaq can 
be found on the Web at: http:\\h18000.www1.hp.com/support/files.
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6.20 Speaker 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the speaker wire from the system board.

4. Remove the four screws from the inside of the chassis 1 that secure the speaker to the 
chassis.

5. Remove the speaker 2.

To install the speaker, reverse the removal procedures.
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6.21 Chassis Fan 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the fan control cable from the system board.

4. Remove the four screws that secure the fan assembly to the chassis 1 and then remove the 
fan assembly 2.

To install the fan assembly, reverse the removal procedure.
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6.22 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 6.1).

1. Remove the computer access panel (Section 6.5).

2. Disconnect all power cables from the mass storage devices and from the system board.

3. Remove the four screws that connect the power supply to the chassis 1.

4. Slide the power supply toward the front of the computer, then lift it out of the computer 2.

To install the power supply, reverse the removal procedure.
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6.23 Changing from Desktop to Minitower 
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock it.

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the computer access panel (Section 6.5).

4. Remove the front bezel (Section 6.6).

5. Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.

6. To release the drives from the 5.25-inch drive bay, press down on the short yellow drivelock 
as shown. While pressing the drivelock, pull the drives out of the drive bay.
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7. Before you reinstall each drive into the chassis, turn it so that it is in the same orientation as 
the internal 3.5-inch drive. The bottom of the drive should be parallel to the yellow drivelock.

8. Slide the drive into the uppermost available bay until it snaps into place. When the drive is 
properly inserted, the drivelock will secure it. Repeat this step for each drive.

Ä
CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom 
bay supports a drive that is no more than 6.7 inches in depth, including the cables that attach to the back 
of the drive. Do not try to force a larger drive, such as an optical drive or MultiBay drive, into the bottom 
bay. This could cause damage to the drive and the system board. 
 
The use of unnecessary force when installing any drive into the drive bay may result in damage to the 
drive.

9. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

10. Remove the bezel subpanel (Section 6.23).

Ä
CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the subpanel 
away at an angle could damage the pins that align it within the front bezel.

11. Reposition the bezel blanks within the subpanel in the proper orientation for the desktop 
configuration.
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12. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the 
bezel.
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6.24 Changing from Minitower to Desktop 
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock it.

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the computer access panel (Section 6.5).

4. Remove the front bezel (Section 6.6).

5. Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.

6. To release the drives from the 5.25-inch drive bay, lift the release tab on the green latch drive 
bracket for the drive. While lifting the release tab, slide the drive from its drive bay. Repeat 
this step for each 5.25-inch drive.
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7. Before reinstalling each drive into the chassis, turn the drive so that it is perpendicular to the 
internal 3.5-inch drive. The drive should be parallel to the green latch drive bracket.

8. Slide the drive into the uppermost available bay until it snaps into place. When the drive is 
properly inserted, the drivelock will secure it. Repeat this step for each drive.

Ä
CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom 
bay supports a drive that is no more than 6.7 inches in depth, including the cables that attach to the back 
of the drive. Do not try to force a larger drive, such as an optical drive or MultiBay drive, into the bottom 
bay. This could cause damage to the drive and the system board. 
 
The use of unnecessary force when installing any drive into the drive bay may result in damage to the 
drive.

9. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

10. Remove the bezel subpanel (Section 6.7).

Ä
CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the subpanel 
away at an angle could damage the pins that align it within the front bezel.

11. Reposition the bezel blanks within the subpanel in the proper orientation for the desktop 
configuration.
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12. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the 
bezel.

13. Replace the front bezel and computer access panel.

14. Reconnect the external equipment.

15. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor.
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7
Removal and Replacement Procedures— 

Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

7.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation” for initial 
safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 7.2, 
“Unlocking the Smart Cover Lock,” and Section 7.4, “External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or MultiBay device from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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7.2 Unlocking the Smart Cover Lock 
If you have locked the Smart Cover Lock use Computer Setup to unlock the lock. Refer to the 
Desktop Management Guide on the Documentation Library CD for more information about the 
Smart Cover Lock.

If you cannot access Computer Setup to unlock the cover you will need to remove the locking 
solenoid by using the Smart Cover FailSafe Key (Spare part number 166527-001 or 
166527-002). Once the solenoid has been deactivated or removed the access panel can be 
removed.

The Smart Cover FailSafe Key will be needed in any of the following circumstances:

■ Power outage

■ Startup failure

■ Processor or power supply failure

■ Lost password

1. Using the Smart Cover FailSafe Key, remove the tamper-proof screw that secures the Smart Cover 
Lock to the inside of the chassis.

2. Remove the computer cover (Section 7.5, “Computer Cover”).
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To reattach the Smart Cover Lock, position the lock with the tamper-proof screw. 
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7.3 Hood Sensor 
1. Prepare the computer for disassembly.

2. Remove the computer cover.

3. Raise the power supply to its full upright position.

4. Disconnect the hood sensor cable from the system board.

5. Slide the hood sensor switch mounted on the power supply towards the outside of the 
computer 1 and lower it through the slot 2.

To install the hood sensor, reverse the removal procedure.
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7.4 External Security Devices

7.4.1 Security Clip
A special clip is required to secure the computer from intrusion. This clip must be installed 
before installing the computer cover.

7.4.2 Cable Lock 
The cable lock may be used to secure the computer cover to the chassis and, at the same time, 
secure the computer to a fixed object. 

Insert the cable lock in the location shown below.
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7.4.3 Padlock 
A padlock may be used by itself to secure the computer cover to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I

7.4.4 Universal Chassis Clamp Lock

Without Security Cable
1. Thread the keyboard and mouse cables through the lock.
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2. Screw the lock to the chassis using the screw provided.
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3. Insert the plug into the lock 1 and push the button in 2 to engage the lock. Use the key 
provided to disengage the lock.

With Security Cable
1. Fasten the cable by looping it around a stationary object.
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2. Thread the keyboard and mouse cables through the lock.

3. Screw the lock to the chassis using the screw provided.
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4. Insert the plug end of the security cable into the lock 1 and push the button in 2 to engage 
the lock. Use the key provided to disengage the lock.
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7.5 Computer Cover 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

Ä
CAUTION: Before removing the computer cover, ensure that the computer is turned off and that the 
power cord is disconnected from the electrical outlet.

1. Press the buttons on the left and right sides of the computer 1.

2. Slide the computer cover towards the front of the computer until it stops 2 then, lift it up and 
off the chassis.

To install the computer cover, reverse the removal procedure.
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7.6 Front Drive Bezels 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove the drive bezel by pushing the top tab on the right side of the larger front bezel as 
shown 1 and rotating the drive bezel away from the larger front bezel 2. 

✎ The drive bezel will vary depending on the computer configuration.

4. Install a bezel or a bezel blank by pushing the bezel into place.
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There are three drive bezel inserts that are available. 

Item Description

1 Diskette drive bezel

2 Hard drive bezel

3 3.5” drive bezel
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7.7 Cable Management 
The Slim Tower chassis is a very compact computer and proper routing of the internal cables is 
critical to the operation of the computer. Follow good cable management practices when working 
inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules.Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of sliding parts like the drive cage to prevent their being cut when the drive 
cage is being seated.

■ Keep cables clear of rotating parts like the power supply to prevent their being cut or crimped 
when the power supply is lowered.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.
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When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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7.8 Memory 

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly 
Preparation,” for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 
7.2, “Unlocking the Smart Cover Lock”).

2. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

3. Remove the computer cover (Section 7.5, “Computer Cover”).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

4. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Refer to Appendix F for the correct sequence for installing memory modules to get 
optimal performance.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 

5. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position 3.
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6. Repeat steps 4 and 5 for any additional modules that you want to install.

✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

✎ If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and enable 
the Smart Cover Sensor.
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7.9 Vertically Oriented Expansion Card 

7.9.1 Expansion Card Retainer 
1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 

unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer from the stand and lay the computer on its side.

5. Remove the computer cover. Refer to Section 7.5, “Computer Cover”

6. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab 
on the latch and rotating the latch to the full open position 1.

7. Remove the single screw that keeps the card retainer in place 2 and slide the retainer to the 
left to remove it from the chassis 3.

To install the card retainer, reverse the removal procedure.
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7.9.2 PCI Expansion Card 
1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 

unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer from the stand and lay the computer on its side.

5. Remove the computer cover. Refer to Section 7.5, “Computer Cover”.

6. Identify the slot into which you want to insert the expansion card.

7. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab 
on the latch and rotating the latch to the full open position 1.

8. Remove the slot cover by sliding it up and out 2 of the computer.
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9. Install the expansion card by sliding the card under the slot cover retention latch then 
pressing the card down into the slot on the system board.

✎ Be sure not to scrape other components in the chassis when installing an expansion card.

10. Rotate the slot cover retention latch back in place to secure the expansion card.

✎ When you install an expansion card, make sure the metal bracket on the card slides into the slot 
on the back of the computer then press down firmly on the card so that the whole connector seats 
properly in the expansion card slot.

Ä
CAUTION: All expansion card slots on the rear of the computer must contain either an expansion card 
or slot cover for proper cooling of internal components during operation.
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7.9.3 PCI Express Expansion Card
To remove a PCI Express expansion card:

1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 
unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer cover. Refer to Section 7.5, “Computer Cover”.

5. Release the slot cover retention latch on the back of the computer that secures the PCI slot 
covers by lifting the green tab on the latch and rotating the latch to the open position.

6. Pull the retention arm on the back of the PCI Express expansion socket away from the card 
(on x16 card socket only) and carefully rock the card back and forth until the connectors pull 
free from the socket. Pull the expansion card straight up from the socket then away from the 
inside of the chassis. Be sure not to scrape the card against the other components.

7. If you are not installing a new expansion card, install an expansion slot cover to close the 
open slot.

8. Rotate the slot cover retention latch back in place to secure the expansion cards and 
expansion slot.

Ä
CAUTION: All expansion card slots on the rear of the computer must contain either an expansion card 
or slot cover for proper cooling of internal components during operation.
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7.10 Horizontally Oriented Expansion Card
This application is only available when the computer has the PCI Riser Card cage installed. 
Neither a PCI Express x1 or x16 card can be used in this application. 

7.10.1 Expansion Card Cage 
1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 

unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer from the stand and lay the computer on its side.

5. Remove the computer cover. Refer to Section 7.5, “Computer Cover”.

6. Lift the bail handle on the expansion card cage and pull the cage straight up and out of the 
computer.

7. Lay the card cage on its top for stability before doing any work on it.

To install the card cage, reverse the installation process.

7.10.2 PCI Expansion Card
1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 

unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer from the stand and lay the computer on its side.

5. Remove the computer cover. Refer to Section 7.5, “Computer Cover”.
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6. Remove the expansion card cage Section 7.10, “Horizontally Oriented Expansion Card”.

If you are installing a card for the first time in this computer, go to step 12.

7. If your are replacing an existing card, stand the card cage on its end for better leverage, and 
remove the card retaining screw 1.

8. Grasp the card and carefully rock it back and forth until the connectors pull free from the 
socket. Pull the expansion card straight up from the socket 2 then away from the inside of 
the card cage. Be sure not to scrape the card against other components.

9. Store the removed card in anti-static packaging. 

10. Slide the bracket on the end of the expansion card down into the slot on the expansion card 
cage and press the card down firmly into the socket on the riser card.

11. Reinstall the card retaining screw.

Go to step 15.

12. If you are installing an expansion card in a vacant slot, remove the slot cover retaining screw 
and slide the slot cover out of its socket.

13. Slide the bracket on the end of the expansion card down into the slot on the expansion card 
cage and press the card down firmly into the socket on the riser card.

14. Reinstall the card retaining screw.
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15. Reinstall the expansion card cage by aligning the cage with the guide rails on the backwall. 
Press down firmly on the cage to secure it in place on the backwall. Be sure the riser card in 
the cage is properly seated in the PCI expansion slot on the system board.

Complete the reassembly of the computer.
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7.10.3 Riser Card
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 

7.2, “Unlocking the Smart Cover Lock”).

2. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

3. Remove the computer access panel (Section 7.5, “Computer Cover”).

4. Remove the expansion card cage (Section 7.10.1, “Expansion Card Cage”).

5. Remove the two screws that secure the riser card to the expansion card cage 1, then remove 
the card 2.

To install the riser card, reverse the removal procedure.

✎ The riser card is not spared separately at the time this document was released. 
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7.11 Drives
A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the Compaq factory-installed files.

7.11.1 Drive Positions 

To verify the type and size of the storage device installed in the computer, run Computer Setup.

Drive Positions

Item Description Item Description

1 3.5-inch, internal, standard hard 
drive bay

3 3.5-inch drive bay (1.44-MB 
diskette drive shown)*

2 5.25-inch drive bay for optional 
drives

*A 3.5-inch diskette drive, hard drive, or Zip drive may be installed in this bay but the correct 
bezel must be installed to ensure proper air flow. 
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7.11.2 Optical Drive 

Ä
CAUTION: All removable media should be taken out of the drives before removing the drive from the 
computer.

✎ An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD+R/RW, or CD-RW/DVD Combo 
drive.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 
7.2, “Unlocking the Smart Cover Lock”).

2. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

3. Remove the computer cover (Section 7.5, “Computer Cover”). 

4. Press down on the green latch located on the front of the chassis next to the drives 1. This 
disengages the drive cage.

5. Slide the drive cage forward until it stops 2. 

✎ The unlock icon on the drive tray should align with the arrow on the chassis when the tray is fully 
extended.
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6. Disconnect the power and data cables from the rear of the optical drive.

7. Slide the optical drive forward and lift it up and out of the drive cage.

✎ If the drive will not slide out of the cage, the cage is not fully extended. Pull on the cage until the 
internal drive lock mechanism has been released.

Ä
CAUTION: Use only 3/16-inch or 5-mm long screws as guide screws. Longer screws can damage the 
internal components of the drive.

✎ When replacing the drive, transfer the four screws from the old drive to the new one. The screws 
take the place of drive rails.
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7.11.3 External 3.5-inch Drive 
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock. Refer to 

Section 7.2, “Unlocking the Smart Cover Lock”.

2. Prepare the computer for disassembly. Refer to Section 7.1, “Preparation for Disassembly”.

3. Remove the computer cover. Refer to Section 7.5, “Computer Cover”. 

4. Remove the optical drive. Refer to Section 7.11.2, “Optical Drive”.

5. Disconnect the signal and power cables from the drive. The other end of the cables should 
remain connected to the system board.

✎ Diskette drive shown.

6. Slide the drive forward and lift it up and out of the drive cage.

To replace the drive, transfer the four screws from the old drive to the new one and reverse the 
removal procedure.
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7.11.4 Primary Hard Drive 
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 

7.2, “Unlocking the Smart Cover Lock”).

2. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

3. Remove the computer cover (Section 7.5, “Computer Cover”).

4. Press down on the green latch located on the front of the chassis next to the optical drive 1 
and slide the drive cage forward 2 to its fully extended position. This will give you access to 
the cable connectors on the primary hard drive.

✎ It is not necessary to remove the optical drive.
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5. Remove the security clip that secures the backwall to the power supply.

6. Rotate the power supply to its full upright position. 
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7. Disconnect the power cable 1 and data cable 2 from the back of the hard drive.

8. Pull the tab that locks the drive in place away from the drive 1, slide the hard drive toward 
the front of the computer, then lift it up and out of the bay 2.

To install a hard drive, reverse the above procedure.

✎ The replacement hard drive kit includes several data cables. Make sure to use the cable that is 
exactly the same as the factory-installed cable.

✎ If the system has only one SATA hard drive, the data cable must be connected to the blue 
connector labeled P60 SATA 0 first to avoid any hard drive performance problems.
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✎ When replacing the hard drive, transfer the four screws from the old drive to the new one. The 
screws take the place of drive rails. You will need a Torx T-15 screwdriver to remove and 
re-install the guide screws. HP has provided four extra 6-32 standard guide screws on the front of 
the chassis, under the computer cover. The 6-32 standard guide screws are silver.

✎ If you replaced the primary hard drive, insert the Restore Plus! CD to restore the operating 
system, software drivers, and any software applications that were preinstalled on the computer. 
Follow the instructions in the guide included with the Restore Plus! CD. When the restore 
process has completed, reinstall any personal files that you backed up before replacing the hard 
drive.
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7.12 Fan Shroud 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Lift up on the fan shroud to remove it from the computer.

When replacing the shroud, make sure that it does not get caught on the wires from either the fan 
or the speaker. 
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7.13 Front I/O Devices 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Disconnect the two I/O device cables from the system board: the front USB cable pair and 
the front audio cable.

4. Remove the drives from the drive tray. Refer to Section 7.11, “Drives”.

5. Remove the power supply cable that is routed under the drive cage from the side 1 and 
front 2 cable retaining clips. 

✎ It may be necessary to flatten the cable in the cable retaining clip areas to make the cable more 
flexible. 

6. Remove the power supply cable that is routed under the green leg of the drive cage 3. 

✎ It may be necessary to flatten the cable to make the cable more flexible.
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7. Remove the SATA cable from the front and side retaining clips.

8. Push the empty drive cage back into its locked position.

Ä
CAUTION: Make sure the flat ribbon cables are folded down and the SATA and power cables are 
pushed out of the way to prevent their being damaged when the drive cage is pushed into the locked 
position.
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9. Remove the two screws that secure the front I/O device 1 then, push the I/O device towards 
the back of the chassis 2. 

10. Pull the drive cage forward, grasp the I/O device and carefully pull it from under the drive 
cage 3. Guide the cable ends through the slots in the drive cage support device to keep them 
from snagging.
Service Reference Guide, dc7100 361288-003 7–37



Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
Follow these procedures for reinstalling the front I/O device.

1. Begin with the drive cage in its fully extended position. Guide the I/O device cables under 
the drive cage and through the legs of the drive cage support 1. It may be necessary to use a 
wooden pencil to help in this task.

2. Push the I/O device beneath the drive cage as far as possible 2 then, push the drive cage into 
the closed position to access the front of the chassis. Make sure the USB ports in the I/O 
device are oriented properly on the right side. 

3. Install the two retaining screws 3 while holding the I/O device in position.

4. Reinstall the balance of the cabling and drives. 
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7.14 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Disconnect the power switch/LED cable from the system board. 

4. Squeeze the switch holder retaining clips together at the front of the chassis 1 and push the 
switch assembly out of the chassis 2. Push the two LEDs out of the chassis 3.

5. If necessary, the LED holders may also be removed by squeezing the clips and pushing them 
out of the front of the chassis 4. 

To install the power switch and LEDs, reverse the removal procedure. 
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7.15 Heatsink 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove the fan shroud. Refer to Section 7.12, “Fan Shroud”.

4. Disconnect the fan control cable from the system board.

5. Loosen the four captive screws 1 that secure the heatsink to the system board tray.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

6. Lift the heatsink from atop the processor 2 and set is on its side to keep from contaminating 
the work area with thermal grease.

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe 
and fresh thermal grease has been applied to the top of the processor.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.
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7.16 Processor 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove the fan shroud. Section 7.12, “Fan Shroud”.

4. Disconnect the heatsink control cable from the system board and remove the heatsink 
(Section 7.15, “Heatsink”).

5. Rotate the locking lever to its full open position 1.

6. Raise and rotate the microprocessor retainer to its fully open position 2.

7. Carefully lift the processor from the socket 3. 

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 6.
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3. If reusing the existing heatsink, clean the bottom of the heatsink with the alcohol pad 
provided in the spares kit.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the speaker spares kit. After the alcohol has evaporated, apply 
thermal grease to the top of the processor from the syringe supplied in the speaker spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the 
heatsink atop the processor.

5. Go to step 7.

6. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

7. Secure the heatsink to the system board and system board tray with the 4 captive screws and 
attach the heatsink control cable to the system board. 

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system ROMPaq can 
be found on the Web at: http:\\h18000.www1.hp.com/support/files.
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7.17 Speaker 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove the fan shroud. Section 7.12, “Fan Shroud”

4. Remove the heatsink control cable and the heatsink from the system board (Section 7.15, 
“Heatsink”).

5. Remove any memory modules that might interfere with the screwdriver used for removing 
the speaker.

6. Disconnect the speaker wire from the system board.

7. Remove the two screws that secure the speaker to the chassis.

8. Remove the speaker from the chassis.

To install the speaker, reverse the removal procedures.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the speaker spares kit. After the alcohol has evaporated, apply 
thermal grease to the top of the processor from the syringe supplied in the speaker spares kit.
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7.18 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove the security clip. 

4. Rotate the power supply to its upright position.

5. Pull the drive cage forward and disconnect the power cables from all of the drives.

6. Disconnect the power cables from the system board.

7. Release the power supply cable from the cable retaining clip at the front of the chassis below 
the drive cage and from the clip on the side of the chassis in front of the hard drive (Section 
7.12, “Fan Shroud”).

8. Disconnect the hood sensor from the system board and remove the sensor from the power 
supply if required (Section 7.3, “Hood Sensor”).
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9. Lift the power supply up and out of the chassis.

To install the power supply, reverse the removal procedure.

Ä
CAUTION: When installing the power supply cables, make sure they are properly positioned so they 
are not cut by the drive cage and are not pinched by the rotating power supply.
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7.19 System Board 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove all PCI and PCI Express expansion boards (Section 7.9, “Vertically Oriented 
Expansion Card”).

4. Remove the fan shroud from the chassis (Section 7.11, “Drives”).

5. Slide the drive tray forward and disconnect the drive and power cables from the system 
board.

6. Remove the security clip.
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7. Rotate the power supply to its upright position.

8. Disconnect the serial port from the system board

9. Disconnect the balance of the cables from the system board. .
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10. Remove the long mounting screw that secures the system board tray to the chassis.

✎ The heatsink has been removed from the drawing below for clarity. The heatsink should not be 
removed until the system board has been removed from the chassis.
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11. Slide the system board tray assembly towards the front of the chassis, about 1/4 inch and lift 
the system board up and out of the chassis.

12. Remove the heatsink from the system board and the system board tray (Section 7.15, 
“Heatsink”).

✎ When reinstalling the system board it is important to secure the system board and tray to the 
chassis with the long retaining screw before performing any subsequent steps. Locking the board 
in place makes the installation of the heatsink easier and prevents damage. 

Ä
CAUTION: When reconnecting the cables it is important that they be positioned so they do not interfere 
with the sliding of the drive cage the rotation of the power supply 

Complete the installation of the system board by reconnecting all cables. 

✎ The heatsink should be installed on the system board before the system board is reinstalled in the 
chassis.

✎ CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the speaker spares kit. After the alcohol has evaporated, apply 
thermal grease to the top of the processor from the syringe supplied in the speaker spares kit.
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7.20 Chassis Fan 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove the fan shroud (Section 7.12, “Fan Shroud”).

4. Disconnect the chassis fan cable from the system board. 

5. Remove the four screws that secure the fan and fan guard to the chassis then, remove the fan 
from the chassis.

.

To install the chassis fan, reverse the removal procedure. 
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7.21 Backwall 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer cover (Section 7.5, “Computer Cover”).

3. Remove all PCI and PCI Express expansion boards (Section 7.9, “Vertically Oriented 
Expansion Card”).

4. Press down on the green latch located on the front of the chassis next to the drives 1. This 
disengages the drive cage.

5. Slide the drive cage forward until it stops 2.

✎ It is not necessary to remove any drives from the drive cage. The drive cage is moved only to gain 
working room.

6. Remove the power supply from the chassis (Section 7.18, “Power Supply”).

7. Disconnect all data and power cables from the system board except the cable to the heatsink.
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8. Disconnect the “Serial A” cable 1 from the system board, remove the two screws 2 that 
secure the serial connector to the backwall, then remove the serial connector 3 from the 
backwall.

9. Remove the fan shroud from the fan (Section 7.12, “Fan Shroud”)

10. Remove the long mounting screw that secures the system board tray to the chassis.

✎ The heatsink has been removed from the drawing for clarity. Do not remove the heatsink for this 
operation.
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11. Slide the system board tray assembly towards the front of the chassis, about 7 mm (1/4-inch) 
and lift the system board up and out of the computer.

12. Remove the three screws 1 that secure the backwall assembly to the chassis, then slide the 
backwall assembly 2 a few millimeters/inches toward the space vacated by the power supply 
and lift out.
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13. Slide the new backwall 1 onto the rear chassis. Secure it with the three screws 2 removed 
from the old backwall.

14. Install the serial connector 1 into the new backwall using the two screws 2 that were 
removed from the serial connector in a previous step. Reconnect the “Serial A” cable 3 to 
the system board.

15. Install the system board tray assembly. Be sure the keyhole slot on the system board sits 
properly over the locking pins. When the system board is in position, replace the long screw 
to secure the system board to the chassis.
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16. Reconnect all power and data cables to the system board. Be sure to use proper cable 
handling and placement precautions.

17. Install the power supply. Rotate it to its normal operating position. Be sure to use proper 
cable handling and placement precautions.

18. If ready, install the PCI expansion card in the available slot in the new PCI riser card cage 
assembly. Consult the guide that comes with your computer model to install a PCI expansion 
card.
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19. Install the new PCI riser card cage assembly on the new backwall by aligning the cage with 
the guide rails on the backwall. Press down firmly on the cage to secure it in place on the 
backwall. Be sure the riser card in the cage is properly seated in the PCI expansion slot on 
the system board.

20. Slide the drive cage back into its operating position and lock it in place. Be sure to use proper 
cable handling and placement precautions.

Ä
CAUTION: Cables are very sensitive. Overbending, creasing, or pinching can damage cables.
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21. Replace the fan shroud on top of the fan.

22. Replace the computer access panel.

23. Connect the power cord to the computer and electrical outlet.

24. Connect any peripheral equipment to the computer.
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7.22 Battery
The battery that comes with this computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C) 
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP/Compaq spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting 
Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP/Compaq, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.5, “Computer Cover”).

✎ It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Carefully pull the cable bundle out of the way to access the battery.

5. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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7.22.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer cover or access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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7.22.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge 

of the battery. When the battery pops up, lift it out 1.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

✎ After the battery has been replaced, use the following steps to complete this procedure.

3. Replace the computer cover or access panel.

4. Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup. 
Refer to the Computer Setup (F10) Utility Guide.
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7.22.3 Type 3 Battery Holder
1. Pull back on the clip 1 that holds the battery in place, then remove the battery 2.

2. Insert the new battery and position the clip back in place.

✎ After the battery has been replaced, use the following steps to complete this procedure.

3. Replace the computer cover or access panel.

4. Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup. 
Refer to the Computer Setup (F10) Utility Guide.
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8
Removal and Replacement Procedures - 

Ultra-Slim Desktop (USDT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

8.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation” for initial 
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 8.2).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or MultiBay device from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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8. If the PC is mounted in the accessory mounting stand, remove it and lay the computer down 
on its rubber feet. 
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8.2 External Security Devices

8.2.1 Installing a Cable Lock 
The cable lock may be used to secure the computer access panel to the chassis and, at the same 
time, secure the computer to a fixed object. 
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8.2.2 Installing a Padlock 
A padlock may be used by itself to secure the access panel to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I
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8.3 Computer Access Panel 
1. Prepare the computer for disassembly (Section 8.1).

Ä
CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that 
the power cord is disconnected from the electrical outlet.

2. Lay the computer down so the rubber feet rest on a solid surface.

3. Loosen the captive thumbscrew 1 that secures the access panel to the computer chassis. 

4. Slide the top access panel back about 1.3 cm, (1/2 inch), then lift it off the unit 2.

To install the access panel, reverse the removal procedure.
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8.4 MultiBay Device

Ä
CAUTION: The MultiBay device must be removed from the chassis before the front panel assembly is 
removed. Failure to remove the MultiBay device will result in severe damage to the computer.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the access panel (Section 8.3).

3. Unlock the MultiBay device by pushing down on the green locking lever on top of the 
MultiBay drive cage 1 an then pushing it to the right 2.

4. Eject the MultiBay device by sliding the front-mounted eject lever to the left 1 then, pull the 
device out of the device bay 2. 

To install the MultiBay device, reverse the removal procedures. 

Lock the device in place if desired.
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8.5 MultiBay Riser Card

Ä
CAUTION: The MultiBay riser card must be removed before removing the front panel assembly. Failure 
to do so will damage the MultiBay riser card and the front panel assembly.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Grasp the green handle on top of the riser card assembly and lift it straight up. 

✎ The MultiBay riser card assembly serves a number of purposes: it provides data and power to an 
installed MultiBay device: it locks the front panel assembly in the chassis; and it secures the 
power supply in the chassis and prevents its front-to-back movement.

To reinstall the riser card, reverse the removal procedures.
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8.6 Front Panel Assembly
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device from the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Lift up on the two green locking levers release tabs on the right side of the bezel 1. This will 
unlatch the front panel assembly and push it about 1.3 cm (1/2 inch) out of the chassis.

6. Disconnect the fan cable from the system board 2 and remove the panel assembly 3 by 
pulling it straight out of the chassis.

To reinstall the front panel assembly, reverse the removal procedure.
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8.7 Front Bezel
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Use a #0 Phillips screwdriver to remove the four screws that secure the front bezel to the 
front panel assembly 1. 

7. Raise the plastic locking device 2 located just below the MultiBay drive cage and pull the 
front bezel away from the assembly. It may be necessary to release the catch 3 that keeps the 
top of the bezel in place.

To reinstall the front bezel, reverse the removal procedures.

✎ When installing the front bezel, make sure that the MultiBay eject lever is positioned nearest the 
center of the bezel to ensure it will properly activate the eject mechanism.
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8.8 Chassis Fan
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6)

6. Remove the front bezel (Section 8.7).

7. Pull the four push pins that secure the fan to the front panel assembly out of the plastic 
grommets 1 then, lift the fan off the grommets 2.

8. To remove the grommets, slide them towards the outside corners of the fan cutout 3. 

To install the fan assembly, reverse the removal procedures, making sure that the fan cable is 
located near the top of the assembly nearest the center of the front panel assembly.

✎ When installing the four push pins it is necessary to squeeze the pins into the grommets with 
your fingers acting as a pincer. The back of the grommet must be immovable for the pin to seat 
properly.
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8.9 Cable Management
Always follow good cable management practices when working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules.Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of sliding or moveable parts to prevent their being cut or crimped when the 
parts are moved.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

Do not rely on components like the drive cage, power supply, or computer cover to push cables 
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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8.10 Memory 

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Chapter 5 for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. If you are replacing a memory module, place it in the socket vacated by its 
predecessor.

Push the module down into the socket, ensuring that the module is fully inserted and properly 
seated. Make sure the latches are in the closed position 3.
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✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 

7. Repeat step 6 for any additional modules that you want to install.

✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.
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8.11 Expansion Card Cage
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Lift the green bail handle on the expansion card cage and lift straight up.

To install the cage, align the cage in the guides on the chassis and press it firmly into place.
8–14 361288-003 Service Reference Guide, dc7100



Removal and Replacement Procedures - Ultra-Slim Desktop (USDT) Chassis
8.12 Expansion Card 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the expansion card cage (Section 8.11).

4. Open the latch 1 by squeezing the retainer fingers together and rotate the latch out of the 
way 2. 

5. Lay the card cage on its edge and hold it firmly in place. Grasp the card and carefully rock it 
back and forth until the connectors pull free from the card cage. Pull the expansion card 
straight out 3 to remove it from the chassis. Be sure not to scrape the card against the cage.  
 
Store the removed card in anti-static packaging.

.

6. If you are not installing a new expansion card, install an expansion slot cover to close the 
open slot and continue with step 8.

If you are installing a new expansion card, continue with step 7.

Ä
CAUTION: After removing an expansion card, you must replace it with a new card or cover the open 
slot (for example, with a metal slot cover or a piece of cardboard taped in place) for proper cooling of 
internal components during operation.
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7. Slide the bracket on the end of the expansion card down into the slot and press the card 
firmly into the socket. 

✎ When you install an expansion card, make sure you press firmly on the card so that the whole 
connector seats properly in the expansion card socket on the riser board.

8. Close the latch firmly to secure the card in place.

9. Install the expansion card cage into the computer.

10. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide on 
the Documentation Library CD for instructions about using Computer Setup.
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8.13 Hood Sensor
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the expansion card cage (Section 8.11).

4. Disconnect the cable from the system board 1 and then slide the hood sensor out of the slot 
in the chassis 2.

To install the hood sensor, reverse the removal procedures.
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8.14 Expansion Card Retaining Latch
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the expansion card cage (Section 8.11).

4. Open the latch 1 by squeezing the retainer fingers together then, rotate the latch out of the 
way 2. 

5. Use a thin, flat-blade screwdriver to pry 3 the damaged locking lever off the expansion card 
cage. 

6. Remove the locking lever.

To install the replacement locking lever, spread the pivot pin area and push it onto the ear of the 
expansion card cage so the pins snap into their receptacles.

Complete the assembly by locking the expansion card in place and reinstalling the expansion 
card cage.
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8.15 Hard Drive 
A Torx T-15 screwdriver is needed to remove and install the guide screws on a hard drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the Compaq factory-installed files.

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. For more information about preventing electrostatic damage, refer to 
Chapter 5 for more information

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Disconnect the power and data cables from the hard drive. 

Follow proper cable management techniques when handling all cables. Refer to Section 8.9.
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7. Pull the drive release lever away from the hard drive 1, then lift the cable-end of the drive 2 
up and pull it towards the center of the chassis 3 to remove it from the drive cage.

8. Remove the four guide screws (two on each side) from the old drive. You will need these 
screws to install a new drive. 

9. Store the removed drive in anti-static packaging.

To install a drive, reverse the removal procedure.
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8.16 Front I/O Device 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Remove the hard drive (Section 8.15).

7. Remove the two screws that hold the front I/O device in place 1.

8. Disconnect the audio cable from the back of the IO device 2 and pull that cable through the 
tunnel opening in the chassis 3.

9. Disconnect the I/O cables from the system board.

To install the front I/O device, follow this sequence:

1. Thread the audio cable through the tunnel in the chassis and attach it to the front I/O board.

2. Attach the front USB cable and the power switch/LED cable to the front I/O board.

3. Attach the front I/O board to the chassis with two screws.

4. Plug the cables into the system board.

✎ All cables are color coded to match their connectors on the front I/O board and are keyed to 
prevent improper connections.
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8.17 Heatsink Assembly 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Disconnect the thermal sensor and heatsink fan cables 1 from the system board.

7. Unscrew the four screws that secure the heatsink to the system board 2 then, lift the heatsink 
from the system board 3.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

8. Lay the heatsink on its top in a safe area to prevent the thermal grease from contaminating 
the work surface.
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8.17.1 Heatsink Fan with Shroud
1. Turn the heatsink assembly upside down and set it on a flat surface.

2. Spread the four snaps that are hooked around the base of the heatsink 1 and lift the heatsink 
from the shroud 2.

To install a new shroud, reverse the removal procedure.

When reinstalling the heatsink in the computer, make sure that the top of the processor and the 
bottom of the heatsink have been cleaned with an alcohol wipe and fresh thermal grease has been 
applied to the top of the processor.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.
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8.18 Processor
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Remove the heatsink (Section 8.17).

7. Rotate the processor locking lever to its full open position 1.

8. Raise and rotate the microprocessor retainer to its fully open position 2.

9. Carefully lift the processor from the socket 3. 

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 5.

3. If reusing the existing heatsink clean bottom of the heatsink and apply the thermal grease 
provided in the spares kit to the top of the processor.
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4. Clean the bottom of the heatsink with the provided alcohol pad and place it atop the 
processor.

Go to step 6.

5. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

6. Secure the heatsink to the system board and system board tray with the 4 captive screws and 
attach the heatsink control cable to the system board.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system ROMPaq can 
be found on the Web at: http:\\h18000.www1.hp.com/support/files.
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8.19 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Disconnect the power supply cable from the hard drive and the 6-pin power supply cable on 
the system board alongside the heatsink.

7. Slide the power supply towards the front of the chassis 1 about 1.3 cm (1/2 inch) then slide 
it towards the center of the chassis and rotate it up 2 to access the main cable connection 
beneath it.

8. Disconnect the power cable from thesystem board 3.

✎ There are slots on the chassis that match with clips on the bottom of the power supply for positive 
retention.

9. Remove the power supply from the chassis.

To install the power supply, reverse the removal procedure. Make sure the power supply engages 
the clips on the chassis when sliding it into place.

✎ When installing the power supply make sure the cables are routed properly and do not interfere 
with the access panel installation.
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8.20 Battery
The battery that comes with this computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C) 
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP/Compaq spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting 
Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP/Compaq, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Raise the power supply to access the battery but do not either disconnect the cables or 
remove the assembly from the chassis (Section 8.19).

6. Depending on the type of battery holder on the system board, complete the following 
instructions to replace the battery:
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8.20.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer cover or access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup Guide.
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8.20.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp 1 that extends above one 

edge of the battery. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

After the battery has been replaced, reverse the disassembly procedure

3. Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup. 
Refer to the Computer Setup Guide.
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R&R 
8.20.3 Type 3 Battery
1. Pull back on the clip 1 that holds the battery in place, then remove the battery 2.

2. Insert the new battery and position the clip back in place.

✎ After the battery has been replaced, use the following steps to complete this procedure.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer Setup. 
Refer to the Computer Setup (F10) Utility Guide.

CHeck 
process
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8.21 Speaker 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the expansion card cage (Section 8.11).

4. Disconnect the speaker cable from the system board.

5. Grasp the bottom of the speaker while at the same time pressing down on the tab on its top 
then, slide the speaker towards the center of the chassis to release it.

To install the speaker, reverse the removal procedure.
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8.22 System Board 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove any MultiBay device in the drive cage (Section 8.4).

4. Remove the MultiBay riser card (Section 8.5).

5. Remove the front panel assembly (Section 8.6).

6. Remove the memory modules (Section 8.10).

7. Remove the heatsink (Section 8.17).

8. Remove the power supply (Section 8.19).

9. Disconnect all cables connected to the system board, noting their location for reinstallation.

10. Remove the thumbscrew that secures the system board to the chassis 1. 

11. Slide the system board towards the front of the chassis 2, making sure that all keyhole 
retainers are clear before lifting the system board from the chassis.

Ä
CAUTION: Be very careful when removing or replacing the system board to prevent damaging it.

To install the system board, reverse the removal procedure.

✎ When installing the system board make sure that the board is pressed firmly against the floor of 
the chassis to allow the keys to lock into the keyhole slots on the system board.
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A
Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. 
Some of these connectors may not be used on the product being serviced.

Keyboard
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Mouse
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Ethernet BNC
Connector and Icon Pin Signal

1 (Center) Data

2 (Shield) Ground
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Ethernet RJ-45
Connector and Icon Pin Signal

1 
2 
3 
4

(+) Transmit Data 
(-) Transmit Data 
(+) Receive Data 
Unused

5 
6 
7 
8

Unused 
(-) Receive Data 
Unused 
Unused

Ethernet AUI

Connector and Icon

Pin Signal Pin Signal

1 
2 
3 
4

Ground 
Negative AUI Differential Collision 
Positive AUI Differential Collision 
Negative AUI Differential Transmit

9 
10 
11 
12

Positive AUI Differential Receive 
+12V 
Ground 
Ground

5 
6 
7 
8

Positive AUI Differential Transmit 
Ground 
Ground 
Negative AUI Differential Receive

13 
14 
15 
16

Unused 
Unused 
Unused 
Unused
A–2 361288-003 Service Reference Guide, dc7100



Connector Pin Assignments
Parallel Interface

Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Strobe 
Data Bit 0 
Data Bit 1

7 
8 
9

Data Bit 5 
Data Bit 6 
Data Bit 7

13 
14 
15

Select 
Auto Linefeed 
Error

4 
5 
6

Data Bit 2 
Data Bit 3 
Data Bit 4

10 
11 
12

Acknowledge 
Busy 
Paper End

16 
17 
18-25

Initialize Printer 
Select IN 
Signal Ground

Serial Interface, Powered and Non-Powered
Connector and Icon Pin Signal

1 
2 
3

Carrier Detect (12V if powered) 
Receive Data 
Transmit Data

4 
5 
6

Data Terminal Ready 
Signal Ground 
Data Set Ready

7 
8 
9

Request to Send 
Clear to Send 
Ring Indicator (5V if powered)

USB
Connector and Icon Pin Signal

1 
2 
3 
4

+5 VDC 
- Data 
+ Data 
Ground

Microphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio

2 (Ring) Power

3 (Shield) Ground

1 2 31 2 3
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Connector Pin Assignments
Headphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Left

2 (Ring) Audio_Right

3 (Shield) Ground

Line-In Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_In_Left

2 (Ring) Audio_In_Right

3 (Shield) Ground

Line-Out Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Out_Left

2 (Ring) Audio_Out_Right

3 (Shield) Ground

SCSI Low Voltage Differential/Single Ended (LVD/SE)
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-16 
17-18 
19

Ground 
TERMPWR 
Reserved

40 
41 
42

-D0 
-D1 
-D1

49-50 
51-52 
53

Ground 
TERMPW 
Reserved

60 
61 
62

-MSG 
-SEL 
-C/D

20-34 
35 
36

Ground 
-D12 
-D13

43 
44 
45

-D3 
-D4 
-D5

54 
55 
56

Ground 
-ATN 
Ground

63 
64 
65

-REQ 
-I/O 
-D

37 
38 
39

-D14 
-D15 
-DP1

46 
47 
48

-D6 
-D7 
-DP0

57 
58 
59

-BSY 
-ACK 
-RST

66 
67 
68

-D 
-D 
-D

1 2 3

1 2 3

1 2 3
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Connector Pin Assignments
Ultra SCSI
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-11 
12 
13 
14

Ground 
Reserved 
Open 
Reserved

29 
30 
31 
32

DB3 
DB4 
DB5 
DB6

37 
38 
39 
40

Reserved 
TERMPWR 
Reserved 
Ground

45 
46 
47 
48

RST # 
MSG # 
SEL # 
C/D

15-25 
26 
27 
28

Ground 
DB0 
DB1 
DB2

33 
34 
35 
36

DB7 
DBP 
Ground 
Ground

41 
42 
43 
44

ATN # 
Ground 
BSY # 
ACK #

49 
50

REQ # 
Input/Output

External Infrared Transceiver
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Transmit 
Receive 
Ground

4 
5 
6

5V 
Mode 
Not Used

7 
8 

Not Used 
Not Used

Monitor
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Red Analog 
Green Analog 
Blue Analog

6 
7 
8

Ground 
Ground 
Ground

11 
12 
13

Not used 
DDC Serial Data 
Horizontal Sync

4 
5

Not used 
Ground

9 
10

+5V (fused) 
Ground

14 
15

Vertical Sync 
DDC Serial Clock
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Connector Pin Assignments
ATA/ATAPI (IDE) Standard Drive Cable
Connector

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
 

MultiBay CD-ROM Adapter
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

RESDRV_ 
GROUND 
D07 
D08 
D06

18 
19 
20 
21 
22

D15 
GROUND 
(key) 
DRQ 
GROUND

35 
36 
37 
38 
39

A0 
A2 
CS1FX 
CS3FX 
DASP

52 
53 
54 
55 
56

FP05 
FP06 
FP07 
FP08 
FP09

6 
7 
8 
9 
10

D09 
D05 
D10 
D04 
D11

23 
24 
25 
26 
27

IOW 
GROUND 
IOR 
GROUND 
IOCHDRY

40 
41 
42 
43 
44

GROUND 
+5VMLOG 
-5VMOT 
GROUND 
AUDIO_L

57 
58 
59 
60 
61

FP10 
FP11 
FP12 
FP13 
FP14

11 
12 
13 
14 
15

D03 
D12 
D02 
D13 
D01

28 
29 
30 
31 
32

CABLE SELECT 
DAK 
GROUND 
IRQ 
IO16

45 
46 
47 
48 
49

A_GROUND_R 
A_GROUND_I 
audio_r 
FP01 
FP02

62 
63 
64 
65 
66

FP15 
FP16 
FP17 
FP18 
FP19

16 
17

D14 
D00

33 
34

A1 
PDIAG

50 
51

FP03 
FP04

67 
68

FP20 
FP21
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Connector Pin Assignments
24-Pin Power

Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5 
6

+3.3 V 
+3.3 V 
GND 
+5 V 
GND 
+5 V

7 
8 
9 
10 
11 
12

GND 
POK 
+5 Vaux 
+12 V 
+12 V 
+3.3 V

13 
14 
15 
16 
17 
18

+3.3 V 
-12 V 
GND 
PSON 
GND 
GND

19 
20 
21 
22 
23 
24

GND 
open 
+5 V 
+5 V 
+5 V 
GND

24

12

13

1

24-Pin MicroFit Power

Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5 
6

+5 Vaux 
GND
+5 V 
+5 V 
PS_ON 
GND

7 
8 
9 
10 
11 
12

PWRGD
+3.3 V 
+3.3 V 
Tach 
GND 
Fan-CMD

13 
14 
15 
16 
17 
18

+12 V 
+5 V Sense 
GND 
+5 V 
+5 V 
+3.3 V

19 
20 
21 
22 
23 
24

GND 
+3.3 Sense 
+3.3 V 
+3.3 V 
GND 
-12 V

4-Pin Power (for CPU)
Connector and Icon Pin Signal

1 GND

2 GND

3 +12 V CPU

4 -12 V CPU

24

12

13�

1
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Connector Pin Assignments
 

6-Pin Power

Connector and Icon Pin Signal

1 GND

2 GND

3 GND

4 12 V CPU

5 12 V CPU

6 +12 V

64

SATA Data and Power 

Drive Connector

Pin Signal Pin Signal Pin Signal Pin Signal

S1
S5

Ground
B-

S2
S6

A+
B+

S3
S7

A-
Ground

S4 Ground

P1
P5
P9
P13

V 3.3
Ground
V 5
V 12

P2
P6
P10
P14

V 3.3
Ground
Ground
V 12

P3
P7
P11
P15

V 3.3
V 5
Reserved
V 12

P4
P8
P12

Ground
V 5
Ground

*S = Data, P = Power
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Connector Pin Assignments
PCI Express 

x1, x4, x8, and x16 PCI Express Connector

Pin A

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

PRSNT1# 
+12V 
+12V 
GND 
JTAG2

6 
7 
8 
9 
10

JTAG3 
JTAG4 
JTAG5 
+3.3v 
+3.3v

11 
12 
13 
14 
15

PERST# 
GND 
REFCLK+ 
REFCLK- 
GND

16 
17 
18 
19 
20

PERp0 
PERn0 
GND 
RSVD 
GND

21 
22 
23 
24 
25

PERp1 
PERn1 
GND 
GND 
PERp2

26 
27 
28 
29 
30

PERn(2) 
GND 
GND 
PERp3 
PERn3

31 
32 
33 
34 
35

GND 
RSVD 
RSVD 
GND 
PERp4

36 
37 
38 
39 
40

PERn4 
GND 
GND 
PERp5 
PERn5

41 
42 
43 
44 
45

GND 
GND 
PERp6
PERn6 
GND

46 
47 
48 
49 
50

GND 
PERp7 
PERn7 
GND 
RSVD

51 
52 
53 
54 
55

GND 
PERp8 
PERn8 
GND 
GND

56 
57 
58 
59 
60

PERp9 
PERn9 
GND 
GND 
PERp10

61
62 
63 
64 
65

PERn10 
GND 
GND 
PERp11 
PERn11

66 
67 
68 
69 
70

GND 
GND 
PERp12 
PERn12 
GND

71 
72 
73 
74 
75

GND 
PERp13 
PERn13 
GND 
GND

76 
77 
78 
79 
80

PERp14 
PERn14 
GND 
GND 
PERp15

81 
82

PERn15 
GND

Pin B information is on the next page

Notes: 
x1 PCI Express uses pins 1-18 
x4 PCI Express uses pins 1-32 
x8 PCI Express uses pins 1-49 
x16 PCI Express uses pins 1-82 
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Connector Pin Assignments
Pin B

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

+12V 
+12V 
RSVD 
GND 
SMCLK

6 
7 
8 
9 
10

SMDAT 
GND 
+3.3v 
JTAG1 
3.3vAux

11 
12 
13 
14 
15

WAKE# 
RSVD 
GND 
PETp0 
PETn0

16 
17 
18 
19 
20

GND 
PRSNT2# 
GND 
PETp1 
PETn1

21 
22 
23 
24 
25

GND 
GND 
PETp2 
PETn2 
GND

26 
27 
28 
29 
30

GND 
PETp3 
PETn3 
GND
RSVD

31 
32 
33 
34 
35

PRSNT2# 
GND 
PETp4 
PETn4 
GND

36 
37 
38 
39 
40

GND 
PETp5 
PETn5 
GND 
GND

41 
42 
43 
44 
45

PETp6 
PRTn6 
GND 
GND 
PETp7

46 
47 
48 
49 
50

PETn7 
GND 
PRSNT2# 
GND 
PETp8

51 
52 
53 
54 
55

PETn8 
GND 
GND 
PETp9 
PETn9

56 
57 
58 
59 
60

GND 
GND 
PETp10 
PETn10 
GND

61 
62 
63 
64 
65

GND 
PETp11 
PETn11 
GND 
GND

66 
67 
68 
69 
70

PETp12 
PETn12 
GND 
GND 
PETp13

71 
72 
73 
74 
75

PETn13 
GND 
GND 
PETp14 
PETn14

76 
77 
78 
79 
80

GND 
GND 
PETp15 
PETn15 
GND

81 
82

PRSNT2# 
RSVD

Notes: 
x1 PCI Express uses pins 1-18 
x4 PCI Express uses pins 1-32 
x8 PCI Express uses pins 1-49 
x16 PCI Express uses pins 1-82

PCI Express 

x1, x4, x8, and x16 PCI Express Connector
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B
Power Cord Set Requirements

The voltage select switch feature on the computer permits it to operate from any line voltage 
between 100-120 or 220-240 volts AC. 

The power cord set received with the computer meets the requirements for use in the country 
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you 
use the computer. For more information on power cord set requirements, contact your authorized 
HP dealer, reseller, or service provider.

General Requirements
The requirements listed below are applicable to all countries: 

1. The length of the power cord set must be at least 1.8 m (6.00 feet) and a maximum of 3.0 m 
(9.75 feet).

2. All power cord sets must be approved by an acceptable accredited agency responsible for 
evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal voltage 
rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 
Standard Sheet C13 connector, for mating with appliance inlet on the Switch Box.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below. 

Country
Accrediting

Agency Country
Accrediting

Agency

Australia (1) 
Austria (1) 
Belgium (1)  
Canada (2)

EANSW 
OVE 
CEBC 
CSA

Italy (1) 
Japan (3) 
Norway (1) 
Sweden (1)

IMQ 
METI 
NEMKO 
SEMKO

Denmark (1) 
Finland (1)  
France (1)  
Germany (1) 

DEMKO 
SETI 
UTE 
VDE

Switzerland (1) 
United Kingdom (1) 
United States (2) 

SEV 
BSI 
UL 

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm2 conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of 
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug 
must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P 
(15A 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a "T" mark and registration 
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or 
VCTF, 3-conductor, 1.0 mm2 conductor size. Wall plug must be a two-pole grounding type 
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C
POST Error Messages

POST Error Messages
An error message results if the Power-On Self-Test (POST) encounters a problem. This test runs 
when the system is turned on, checking assemblies within the computer and reporting any errors 
found. 

Not all computers use all of the codes listed.

POST Error Messages 

Screen Message Probable Cause Recommended Action

101-Option ROM 
Checksum Error

System ROM or 
expansion board option 
ROM checksum.

Verify the correct ROM.
Flash the ROM if needed.
If an expansion card was recently 
added, remove it and see if the problem 
remains. 
Clear CMOS.
If the message disappears, there may be 
a problem with the expansion card.
Replace the system board.

110-Out of Memory 
Space for Option 
ROMs

Recently added PCI 
expansion card contains 
an option ROM too large 
to download during 
POST.

If a PCI expansion card was recently 
added, remove it to see if the problem 
remains.
In Computer Setup, disable the NIC PXE 
Option ROM Download to prevent PXE 
option ROM for the internal NIC from 
being downloaded during POST to free 
more memory for an expansion card’s 
option ROM. Internal PXE option ROM is 
used for booting from the NIC to a PXE 
server.
Enable the ACPI/USB Buffers @ Top of 
Memory setting in Computer Setup.

162-System Options 
Not Set

Configuration incorrect.
RTC (real-time clock) 
battery may need to be 
replaced. 

Run Computer Setup (F10 Setup) and 
check configuration of Onboard 
Devices.
Set the date and time under Control 
Panel or in F10 Setup depending on 
the operating system.
If the problem persists, replace the RTC 
battery.
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163-Time & Date Not 
Set

Invalid time or date in 
configuration memory. 
RTC (real-time clock) 
battery may need to be 
replaced. 

Set the date and time under Control 
Panel or in F10 Setup depending on 
the operating system. 
If the problem persists, replace the RTC 
battery. 

CMOS jumper may not 
be properly installed.

Check for proper placement of the 
CMOS jumper, if applicable.

164-Memory Size Error Memory amount has 
changed since the last 
boot (memory added or 
removed).

Press the F1 key to save the memory 
changes.

Memory configuration is 
incorrect.

Run Computer Setup (F10 Setup).
Make sure memory module(s) (if any) are 
installed properly.
If third party memory has been added, 
test using HP-only memory.
Verify proper memory module type.

201-Memory Error RAM failure. Run Computer Setup (F10 Setup) or 
Windows utilities.
Ensure memory and continuity modules 
are installed correctly.
Verify proper memory module type.
Remove and replace memory module(s) 
one at a time to isolate faulty module.
Replace the faulty memory module(s).
If error persists after replacing memory 
modules, replace the system board.

213-Incompatible 
memory Module in 
memory Socket(s)  
X,X, X

A memory module in 
memory socket identified 
in the error message is 
missing critical SPD 
information, or is 
incompatible with the 
chipset.

Verify proper memory module type.
Try another memory socket.
Replace memory with a module 
conforming to the SPD standard.

214-DIMM 
Configuration Warning

Populated DIMM 
configuration is not 
optimized.

Rearrange the DIMMS so that each 
channel has the same amount of 
memory.

219-ECC Memory 
Module Detected ECC 
Modules not supported 
on this platform

Recently added memory 
module(s) support ECC 
memory error correction.

If additional memory was recently 
added, remove it to see if the problem 
remains.
Check product documentation for 
memory support information.

POST Error Messages 

Screen Message Probable Cause Recommended Action
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301-Keyboard Error Keyboard failure. Reconnect keyboard with computer 
turned off.
Check connector for bent or missing 
pins.
Ensure that none of the keys are 
depressed.
Replace keyboard.

303-Keyboard 
Controller Error

I/O board keyboard 
controller.

Reconnect keyboard with computer 
turned off.
Replace the system board.

304-Keyboard or 
System Unit Error

Keyboard failure. Reconnect the keyboard with computer 
turned off.
Ensure that none of the keys are 
depressed.
Replace keyboard.
Replace system board. 

501-Display Adapter 
Failure

Graphics display 
controller.

Reseat the graphics card (if applicable).
Clear CMOS.
Verify that the monitor is attached and 
turned on.
Replace the graphics controller (if 
applicable).

510-Splash Screen 
image corrupted

Splash Screen image has 
errors.

Install latest version of ROMPaq to 
restore image.

511-CPU, CPUA, or 
CPUB Fan not detected

Fan is not connected or 
may have malfunctioned.

Reseat fan cable.
Reseat the fan.
Replace the fan.

512-Chassis, rear 
chassis, or front chassis 
fan not detected

Fan is not connected, 
may have malfunctioned.

Reseat chassis, rear chassis, or front 
chassis fan cable.
Reseat chassis, rear chassis, or front 
chassis fan.
Replace chassis, rear chassis, or front 
chassis fan.

514-CPU or Chassis 
Fan not detected.

CPU fan is not connected 
or may have 
malfunctioned.

Reseat CPU or chassis fan.
Reseat fan cable.
Replace CPU or chassis fan.

601-Diskette Controller 
Error

Diskette controller 
circuitry or floppy drive 
circuitry incorrect.

Run Computer Setup (F10 Setup).
Check and/or replace cables.
Clear CMOS.
Replace diskette drive. 
Replace the system board.

POST Error Messages 

Screen Message Probable Cause Recommended Action
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605-Diskette Drive Type 
Error

Mismatch in drive type. Run Computer Setup (F10 Setup).
Disconnect any other diskette controller 
devices (tape drives).
Clear CMOS.

912-Computer Cover 
Has Been Removed 
Since Last System Start 
Up

No action required.

917-Front Audio not 
Detected

Front audio harness has 
been detached or 
unseated from the system 
board.

Reconnect or replace front audio 
harness.

919-Front Panel, 
MultiPort, and/or 
MultiBay Risers not 
Detected.

Riser card has been 
removed or has not been 
reinstalled properly in the 
system.

Unplug computer and install/reinstall 
riser cord.

921-Device in PCI 
Express slot failed to 
initialize.

There is an 
incompatibility/problem 
with this device and the 
system or PCI Express Link 
could not be retrained to 
an X1.

Try rebooting the system. If the error 
reoccurs, the device may not work with 
this system.

✎ This error message applies to the PCI Express Graphics slot using Intel 9X1 Express chipsets. This 
slot supports x1 and x16 (PCI Express Link Width cards) only. If a x4 or x8 card is used, system 
BIOS will attempt to retrain to a x1. If this fails, the 921 error message will be displayed.

1720-SMART Hard 
Drive Detect Imminent 
Failure

Hard drive is about to 
fail. (Some hard drives 
have a firmware patch 
that will fix an erroneous 
error message.)

Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test if applicable.
Apply firmware patch if applicable. (see 
www.hp.com/support)
Back up contents and replace hard drive.

1785-MultiBay 
incorrectly installed  

(for MultiBay option on 
non-USDT systems)
Multibay option ribbon 
cables not seated or 
improperly attached.
or
MultiBay device not 
properly seated.
or
MultiBay diskette present.

Ensure the MultiBay option is attached 
as device 0 on the IDE cable.
Ensure no other device is attached to the 
same IDE cable.
Ensure both ends of the IDE and 
MultiBay ribbon cables are properly 
seated.
Ensure the MultiBay device is fully 
inserted.
Ensure a MultiBay diskette is not present 
(MultiBay diskette drives are not 
supported by the MultiBay option).

POST Error Messages 

Screen Message Probable Cause Recommended Action
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1785-MultiBay 
incorrectly installed 
(continued)

(for integrated MultiBay/ 
USDT systems)
MultiBay device not 
properly seated.
or
MultiBay riser not 
properly seated. 

Ensure the MultiBay device is fully 
inserted.
Ensure the MultiBay riser is properly 
seated.

1794-Inaccessible 
devices attached to 
SATA 1 and/or SATA 3

A device is attached to 
SATA 1 and/or SATA 3.
Devices attached to these 
connectors will be 
inaccessible while “SATA 
Emulation” is set to 
“Combined IDE 
Controller” in Computer 
Setup.

If using Windows 2000 or Windows XP, 
change “SATA Emulation” to “Separate 
IDE Controller” in Computer Setup.
If not using Windows 2000 or Windows 
XP, relocate the affected devices to SATA 
0 or SATA 2 (if available).
Remove the affected devices from SATA 
1 and SATA 3.

1796-SATA Cabling 
Error

One or more SATA 
devices are improperly 
attached. For optimal 
performance, the SATA 0 
and SATA 1 connectors 
must be used before 
SATA 2 and SATA 3.

Ensure SATA connectors are used in 
ascending order. For one device, use 
SATA 0. For two devices, use SATA 0 
and SATA 1. For three devices, use SATA 
0, SATA1, and SATA 2.

1801-Microcode Patch 
Error

Processor not supported 
by ROM BIOS.

Upgrade BIOS to proper version.
Change the processor.

1998-Master Boot 
Record has been lost.

The previously saved 
copy of the MBR has 
been corrupted.

Run Computer Setup and save the MBR 
of the current bootable disk.

1999-Master Boot 
Record has been 
changed.

The current MBR does not 
match the previously 
saved copy of the MBR.

Use extreme caution, The MBR may have 
been updated due to normal disk 
maintenance activities (disk manager, 
fdisk, or format). 

Ä Replacing the previously saved MBR 
in such situations can cause data 
loss. 

If certain that the MBR change is 
unintentional and undesired (e.g. due to 
a virus), run Computer Setup and restore 
the previously saved MBR copy. 
Otherwise, run Computer Setup and 
either disable MBR security or save the 
MBR of the current bootable disk.

POST Error Messages 

Screen Message Probable Cause Recommended Action
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2000-Master Boot 
Record Hard Drive has 
Changed.

The current bootable hard 
drive is not the same as 
the one that was present 
when MBR security was 
enabled.

Run Computer Setup and either disable 
MBR security or save the MBR of the 
current bootable disk.

Invalid Electronic Serial 
Number.

Electronic serial number 
has become corrupted.

Run Computer Setup. If Setup already 
has data in the field or will not allow the 
serial number to be entered, download 
from http://www.hp.com and run 
SP5572.EXE (SNZERO.EXE).
Run Computer Setup and try to enter 
serial number under Security, System ID, 
then save changes.

Network Server Mode 
Active and No 
Keyboard Attached

Keyboard failure while 
Network Server Mode 
enabled.

Reconnect keyboard with computer 
turned off.
Check connector for bent or missing 
pins.
Ensure that none of the keys are 
depressed.
Replace keyboard.

Parity Check 2. Parity RAM failure. Run Computer Setup and Diagnostic 
utilities.

POST Error Messages 

Screen Message Probable Cause Recommended Action
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POST Diagnostic Front Panel LEDs and Audible Codes
This section covers the front panel LED codes as well as the audible codes that may occur before 
or during POST that do not necessarily have an error code or text message associated with them.

✎ If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the 
computer and refer to the following table to determine the front panel LED codes.

✎ Recommended actions in the following table are listed in the order in which they should be 
performed.

✎ Beeps will occur only for 5 iterations and then stop. LEDs will continue to blink until corrective 
action is taken.

POST Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps
Possible 
Cause Recommended Action

Green Power LED 
On.

None Computer on. None

Green Power LED 
flashes every two 
seconds.

None Computer in 
Suspend to RAM 
mode (select 
models only) or 
normal Suspend 
mode.

None required. Press any key or move the 
mouse to wake the computer.

Red Power LED 
flashes two times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after the fifth 
iteration but the 
LED continues to 
flash until the issue 
has been resolved.

2 Processor 
thermal 
protection 
activated:
A fan may be 
blocked or not 
turning.
OR 
The heatsink/fan 
assembly is not 
properly 
attached to the 
processor. 

Ensure that the computer air vents are not 
blocked and the processor cooling fan is 
running.
Open hood, press power button, and see 
if the processor fan spins. If the processor 
fan is not spinning, make sure the fan's 
cable is plugged onto the system board 
header. Ensure the fan is fully/properly 
seated or installed.
If fan is plugged in and seated properly, 
but is not spinning, then replace processor 
fan.
Reseat processor heatsink and verify that 
the fan assembly is properly attached.
Contact an authorized reseller or service 
provider.
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Red Power LED 
flashes three times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after the fifth 
iteration but the 
LED continues to 
flash until the issue 
has been resolved.

3 Processor not 
installed (not an 
indicator of bad 
processor).

Check to see that the processor is present.
Reseat the processor.

Red Power LED 
flashes four times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after the fifth 
iteration but the 
LED continues to 
flash until the issue 
has been resolved.

4 Power failure 
(power supply is 
overloaded).

Open the hood and ensure the power 
supply cable is seated into the connector 
on the system board.
Check if a device is causing the problem 
by removing ALL attached devices (such as 
hard, diskette, or optical drives, and 
expansion cards). Power on the system. If 
the system enters the POST, then power off 
and replace one device at a time and 
repeat this procedure until failure occurs. 
Replace the device that is causing the 
failure. Continue adding devices one at a 
time to ensure all devices are functioning 
properly.
Replace the power supply.
Replace the system board.

Red Power LED 
flashes five times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after the fifth 
iteration but the 
LED continues to 
flash until the issue 
has been resolved.

5 Pre-video 
memory error.

Reseat DIMMs. Power on the system.
Replace DIMMs one at a time to isolate 
the faulty module.
Replace third-party memory with HP 
memory.
Replace the system board.

Activity Beeps
Possible 
Cause Recommended Action
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Red Power LED 
flashes six times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after the fifth 
iteration but the 
LED continues to 
flash until the issue 
has been resolved.

6 Pre-video 
graphics error. 

For systems with a graphics card:
Reseat the graphics card. Power on the 
system.
Replace the graphics card.
Replace the system board.
For systems with integrated graphics, 
replace the system board.

Red Power LED 
flashes seven 
times, once every 
second, followed 
by a two second 
pause. Beeps stop 
after the fifth 
iteration but the 
LED continues to 
flash until the issue 
has been resolved.

7 System board 
failure (ROM 
detected failure 
prior to video).

Replace the system board.

Red Power LED 
flashes eight times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after the fifth 
iteration but the 
LED continues to 
flash until the issue 
has been resolved.

8 Invalid ROM 
based on bad 
checksum.

Reflash the ROM using a ROMPaq 
diskette. See the “ROM Flash” section of 
the Desktop Management Guide on the 
Documentation CD.
Replace the system board.

Activity Beeps
Possible 
Cause Recommended Action
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Red Power LED 
flashes nine times, 
once every 
second, followed 
by a two second 
pause.

9 System powers 
on but is unable 
to boot.

 Check that the voltage selector, located 
on the rear of the power supply (some 
models), is set to the appropriate voltage. 
Proper voltage setting depends on your 
region.
Replace the system board.
Replace the processor. 

Red Power LED 
flashes ten times, 
once every 
second, followed 
by a two second 
pause.

10 Bad option card. Check each graphics card by removing 
the card (one at a time if multiple cards), 
then power on the system to see if fault 
goes away.
Once a bad card is identified, remove and 
replace the bad option card.
Replace the system board.

System does not 
power on and 
LEDs are not 
flashing.

None System unable to 
power on.

Press and hold the power button for less 
than 4 seconds. If the hard drive LED turns 
green, then:
Check that the voltage selector, located on 
the rear of the power supply, is set to the 
appropriate voltage. Proper voltage 
setting depends on your region.
Remove the expansion cards one at a time 
until the 3V_aux light on the system board 
turns on.
Replace the system board.
OR
Press and hold the power button for less 
than 4 seconds. If the hard drive LED does 
not turn on green then:
Check that the unit is plugged into a 
working AC outlet.
Open hood and check that the power 
button harness is properly connected to 
the system board.
Check that both power supply cables are 
properly connected to the system board.
Check to see if the 3V_aux light on the 
system board is turned on. If it is turned 
on, then replace the power button harness.
If the 3V_aux light on the system board is 
not turned on, then replace the power 
supply.
Replace the system board.

Activity Beeps
Possible 
Cause Recommended Action
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D
Troubleshooting Without Diagnostics

Preliminary Checklist
This section describes some simple, preliminary tests and guidelines for troubleshooting the 
computer without using the diagnostics.

■ Are the computer and monitor connected to a working electrical outlet?

■ Is the voltage select switch is set to the appropriate voltage for your region (115V or 230V)?

■ Is the computer turned on?

■ Is the green power light illuminated?

■ Is the monitor turned on?

■ Is the green monitor light illuminated?

■ Turn up the monitor brightness and contrast controls if the monitor is dim.

■ If the system has multiple video sources (embedded or PCI adapters) installed (embedded 
video on select models only) and a single monitor, the monitor must be plugged into the 
monitor connector on the source selected as the primary VGA adapter. During boot, the other 
monitor connectors are disabled and if the monitor is connected into these ports, the monitor 
will not function. You can select which source will be the default VGA source in Computer 
(F10) Setup.

■ Press and hold any key. If the system beeps, then the keyboard is operating correctly.

■ Check all cables for loose or incorrect connections.

■ Reconfigure the computer after installing a non–Plug and Play expansion board or other 
option, such as a diskette drive.

■ Are all of the necessary device drivers installed?

■ Have all printer drivers been installed for each application?

■ Remove all bootable media (diskette, CD, or USB device) from the system before turning on 
the system.

■ Are all switches set correctly?

■ Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC and 
the riser/system board?
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Solving Minor Problems

Solving Minor Problems 

Problem Cause Possible Solution

Computer appears 
locked up and will not 
turn off when the power 
button is pressed.

Software control of the 
power switch is not 
functional.

1. Press and hold the power button 
for at least four seconds until the 
computer turns off.

2. Disconnect electrical plug from 
outlet.

Computer will not 
respond to USB 
keyboard or mouse.

Computer is in 
standby mode.

Press the power button to resume from 
standby mode.

System has locked up. Restart computer.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the power 
button for more than four seconds. Otherwise, the computer will shut down and you will lose 
any unsaved data. 

Computer date and 
time display is incorrect.

RTC (real-time clock) 
battery may need to be 
replaced. 

1. Reset the date and time under 
Control Panel. 

2. Replace the RTC battery.

Computer appears to 
pause periodically.

Network driver is loaded 
and no network 
connection is established.

Establish a network connection, or 
use Computer Setup or Microsoft 
Windows Device Manager to disable 
the network controller.

Cursor will not move 
using the arrow keys on 
the keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The Num 
Lock key can be disabled (or 
enabled) in Computer Setup.

Cannot remove 
computer cover or 
access panel.

Smart Cover Lock, 
featured on some 
computers, is locked.

1. Unlock the Smart Cover Lock 
using Computer Setup.

2. Use the Smart Cover FailSafe Key 
in case of forgotten password, 
power loss, or computer 
malfunction.

Poor performance is 
experienced.

Processor is hot. 1. Ensure airflow to the computer is 
not blocked.

2. Ensure the fans are connected 
and working properly (some fans 
only operate when needed).

3. Ensure the processor heatsink is 
installed properly.

Hard drive is full. Transfer data from the hard drive to 
create more space on the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.
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Poor performance is 
experienced. 
(continued)

Program previously 
accessed did not release 
reserved memory back to 
the system

Restart the computer.

Virus resident of the hard 
drive.

Run virus protection program.

Too many applications 
running.

Close unnecessary applications.
Add more memory.

Cause unknown. Restart the computer.

Computer powered off 
automatically and the 
Power LED flashes Red 
two times, once every 
second, followed by a 
two second pause, and 
the computer beeps two 
times. Beeps continue 
for five iterations after 
which the LED flashes 
will continue until the 
problem is resolved.

Processor thermal 
protection activated:
A fan may be blocked or 
not turning.
OR 
The heatsink is not 
properly attached to the 
processor.

1. Ensure computer air vents are not 
blocked and the cooling fan is 
running.

2. Open hood, press power button, 
and see if the processor fan 
spins. If not spinning, make sure 
the fan's cable is plugged onto 
the system board header. Ensure 
the fan is fully/properly seated or 
installed.

3. Replace the processor fan.
4. Reseat processor heatsink and 

verify that the fan assembly is 
properly attached.

Solving Minor Problems (Continued)

Problem Cause Possible Solution
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System does not power 
on and the LEDs on the 
front of the computer 
are not flashing.

System unable to power 
on.

Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED turns green, then:
1. Check that the voltage selector is 

set to the appropriate voltage. 
2. Remove the expansion cards one 

at a time until the 5 V_aux light 
on the system board turns on.

3. Replace the system board.
OR
Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED does not turn on green then:
1. Check that the unit is plugged 

into a working AC outlet.
2. Open hood and check that the 

power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. If the 5 V_aux light on the system 
board is on, then replace the 
power button harness.

5. If the 5 V_aux light on the system 
board is off, then replace the 
power supply.

6. Replace the system board.

Solving Minor Problems (Continued)

Problem Cause Possible Solution
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Solving Power Supply Problems

Solving Power Supply Problems 

Problem Cause Solution

Power supply shuts down 
intermittently.

Voltage selector switch 
on rear of computer 
chassis not switched to 
correct line voltage.

Select the proper AC voltage.

Power supply fault. Replace the power supply.

Computer powered off 
automatically and the 
Power LED flashes Red two 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps two times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Processor thermal 
protection activated:
A fan may be blocked 
or not turning.
OR 
The heatsink/fan 
assembly is not properly 
attached to the 
processor.

1. Ensure that the computer air 
vents are not blocked and the 
cooling fan is running.

2. Open hood, press the power 
button, and see if the processor 
fan spins. If the processor fan is 
not spinning, make sure the 
fan's cable is plugged onto the 
system board header. Ensure 
the fan is fully/properly seated 
or installed.

3. Replace the processor fan.
4. Reseat processor heatsink and 

verify that the fan assembly is 
properly attached.

Power LED flashes Red, four 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps four times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Power failure (power 
supply is overloaded).

1. Check that the voltage selector, 
is set to the appropriate voltage. 

2. Open the hood and ensure the 
4-wire power supply cable is 
seated into the connector on the 
system board.

3. Check if a device is causing the 
problem by removing ALL 
attached devices). Power on the 
system. If the system enters the 
POST, then power off and 
replace one device at a time 
and repeat this procedure until 
failure occurs. Replace the 
device causing the failure. 
Continue adding devices one at 
a time to ensure all devices are 
functioning properly.

4. Replace the power supply.
5. Replace the system board.
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Solving Diskette Problems

Solving Diskette Problems 

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows XP, right-click 
Start, click Explore, and select a 
drive. Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly 
inserted.

Remove diskette and reinsert.

Drive button is not 
pushed in.

Push in drive button.

Files on diskette are 
damaged.

Check the program diskettes.

Drive cable is not 
properly connected.

Reconnect power cable. Ensure that 
all four pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and 
power cables.

Removable drive is not 
seated properly.

Reseat the drive.

You attempted to hot 
plug a removable 
hard drive that has 
DriveLock security 
enabled. (This feature 
supported on select 
models only.)

Shut down the computer. Insert the 
drive into the MultiBay, if it is not 
already inserted. Turn on the 
computer.

Diskette drive cannot write 
to a diskette.

Diskette is not 
formatted.

Format the diskette.

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Writing to the wrong 
drive.

Check the drive letter in the path 
statement.

Not enough space is 
left on the diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check the 
storage security feature disabled 
settings.

Diskette is damaged. Replace the damaged disk.

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, 
you may need to specify diskette 
capacity. For example, to format a 
1.44-MB diskette, type the following 
command at the MS-DOS prompt:

FORMAT A: /F:1440
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Cannot format diskette. 
(continued)

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Diskette write control is 
enabled.

Use Computer Setup to check the 
storage security feature disabled 
settings.

A problem has occurred 
with a disk transaction.

The directory structure is 
bad, or there is a 
problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette drive cannot read 
a diskette.

Diskette is not 
formatted.

Format the diskette.

You are using the wrong 
diskette type for the 
drive type.

Check the type of drive that you 
are using and use the correct 
diskette type.

You are reading the 
wrong drive.

Check the drive letter in the path 
statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” 
message is displayed.

A diskette that does not 
contain the system files 
needed to start the 
computer has been 
inserted in the drive.

When drive activity stops, remove 
the diskette and press the 
Spacebar. The computer should 
start up.

Diskette error has 
occurred.

Restart the computer by pressing the 
power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer 
Setup.

Run Computer Setup and enable 
diskette boot in Storage > Boot 
Order.
Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options > 
Removable Media Boot.

✎ Both steps should be used as 
the Removable Media 
Boot function overrides the 
Boot Order enable 
command.

Removable media boot 
has been disabled in 
Computer Setup.

Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options> 
Removable Media Boot.

Network server mode is 
enabled in Computer 
Setup.

Run Computer Setup and disable 
Network Server Mode in 
Security > Password Options.

Solving Diskette Problems (Continued)

Problem Cause Solution
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Solving Hard Drive Problems

Solving Hard Drive Problems 

Problem Cause Solution

Hard drive error occurs. Hard disk has bad 
sectors or has failed.

Use a utility to locate and block 
usage of bad sectors. If necessary, 
reformat the hard disk.
In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Disk transaction problem. Either the directory 
structure is bad or there 
is a problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

1. Run Computer Setup.
2. If the system still does not 

recognize the new device, 
check to see if the device is 
listed within Computer Setup. If 
it is listed, the probable cause is 
a driver problem. If it is not 
listed, the probable cause is a 
hardware problem.

3. If this is a newly installed drive, 
enter Setup and try adding a 
POST delay under Advanced 
> Power-On.

Drive jumper settings 
may be incorrect.

If the drive is a secondary drive that 
has just been installed on the same 
cable as the primary drive, verify 
that the jumpers for both drives are 
set correctly.

Drive’s IDE (ATA) 
controller is disabled in 
Computer Setup.

Run Computer Setup and enable the 
Primary and Secondary IDE (ATA) 
controllers in Storage > Storage 
Options.

Drive responds slowly 
immediately after 
power-up.

Run Computer Setup and increase 
the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR 
missing message.

System is trying to start 
from a non bootable 
diskette or USB device.

Remove the media from the drive.
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Nonsystem disk/NTLDR 
missing message. 
(continued)

System is trying to start 
from a damaged hard 
drive.

1. Insert a bootable diskette into 
the diskette drive and restart the 
computer.

2. Check hard drive format using 
fdisk:  
If NTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 
Replace the MBR image.

3. If the hard drive is still 
inaccessible and MBR Security 
is enabled, try restoring the 
previously saved MBR image by 
entering Setup and selecting 
Security > Restore Master 
Boot Record.

System files missing or 
not properly installed.

1. Insert a bootable system diskette 
and restart.

2. Check hard drive format using 
fdisk:  
If NTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 
Replace the MBR image. 

3. Install system files for the 
appropriate operating system if 
necessary.

Hard drive boot 
disabled in Computer 
Setup.

Run Computer Setup and enable the 
hard drive entry in the Storage > 
Boot Order list.

Bootable hard drive is 
not attached as first in a 
multi-hard drive 
configuration.

If attempting to boot from an IDE 
hard drive, ensure it is attached as 
Primary Device 0. If attempting to 
boot from a SATA hard drive, ensure 
it is attached to SATA 0.

Bootable hard drive's 
controller is not listed 
first in the Boot Order.

Enter Computer Setup and select 
Storage > Boot Order and 
ensure the bootable hard drive's 
controller is listed immediately under 
the Hard Drive entry.

Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Solving MultiBay Problems

Parallel ATA (PATA) hard 
drive does not perform 
optimally.

Using the wrong cable 
for the drive type.

Reinstall the second Ultra ATA hard 
drive using an 80-conductor cable 
(standard on select models.)

Both slow and fast 
UATA devices are on 
the same data cable.

Connect slower UATA devices to a 
separate data cable connected to 
the secondary IDE (ATA) controller.

Computer will not start. Hard drive is damaged. Observe the beeps and LED lights 
on the front of the computer. See 
Appendix C “POST Error 
Messages”.

Computer seems to be 
locked up.

Program in use has 
stopped responding to 
commands.

1. Attempt the normal Windows 
“Shut Down” procedure. 

2. Press the power button for 
four or more seconds to turn off 
the power. 

3. Restart the computer using the 
power button.

Solving Hard Drive Problems (Continued)

Problem Cause Solution

Solving MultiBay Problems
Problem Cause Solution

Drive not found. You attempted to hot 
plug a removable 
hard drive that has 
DriveLock security 
enabled. (This feature 
supported on select 
models only.)

Shut down Windows and turn off 
the computer. Insert the drive into 
the MultiBay, if it is not already 
inserted. Turn on the computer.

MultiBay is hidden in 
Computer Setup.

Enter Computer Setup and set 
MultiBay to Device Available in 
Security > Device Security.
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Solving Display Problems

Problem Cause Solution

Blank screen (no video). The cable connections 
are not correct.

Check the cable connections from 
the monitor to the computer and to 
the electrical outlet.

Screen blanking utility 
installed or energy 
saver features enabled.

Press any key or click the mouse 
button and, if set, type your 
password.

System ROM is bad; 
system is running in 
FailSafe Boot Block 
mode (indicated by 
eight red blinks from the 
power LED and eight 
simultaneous beeps).

1. Reflash the ROM using a 
ROMPaq diskette.

2. Replace the system board.

Fixed-sync monitor will 
not sync at the 
resolution chosen.

Ensure that the monitor can accept 
the same horizontal scan rate as the 
resolution chosen.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
you will lose any unsaved data.

Monitor cable plugged 
into the wrong 
connector.

If the computer system has both 
an integrated graphics connector 
and a graphics expansion card 
connector, plug the monitor cable 
into the expansion card connector.

Monitor settings in the 
computer are not 
compatible with the 
monitor.

1. Restart the computer and press 
F8 during startup when you see 
“Press F8” in the bottom right 
corner of the screen.

2. Using the keyboard arrow keys, 
select Enable VGA Mode 
and press Enter.

3. In Windows Control Panel, 
double-click the Display icon 
and select the Settings tab.

4. Use the sliding control to reset 
the resolution.
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Blank screen and the 
power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Pre-video memory error. 1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Pre-video graphics 
error.

For systems with a graphics card:
1. Reseat the graphics card. 
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Blank screen and the 
power LED flashes Red 
eight times, once every 
second, followed by a two 
second pause, and the 
computer beeps eight 
times. Beeps continue for 
five iterations after which 
the LED flashes will 
continue until the problem 
is resolved.

Invalid ROM based on 
checksum.

1. Reflash the ROM using a 
ROMPaq diskette.

2. Replace the system board.

Monitor does not function 
properly when used with 
energy saver features.

Monitor without energy 
saver capabilities is 
being used with energy 
saver features enabled.

Disable monitor energy saver 
feature.

Dim characters. The brightness and 
contrast controls are not 
set properly.

Adjust the monitor brightness and 
contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is 
securely connected to the graphics 
card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics controller 
was upgraded, the 
correct video drivers 
may not be loaded.

Install the video drivers included in 
the upgrade kit.

Problem Cause Solution
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Monitor is not capable 
of displaying requested 
resolution.

Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, 
rolls, jitters, or flashes.

The monitor connections 
may be incomplete or 
the monitor may be 
incorrectly adjusted.

1. Be sure the monitor cable is 
securely connected to the 
computer.

2. In a two-monitor system or if 
another monitor is in close 
proximity, be sure the monitors 
are not interfering with each 
other’s electromagnetic field by 
moving them apart.

3. Fluorescent lights or fans may 
be too close to the monitor.

Monitor needs to be 
degaussed.

Degauss the monitor. 

Vibrating or rattling noise 
coming from inside a CRT 
monitor when powered on.

Monitor degaussing coil 
has been activated.

None. It is normal for the 
degaussing coil to be activated 
when the monitor is powered on.

Clicking noise coming from 
inside a CRT monitor.

Electronic relays have 
been activated inside 
the monitor.

None. It is normal for some monitors 
to make a clicking noise when 
turned on and off, when going in 
and out of standby mode, and when 
changing resolutions.

High pitched noise coming 
from inside a flat panel 
monitor.

Brightness and/or 
contrast settings are too 
high.

Lower brightness and/or contrast 
settings.

Fuzzy focus; streaking, 
ghosting, or shadowing 
effects; horizontal scrolling 
lines; faint vertical bars; or 
unable to center the picture 
on the screen. 
(flat panel monitors using 
an analog VGA input 
connection only)

Flat panel monitor’s 
internal digital 
conversion circuits may 
be unable to correctly 
interpret the output 
synchronization of the 
graphics card.

1. Select the monitor’s 
Auto-Adjustment option in the 
monitor’s on-screen display 
menu.

2. Manually synchronize the Clock 
and Clock Phase on-screen 
display functions. Download 
SoftPaq SP20930 or SP22333, 
depending on the monitor, to 
assist with the synchronization.

Graphics card is not 
seated properly or is 
bad.

1. Reseat the graphics card.
2. Replace the graphics card.

Problem Cause Solution
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Certain typed symbols do 
not appear correct.

The font you are using 
does not support that 
particular symbol.

Use the Character Map to locate the 
and select the appropriate symbol. 
Click Start > All Programs > 
Accessories > System Tools > 
Character Map. You can copy 
the symbol from the Character Map 
into a document.

Problem Cause Solution
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Solving Audio Problems

Solving Audio Problems 

Problem Cause Solution

Sound does not come 
out of the speaker or 
headphones.

Software volume control 
is turned down.

Double-click the Speaker icon on 
the taskbar and use the volume 
slider to adjust the volume.

The external speakers 
are not turned on.

Turn on the external speakers.

Audio is hidden in 
Computer Setup.

Enable the audio in Computer 
Setup: Security > Device 
Security >Audio.

External speakers 
plugged into the wrong 
audio jack.

See the sound card documentation 
for proper speaker connection.

Audio cable not 
connected.

Connect audio cable between CD 
or DVD-ROM drive and the system 
board.

Digital CD audio is not 
enabled.

Enable digital CD audio:
1. From the Control Panel, select 

System.
2. On the Hardware tab, click 

the Device Manager button.
3. Right-click on the CD/DVD 

device and select Properties.
4. On the Properties tab, make 

sure “Enable digital CD 
audio for this CD-ROM 
device” is checked.

Headphones or devices 
connected to the 
line-out connector mute 
the internal speaker.

Turn on and use headphones or 
external speakers, if connected, or 
disconnect headphones or external 
speakers.

Volume is muted. 1. From the Control Panel 
program, click Sound, 
Speech and Audio 
Devices, then click Sounds 
and Audio Devices.

2. Click the Mute check box to 
remove the check mark from 
the box.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.
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Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
any unsaved data will be lost.

Noise or no sound comes 
out of the speakers or 
headphones.

1. If using digital speakers that 
have a stereo jack and want the 
system to auto-switch to digital, 
use a stereo-to-mono adapter 
to properly engage the 
auto-sense feature or use the 
multimedia device properties 
to manually switch the audio 
signal from analog to digital.

2. If the headphones have a mono 
jack, use the multimedia device 
properties to switch the system 
to analog out.

✎ If you set digital as the Output Mode, the internal speaker and external analog 
speakers will no longer output audio until you switch back to an auto-sense or  
analog mode. 
 
If you set analog as the Output Mode, external digital speakers will not function 
until you change the output mode back to an auto-sense or digital mode. 

Sound cuts in and out. Processor resources are 
being used by other 
open applications.

Shut down all open 
processor-intensive applications.

Computer appears to be 
locked up while recording 
audio.

The hard disk may be 
full.

1. Before recording, make sure 
there is enough free space on 
the hard disk. 

2. Try recording the audio file in a 
compressed format.

Solving Audio Problems (Continued)

Problem Cause Solution
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Solving Printer Problems

Solving Printer Problems 

Problem Cause Solution

Printer will not print. Printer is not turned on 
and online.

Turn the printer on and make sure it 
is online.

The correct printer 
driver for the 
application are not 
installed.

1. Install the correct printer driver 
for the application.

2. Try printing using the 
MS-DOS command:
DIR C:\ > [printer port]
where [printer port] is the 
address of the printer being 
used. If the printer works, reload 
the printer driver.

If you are on a network, 
you may not have made 
the connection to the 
printer.

Make the proper network 
connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on. The cables may not be 
connected properly.

Reconnect all cables.

Printer prints garbled 
information.

The correct printer 
driver is not installed.

Install the correct printer driver for 
the application.

The cables may not be 
connected properly.

Reconnect all cables.

Printer memory may be 
overloaded.

Reset the printer by turning it off for 
one minute, then turn it back on.

Printer is offline. The printer may be out 
of paper.

1. Check the paper tray and refill it 
if it is empty. 

2. Select online.
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Solving Keyboard and Mouse Problems

Solving Keyboard and Mouse Problems

Problem Cause Solution

Keyboard commands and 
typing are not recognized 
by the computer.

Keyboard connector 
is not properly 
connected.

1. Turn off the computer. 
2. Reconnect the keyboard to the 

back of the computer and 
restart the computer.

Program in use has 
stopped responding 
to commands.

Shut down the computer using 
the mouse and then restart the 
computer.

Keyboard needs 
repairs.

Replace the keyboard.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Input is coming from a 
nearby wireless 
keyboard.

1. Ensure that the keyboard 
batteries are fresh.

2. Place the receiver over 30 cm 
(12 in) from a telephone, power 
supply, transformer, computer, 
other electrical device, or power 
cords or cables.

3. The receiver should not be 
placed on or inside of a metal 
surface.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
any unsaved data will be lost.

Cursor will not move using 
the arrow keys on the 
keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys. The 
Num Lock key can be disabled  
(or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged 
into the back of the 
computer.

1. Shut down the computer using 
the keyboard.

2. Plug the mouse connector into 
the back of the computer (or the 
keyboard) and restart the 
computer.

Program in use has 
stopped responding 
to commands.

Shut down the computer using the 
keyboard and then restart the 
computer.

Mouse may need 
cleaning.

Remove the roller ball cover on the 
mouse and clean it.

Mouse needs repairs. Replace the mouse.
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Mouse does not respond to 
movement or is too slow. 
(continued)

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Input is coming from a 
nearby wireless mouse.

1. Ensure that the mouse batteries 
are fresh.

2. Place the receiver over 30 cm 
(12 in) from a telephone, power 
supply, transformer, computer, 
other electrical device, or power 
cords or cables.

3. The receiver should not be 
placed on or inside of a metal 
surface.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
you will lose any unsaved data.

Mouse will only move 
vertically or horizontally, or 
movement is jerky.

Mouse roller ball is 
dirty.

Remove roller ball cover from the 
bottom of the mouse and clean it.

Solving Keyboard and Mouse Problems

Problem Cause Solution
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an 
additional diskette drive. If you install a plug and play device, Windows 2000 and Windows XP 
automatically recognize the device and configure the computer. If you install a non–plug and 
play device, you must reconfigure the computer after completing installation of the new 
hardware. In Windows 2000, select the Add New Hardware icon in the Control Panel (for 
Windows XP, use the Add Hardware Wizard) and follow the instructions that appear on the 
screen.

Solving Hardware Installation Problems 

Problem Cause Solution

A new device is not 
recognized as part of 
the system.

Device is not seated or 
connected properly. 

Ensure that the device is properly 
and securely connected and that 
pins in the connector are not 
bent down.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly 
and securely connected and that 
pins in the cable or connector are 
not bent down.

Power switch of new 
external device is not 
turned on.

Turn off the computer, turn on the 
external device, then turn on the 
computer to integrate the device 
with the computer system.

When the system 
advised you of changes 
to the configuration, you 
did not accept them.

Reboot the computer and follow the 
instructions for accepting the 
changes.

A plug and play board 
may not automatically 
configure when 
added if the default 
configuration conflicts 
with other devices.

Use Windows 2000 or Windows XP 
Device Manager to deselect the 
automatic settings for the board and 
choose a basic configuration that 
does not cause a resource conflict. 
You can also use Computer Setup to 
reconfigure or disable devices to 
resolve the resource conflict.

Computer will not start. Wrong memory 
modules were used in 
the upgrade or memory 
modules were installed 
in the wrong location.

1. Review the documentation that 
came with the system to 
determine if you are using the 
correct memory modules and to 
verify the proper installation.

2. Observe the beeps and LED 
lights on the front of the 
computer. See Appendix C 
“POST Error Messages” to 
determine possible causes.
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Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory 

with HP memory.
4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Video card is not seated 
properly or is bad, or 
system board is bad.

For systems with a graphics card:
1. Reseat the graphics card. Power 

on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Power LED flashes Red ten 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps ten times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved

Bad option card. 1. Check each option card by 
removing the cards one at time 
(if multiple cards), then power 
on the system to see if fault goes 
away.

2. Once bad card is identified, 
remove and replace bad option 
card.

3. Replace the system board.

Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Solving Network Problems 

Problem Cause Solution

Wake-on-LAN feature is 
not functioning.

Wake-on-LAN is not 
enabled.

Use the Network control application 
to enable Wake-on-LAN. 

Network driver does 
not detect network 
controller.

Network controller is 
disabled.

Run Computer Setup and enable 
network controller.
Enable the network controller in the 
operating system via the Device 
Manager.

Incorrect network driver. Check the network controller 
documentation for the correct driver 
or obtain the latest driver from the 
manufacturer’s Web site.

Network status link light 
does not turn on or it 
never flashes.

✎ The network status 
light should flash 
when there is 
network activity.

No active network is 
detected.

Check cabling and network 
equipment for proper connection.

Network controller is not 
set up properly.

Use the Network control application 
to verify that the device is working 
properly. 

Network driver is not 
properly loaded.

Reinstall network drivers. 

System cannot autosense 
the network.

Disable auto-sensing capabilities 
and force the system into the correct 
operating mode. 

Diagnostics reports a 
failure.

The cable is not securely 
connected.

Ensure that both ends of the data 
cable are securely connected. 

The cable is attached to 
the incorrect connector.

Ensure that the cable is attached to 
the correct connector.

There is a problem with 
the cable or a device at 
the other end of the cable.

Ensure that the cable and device at 
the other end are operating 
correctly.

Network controller 
interrupt is shared with 
an expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
is defective.

Replace the NIC.
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Diagnostics passes, but 
the computer does not 
communicate with the 
network.

Network drivers are 
not loaded, or driver 
parameters do not match 
current configuration.

1. Make sure the network drivers 
are loaded and that the driver 
parameters match the 
configuration of the network 
controller.

2. Make sure the correct network 
client and protocol is installed.

Diagnostics passes, but 
the computer does not 
communicate with the 
network. (continued)

The network controller 
is not configured for this 
computer.

Select the Network icon in the 
Control Panel and configure the 
network controller.

Network controller 
stopped working when 
an expansion board was 
added to the computer.

Network controller 
interrupt is shared with an 
expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
requires drivers.

Verify that the drivers were not 
accidentally deleted when the 
drivers for a new expansion board 
were installed.

The expansion board 
installed is a network card 
(NIC) and conflicts with 
the embedded NIC.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

Network controller stops 
working without apparent 
cause.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, using 
the Restore Plus! CD.

The cable is not securely 
connected.

Ensure that both ends of the cable 
are securely attached to the correct 
devices.

The network controller is 
defective.

Replace the NIC.

New network card will 
not boot.

New network card may be 
defective or may not meet 
industry-standard 
specifications.

Install a working, industry-standard 
NIC, or change the boot sequence 
to boot from another source.

Cannot connect to 
network server when 
attempting Remote 
System Installation.

The network controller is 
not configured properly.

Verify Network Connectivity, that a 
DHCP Server is present, and that 
the Remote System Installation 
Server contains the NIC drivers for 
your NIC.

System setup utility 
reports unprogrammed 
EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Solving Network Problems (Continued)

Problem Cause Solution
Service Reference Guide, dc7100 361288-003 D–23



Solving Memory Problems

Ä
CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-ECC 
memory. Otherwise, the system will not boot the operating system.

Solving Memory Problems 

Problem Cause Solution

System will not boot or 
does not function properly 
after installing additional 
memory modules.

Memory module is not 
the correct type or 
speed or the new 
memory module is not 
seated properly.

Replace module with the correct 
industry-standard device for the 
computer.

On some models, ECC and non-ECC 
memory modules cannot be mixed.

Out of memory error. Memory configuration 
may not be set up 
correctly.

Use the Device Manager to check 
memory configuration.

You have run out of 
memory to run the 
application.

Check the application 
documentation to determine the 
memory requirements.

Memory count during POST 
is wrong.

The memory modules 
may not be installed 
correctly.

Check that the memory modules 
have been installed correctly and 
that proper modules are used.

Integrated graphics may 
use system memory.

No action required.

Insufficient memory error 
during operation.

Too many Terminate 
and Stay Resident 
programs (TSRs) are 
installed.

Delete any TSRs that you do 
not need.

You have run out of 
memory for the 
application.

Check the memory requirements for 
the application or add more 
memory to the computer.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory 

with HP memory.
4. Replace the system board.
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Solving Processor Problems
.

Solving Processor Problems

Problem Cause Solution

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked.

2. Make sure the fans are 
connected and working 
properly (some fans only 
operate when needed).

3. Make sure the processor 
heatsink is installed properly.

Power LED flashes Red 
three times, once every 
second, followed by a two 
second pause, and the 
computer beeps three 
times. Beeps continue for 
five iterations after which 
the LED flashes will 
continue until the problem 
is resolved.

Processor is not seated 
properly or not 
installed.

1. Check to see that the processor 
is present.

2. Reseat the processor.
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Solving CD-ROM and DVD Problems

Solving CD-ROM and DVD Problems 

Problem Cause Solution

System will not boot from 
CD-ROM or DVD drive.

Removable Media Boot 
is not enabled through 
the Computer Setup 
utility.

Run the Computer Setup utility and 
enable booting to removable media 
and verify boot order settings.

Non-bootable CD in 
drive.

Try a bootable CD in the drive.

Network Server Mode 
is enabled in Computer 
Setup.

Run Computer Setup and disable 
Network Server Mode in Security 
> Password Options. 

Boot order not correct. Run Computer Setup and change 
boot sequence in Storage > Boot 
Order.

CD-ROM or DVD devices 
are not detected or driver is 
not loaded.

Drive is not connected 
properly or not properly 
configured.

1. Reconnect power and data 
cables to the drive.

2. Install correct device driver.

Movie will not play in the 
DVD drive.

Movie may be 
regionalized for a 
different country.

See the documentation that came 
with the DVD drive.

Decoder software is not 
installed.

Install decoder software.

Damaged media. Replace media.

Movie rating locked out 
by parental lock.

Use DVD software to remove 
parental lock.

Media installed upside 
down.

Reinstall media.

Cannot eject compact disc 
(tray-load unit).

Disc not properly seated 
in the drive.

1. Turn off the computer and insert 
a thin metal rod into the 
emergency eject hole and push 
firmly. 

2. Slowly pull the tray out from the 
drive until the tray is fully 
extended, then remove the disc.

CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc or 
takes too long to start.

Media has been 
inserted upside down.

Re-insert the Media with the label 
facing up.

The DVD-ROM drive 
takes longer to start 
because it has to 
determine the type of 
media played, such as 
audio or video.

Wait at least 30 seconds to let the 
DVD-ROM drive determine the type 
of media being played. If the disc 
still does not start, read the other 
solutions listed for this topic.
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Solving Drive Key Problems

Solving Front Panel Component Problems

CD or DVD disc is dirty. Clean CD or DVD with a CD 
cleaning kit.

Windows does not 
detect the CD-ROM or 
DVD-ROM drive.

1. Use Device Manager to remove 
or uninstall the device in 
question.

2. Restart the computer and let 
Windows detect the device.

Recording audio CDs is 
difficult or impossible.

Wrong or poor quality 
media type.

1. Try using a slower recording 
speed.

2. Verify that you are using the 
correct media for the drive.

3. Try a different brand of media. 
Quality varies widely between 
manufacturers.

Solving CD-ROM and DVD Problems (Continued)

Problem Cause Solution

Solving Drive Key Problems

Problem Cause Solution

Drive key is not seen as a 
drive letter in Windows XP.

The drive letter after the 
last physical drive is not 
available.

Change the default drive letter for 
the Drive key in Windows XP.

The computer boots to DOS 
after making a bootable 
Drive key.

Drive key is bootable. Install the Drive key after the 
operating system boots.

Solving Front Panel Component Problems
Problem Cause Solution

A USB device, headphone, 
or microphone is not 
recognized by the 
workstation.

It is not properly 
connected.

1. Turn off the computer.
2. Reconnect the device to the front of 

the workstation and restart the 
computer.

The device does not 
have power.

If the USB device requires AC power, 
be sure one end is connected to the 
device and one end is connected to a 
live outlet.
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Solving Internet Access Problems

A USB device, headphone, 
or microphone is not 
recognized by the 
workstation. (continued)

The correct device 
driver is not installed.

1. Install the correct driver for the 
device.

2. You might need to reboot the 
computer.

The cable from the 
device to the computer 
does not work.

1. If possible, replace the cable.
2. Restart the workstation.

The device is not 
working.

1. Replace the device.
2. Restart the computer.

Solving Front Panel Component Problems
Problem Cause Solution

Solving Internet Access Problems 

Problem Cause Solution

Unable to connect to the 
Internet.

Internet Service Provider 
(ISP) account is not set 
up properly.

Verify Internet settings or contact the 
ISP for assistance.

Modem is not set up 
properly.

Reconnect the modem. Verify the 
connections are correct using the 
quick setup documentation.

Unable to connect to the 
Internet. (continued)

Web browser is not set 
up properly.

Verify that the Web browser is 
installed and set up to work with 
your ISP.

Cable/ DSL modem is 
not plugged in.

Plug in cable/DSL modem. You 
should see a “power” LED light on 
the front of the cable/DSL modem.

Cable/DSL service is 
not available or has 
been interrupted due to 
bad weather.

Try connecting to the Internet at a 
later time or contact your ISP. (If the 
cable/DSL service is connected, the 
“cable” LED light on the front of the 
cable/DSL modem will be on.)

The CAT5 10/100 
cable is disconnected.

Connect the CAT5 10/100 cable 
between the cable modem and the 
computers’s RJ-45 connector. (If the 
connection is good, the “PC” LED 
light on the front of the cable/DSL 
modem will be on.)

IP address is not 
configured properly.

Contact the ISP for the correct IP 
address.
D–28 361288-003 Service Reference Guide, dc7100



Cookies are corrupted. Windows XP
1. Select Start > Control 

Panel.
2. Double-click Internet 

Options.
3. On the General tab, click the 

Delete Cookies button.

Cannot automatically 
launch Internet programs.

You must log on to the 
ISP before some 
programs will start.

Log on to the ISP and launch the 
desired program.

Internet takes too long to 
download Web sites.

Modem is not set up 
properly.s

Verify that the correct modem speed 
and COM port are selected.
For Windows XP
1. Select Start > Control 

Panel.
Continue with step #2
2. Double-click System.
3. Click the Hardware tab.
4. In the Device Manager area, 

click the Device Manager 
button.

5. Double-click Ports (COM & 
LPT).

6. Right-click the COM port your 
modem uses, then click 
Properties.

7. Under Device status, verify 
that the modem is working 
properly.

8. Under Device usage, verify 
the modem is enabled.

9. If there are further problems, 
click the Troubleshoot button 
and follow the on-screen 
instructions.

Solving Internet Access Problems (Continued)

Problem Cause Solution
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POST Diagnostic Front Panel LEDs and Audible Codes
This section covers the front panel LED codes as well as the audible codes that may occur before 
or during POST that do not necessarily have an error code or text message associated with them.

✎ If you see flashing LEDs on a PS/2 keyboard look for flashing LEDs on the front panel of the 
computer and refer to the following table to determine the front panel LED codes.

✎ Recommended actions in the following table are listed in the order in which they should be 
performed.

Diagnostic Front Panel LEDs and Audible Codes 

Activity Beeps Possible Cause Recommended Action

Green Power LED 
On.

None Computer on. None

Green Power LED 
flashes every two 
seconds.

None Computer in 
Suspend to RAM 
mode (select 
models only) or 
normal Suspend 
mode.

None required. Press any key or move the 
mouse to wake the computer.

Red Power LED 
flashes two times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

2 Processor thermal 
protection 
activated:
A fan may be 
blocked or not 
turning.
OR 
The heatsink/fan 
assembly is not 
properly attached 
to the processor. 

1. Ensure that the computer air vents are 
not blocked and the processor 
cooling fan is running.

2. Open hood, press power button, and 
see if the processor fan spins. If the 
processor fan is not spinning, make 
sure the fan's cable is plugged onto 
the system board header. Ensure the 
fan is fully/properly seated or 
installed.

3. If fan is plugged in and seated 
properly, but is not spinning, then 
replace processor fan.

4. Reseat processor heatsink and verify 
that the fan assembly is properly 
attached.

5. Contact an authorized reseller or 
service provider.
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Red Power LED 
flashes three times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

3 Processor not 
installed (not an 
indicator of bad 
processor).

1. Check to see that the processor is 
present.

2. Reseat the processor.

Red Power LED 
flashes four times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

4 Power failure 
(power supply is 
overloaded).

1. Open the hood and ensure the 4-wire 
power supply cable is seated into the 
connector on the system board.

2. Check if a device is causing the 
problem by removing ALL attached 
devices (such as hard, diskette, or 
optical drives, and expansion cards). 
Power on the system. If the system 
enters the POST, then power off and 
replace one device at a time and 
repeat this procedure until failure 
occurs. Replace the device that is 
causing the failure. Continue adding 
devices one at a time to ensure all 
devices are functioning properly.

3. Replace the power supply.
4. Replace the system board.

Red Power LED 
flashes five times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

5 Pre-video memory 
error.

1. Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory with HP 

memory.
4. Replace the system board.

Red Power LED 
flashes six times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

6 Pre-video graphics 
error. 

For systems with a graphics card:
1. Reseat the graphics card. Power on 

the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, 
replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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Red Power LED 
flashes seven times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

7 System board 
failure (ROM 
detected failure 
prior to video).

Replace the system board.

Red Power LED 
flashes eight times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

8 Invalid ROM 
based on bad 
checksum.

1. Reflash the ROM using a ROMPaq 
diskette. See the “ROM Flash” section 
of the Desktop Management Guide 
on the Documentation CD.

2. Replace the system board.

Red Power LED 
flashes nine times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

9 System powers on 
but is unable to 
boot.

1.  Check that the voltage selector, 
located on the rear of the power 
supply (some models), is set to the 
appropriate voltage. Proper voltage 
setting depends on your region.

2. Replace the system board.
3. Replace the processor. 

Red Power LED 
flashes ten times, 
once every second, 
followed by a two 
second pause. 
Beeps stop after 
fifth iteration but 
LEDs continue until 
problem is 
resolved.

10 Bad option card. 1. Check each option card (PCI or PCI 
Express) by removing the card (one at 
a time if multiple cards), then power 
on the system to see if fault goes 
away.

2. Once a bad card is identified, remove 
and replace the bad option card.

3. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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System does not 
power on and LEDs 
are not flashing.

None System unable to 
power on.

Press and hold the power button for less 
than 4 seconds. If the hard drive LED turns 
green, then:
1. Check that the voltage selector, 

located on the rear of the power 
supply, is set to the appropriate 
voltage. Proper voltage setting 
depends on your region.

2. Remove the expansion cards one at a 
time until the LED light on the system 
board turns on.

3. Replace the system board.
OR
Press and hold the power button for less 
than 4 seconds. If the hard drive LED does 
not turn on green then:
1. Check that the unit is plugged into a 

working AC outlet.
2. Open hood and check that the power 

button harness is properly connected 
to the system board.

3. Check that both power supply cables 
are properly connected to the system 
board.

4. Check to see if the LED light on the 
system board is turned on. If it is 
turned on, then replace the power 
button harness.

5. If the LED light on the system board is 
not turned on, then replace the power 
supply.

6. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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E
System Board and Riser Card Reference 

Designators

These reference designators are used on most, but not all, HP system and riser boards.

Designator Component 

BAT 
CR1 
CR2 
CR3 
CR4

Battery socket/Battery 
LED - 5V_Aux(on)/PS_ON(off) 
Health-LED 
UID LED 
Power LED

CR35 
E14 
E15 
E25 
E49/JP49

Hard drive activity LED 
Boot block header/jumper 
Boot block recovery header 
CPLD programming header 
Clear Password header/jumper

E50 
J7 
J9 
J10 
J11

Clear CMOS header 
RJ45 jack 
Stacked RJ45/Dual USB 
Quad stacked USB 
First IEEE 1394 connector

J12 
J20 - 29 
J30 
J31 - J35 
J37

Second IEEE 1394 connector 
PCI slots 
PCI extender slot (male) 
PCI Express slots 
Primary SCSI connector

J38 
J39 
J40 
J41 
J50

Secondary SCSI connector 
Stacked parallel/SCSI connector 
AGP slot 
x16 PCI Express slot for graphics 
First parallel port

J51 
J52 
J53 
J54 
J55

Second parallel port 
Double-stacked parallel port, Top = Port B, Bottom = Port A 
Parallel port over single Serial Port 
Parallel port over Serial Port and Video Port 
Parallel port over dual VGA ports

J65 
J66 
J67 
J68 

DVI connector 
Keyboard connector, PS/2(Closest to power supply) 
Mouse connector, PS/2 
Double-stacked mouse/keyboard connector, PS/2 
Top = Mouse, Bottom = Keyboard 
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J69 
J70 
J71 
J72 
J73

Video connector, VGA 
Primary single USB connector 
Secondary single USB port 
Microphone jack 
Line-in jack

J74 
J75 
J76 
J77 
J78

Line-out jack 
Headphone jack 
Volume control 
Double-stacked headphone, Top = microphone, Bottom = headphone  
Double-stacked line-in, Top = line-in, Bottom = line-out

J80 
J81 
J82 
J83 
J101

Stacked serial/audio connector 
Primary double-stack USB, Top = Port 2, Bottom = Port 1 
Secondary double-stack USB, Top = Port 4, Bottom = Port 3 
Triple-stacked audio jack (line in, line out/headphone, microphone) 
Security board connector for daughter card

J9020-J9029 
J9030-J9034 
JP49/E49 
L1 
L2

PCI slots on riser card 
PCI express slots on riser card 
Clear password header/jumper 
USB front port choke (1st) 
USB rear port choke (1st)

L3 
L4 
L5 
P1 
P2

USB rear port choke (2nd) 
USB rear port choke (3rd) 
USB front port choke (2nd) 
P/S connector (20 or 24 pin) 
Second P/S connector (as required)

P3 
P4 
P5 
P6 
P7

Processor 12V header  
Secondary Processor 12V header 
Main Power/HDD LED connector  
Speaker connector 
Analog audio connector (from CD-ROM)

P8 
P9 
P10 
P11 
P12

Primary chassis fan connector 
Secondary chassis fan connector 
Diskette drive connector 
Auxiliary Audio connector 
Alert on LAN NIC connector

P13 
P15 
P16 
P20 
P21

VRM module footprint 
AUI connector 
Fan command/fan sink header (may be 2 or 4 pin) 
Primary IDE connector 
Secondary IDE/MultiBay connector

P22 
P23 
P24 
P25  
P26

Header for NEWCARD 
Header for front panel audio  
Header for front panel USB 
Internal USB connector 1 
Internal USB connector 2

Designator Component (Continued)
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P27 
P29 
P30 
P40 
P41

MultiBay header 
SCSI LED connector 
PCI extender slot (female) 
Blade PC graphics connector (outboard) 
Blade PC graphics connector (inboard)

P52 
P53 
P54 
P55 
P58

Serial port header 
First serial port 
Flying serial port 
Double stack serial port, Top = Serial B, Bottom = Serial A 
Riser edge connector (male-mates with J30)

P60 
P61 
P62 
P63 
P64

Primary Serial ATA (SATA) connector 
Second Serial ATA (SATA) connector 
Third Serial ATA (SATA) connector 
Fourth Serial ATA (SATA) connector 
VSFF expansion connector

P65 
P70 
P71 
P101 
P106

Graphics option connector 
Primary (CPU) fan header for fansink 
Secondary CPU fan header for fansink 
Security board connector, system board 
Secondary speaker header

P124 
P125 
P126 
P216 
SW2

Hood lock header 
Hood sensor header 
Flying parallel port header 
White box chassis fan header 
Security hood switch on riser card

SW50 
U2 
U3 
U4 
U5

Clear CMOS switch/push button 
Single chip solution (combined north bridge/south bridge) 
North bridge 
South bridge 
Super I/O

U6 
U7 
U10 
U11 
U12

Clock chip 
64 bit Bridge 
LOM1 
LOM1 EEPROM 
LOM1 PHY

U13 
U14 
U16 
U17 
U18

Audio Codec 
Audio amplifier 
LOM2 
LOM2 EEPROM 
LOM2 PHY

U20 
U29 
U30 
U31 
U32

Fan controller 
TMDS controller 
Parallel port diode array 
First serial port transceiver  
Second serial port transceiver

Designator Component (Continued)
Service Reference Guide, dc7100 361288-003 E–3



U46 
U50 
U51 
U52 
U53

VRM controller 
USB front port power switch 
First USB rear port power switch 
Second USB rear port power switch 
Third USB rear port power switch

XBT 
XMM1 
XMM2 - XMM5 
XU1 
XU2

Battery retainer 
Memory slot. DIMM1 or RIMM1 populated and tested 
Following memory slots 
Primary processor socket  
Secondary processor socket

XU15/U15 
Y1 
Y2 
Y3 
Y4 
Y5/H5

ROM socket (XU15) 
Primary (TH) system clock crystal 
Secondary (SMT) system clock crystal 
Primary NIC clock crystal 
Secondary NIC clock crystal 
RTC clock crystal/tie-down

Designator Component (Continued)
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F
Memory

Intel-Based Systems
Computers equipped with Intel-based processors come with double data rate synchronous 
dynamic random access memory (DDR-SDRAM) dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to three or four 
industry-standard DIMMs depending on the model. These memory module slots are populated 
with at least one preinstalled memory module. To achieve the maximum memory support, you 
can populate the system board with up to 4GB of memory configured in a high-performing dual 
channel mode.

For proper system operation, if the computer supports DDR-SDRAM DIMMs, the DIMMs must 
be industry-standard 184-pin, unbuffered PC2700 333 MHz- or PC3200 400 MHz-compliant, 
2.5 volt DDR-SDRAM DIMMs. The DDR-SDRAM DIMMs must also:

■ support CAS latency 2.5 or 3 (CL = 2.5 OR CL=3)

■ contain the mandatory JEDEC SPD information

In addition, the computer supports:

■ 256Mbit, 512Mbit, AND 1 gBIT non-ECC memory technologies

■ single-sided and double-sided DIMMS 

■ DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM 
are not supported 

The following processor bus frequencies are required for the system to run at the supported 
memory frequencies.

If a memory frequency is paired with an unsupported processor bus frequency, the system will 
run at the highest supported memory speed. For example, if a 400 MHz DIMM is paired with a 
533 MHz processor bus, the system will run at 400 MHz, the highest supported memory speed.

✎ The system will not start if you install unsupported DIMMs.

Memory Frequency Required Processor Bus Frequency

333 MHz 533 MHz or 800 MHz

400 MHz 800 MHz
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DIMM Sockets
There are four DIMM sockets on the system board, with two sockets per channel. The sockets are 
labeled XMM1, XMM2, XMM3, and XMM4. Sockets XMM1 and XMM2 operate in memory 
channel A. Sockets XMM3 and XMM4 operate in memory channel B.

The system board shown may differ from the one in your product.

 

The system will automatically operate in single channel mode, dual channel Asymmetric mode, 
or a a higher-performing dual channel Interleaved mode, depending on how the DIMMs are 
installed. 

To identify the operating mode, run Computer Setup and select the System Information menu 
item. The operating memory mode will appear in the line showing the system total memory.

■ The system will operate in single channel mode if the DIMM sockets are populated in one 
channel only.

■ The system will operate in dual channel Asymmetric mode if the total memory capacity of 
the DIMMs in Channel A is not equal to the total memory capacity of the DIMMs in 
Channel B.

■ The system will operate in a higher-performing dual channel Interleaved mode if the total 
memory capacity of the DIMMs in Channel A is equal to the total memory capacity of the 
DIMMs in Channel B. However, the technology and device width can vary between the 
channels, For example, if Channel A is populated with two 256 MB DIMMS and Channel B 
is populated with one 512 MB DIMM, the system will operate in Interleaved mode.

Item Description Socket Color

1 DIMM socket XMM1, Channel A Black

2 DIMM socket XMM2, Channel A Blue

3 DIMM socket XMM3, Channel B Black

4 DIMM socket XMM4, Channel B Blue
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■ In any mode, the maximum operational speed is determined by the slowest DIMM in the 
system. For example, if the system is populated with a DIMM that is 333 MHz and a second 
DIMM that is 400 MHz, the system will run at the slower of the two speeds.
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Index
Index

4-pin power pin assignments A–7
24-pin MicroFit power pin assignments A–7
24-pin power pin assignments A–7
6-pin power pin assignments A–8

A
access panel

CMT removal and replacement 6–6
USDT removal and replacement 8–5

advanced, Computer Setup heading 2–11
ATA/ATAPI (IDE) drive cable pin assignments 

A–6

B
backwall

SFF removal and replacement 7–51
battery

CMT removal and replacement 6–31
disposal 5–9
real-time clock D–2
SFF removal and replacement 7–58
USDT removal and replacement 8–27

bezel blank
CMT removal and replacement 6–9

bezel insert
SFF removal and replacement 7–12

blank screen D–11

C
cable

CMT hard drive 6–21
proper handling 5–9

cable layout, PATA 4–4
cable lock

CMT 6–4
SFF removal and replacement 7–5
USDT 8–3

cable management
CMT 6–10
SFF 7–14

cable pinouts
PATA data 4–3
PATA power 4–3

SATA data 4–2
SATA power 4–2

categories, Diagnostics for Windows 2–16
cautions

AC power 5–1
adding devices 1–1
batteries 5–9
cables 5–9
cooling fan 5–8
keyboard cleaning 5–7
keyboard keys 5–7
operating system installation 1–1
protecting ROM 3–4

chassis
CMT illustrated 5–1
SFF illustrated 5–2

chassis fan
CMT removal and replacement 6–38
SFF removal and replacement 7–50

chassis types, illustrated 5–1
cleaning

computer 5–6
keyboard 5–7
monitor 5–7
mouse 5–7

clearing password 3–20
CMT

5.25" drive bezel removal and replacement 6–8
access panel removal and replacement 6–6
battery removal and replacement 6–31
bezel blank removal and replacement 6–9
cable lock removal and replacement 6–4
cable management 6–10
chassis fan removal and replacement 6–38
chassis, illustrated 5–1
desktop to minitower conversion 6–40
disassembly preparation 6–1
diskette drive bezel removal and replacement 

6–9
diskette drive removal and replacement 6–27
drive positions 6–20
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Index
expansion card guide removal and replacement 
6–19

expansion card removal and replacement 6–14
expansion card retainer latch removal and 

replacement 6–17
expansion slot cover removal and replacement 

6–13, 6–17
external security 6–4
FailSafe key 6–2
front bezel removal and replacement 6–7
front I/O device removal and replacement 6–28
hard drive cable removal and replacement 6–21
hard drive removal and replacement 6–21
heatsink removal and replacement 6–34
hood sensor removal and replacement 6–3
memory removal and replacement 6–11
minitower to desktop conversion 6–43
optical drive removal and replacement 6–24
padlock removal and replacement 6–5
PCI Express card removal and replacement 

6–15
PCI retainer latch removal and replacement 

6–17
power supply removal and replacement 6–39
power switch assembly removal and 

replacement 6–29
preparation for disassembly 6–1
Smart Cover Lock 6–2
Smart Cover Lock removal and replacement 6–2
speaker removal and replacement 6–37
system board removal and replacement 6–30
tamper-proof screws 6–2

computer cleaning 5–6
computer cover

SFF removal and replacement 7–11
computer pauses D–2
Computer Setup

heading
advanced 2–11
file 2–4
security 2–8
storage 2–5

utilities 2–3
Configuration Record Utility 2–18
connector pin assignments A–1 to A–7
conversion

CMT desktop to minitower 6–40
CMT minitower to desktop 6–43

convertible minitower. See CMT
country-specific power cord set requirements B–2

D
date and time display D–2
device drivers

installing/upgrading 1–1
Diagnostics for Windows

categories 2–16
detecting 2–15
installing 2–15
Menu Bar 2–16
overview 2–14
running tests 2–17

disassembly preparation
CMT 6–1
SFF 7–1
USDT 8–1

diskette drive
CMT removal and replacement 6–27

diskette drive bezel
CMT removal and replacement 6–9

drive
capacities 4–10
CMT diskette drive removal and replacement 

6–27
CMT hard drive removal and replacement 6–21
CMT optical drive removal and replacement 

6–24
partition size 4–10
replacement type 4–9
SFF external removal and replacement 7–29
SFF hard drive removal and replacement 7–30
SFF optical drive removal and replacement 

7–27
USDT hard drive removal and replacement 

8–19
drive bezel inserts

CMT 6–8
SFF 7–13

drive positions
CMT 6–20
SFF 7–26

E
electrostatic discharge. See ESD
error messages, POST C–1 to C–6
ESD (electrostatic discharge)

information 5–3
materials and equipment 5–4
preventing damage 5–3

Ethernet
AUI pin assignments A–2
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Index
BNC pin assignments A–1
RJ-45 pin assignments A–2

expansion card
CMT PCI Express socket removal and 

replacement 6–15
CMT standard socket removal and replacement 

6–14
SFF removal and replacement 7–19
USDT removal and replacement 8–15

expansion card guide
CMT removal and replacement 6–19

expansion card retainer
SFF removal and replacement 7–18

expansion card retaining latch
USDT removal and replacement 8–18

expansion slot cover
CMT removal and replacement 6–13, 6–17

external 3.5-inch drive
SFF removal and replacement 7–29

F
FailSafe key

CMT 6–2
SFF 7–2

fan shroud
SFF removal and replacement 7–34

fan, power supply 5–8
FAT or FAT32 to NTFS conversion 1–2
file, Computer Setup heading 2–4
flashing LEDs C–7
front bezel

CMT removal and replacement 6–7
USDT removal and replacement 8–8

front drive bezel
SFF removal and replacement 7–12

front I/O device
CMT removal and replacement 6–28
SFF removal and replacement 7–35
USDT removal and replacement 8–21

G
grounding methods 5–4

H
hard drive

CMT removal and replacement 6–21
proper handling 5–9
SFF removal and relacement 7–30
USDT removal and replacement 8–19

headphone pin assignments A–4
heatsink

CMT removal and replacement 6–34
SFF removal and replacement 7–40
USDT fan and shroud removal and replacement 

8–23
USDT removal and replacement 8–22

hood sensor
CMT removal and replacement 6–3
SFF removal and replacement 7–4

HP software. See software

I
infrared (IR) transceiver, external, pin assignments 

A–5
installing Diagnostics for Windows 2–15
IR transceiver. See infrared (IR) transceiver

J
jumper settings D–8

K
keyboard

cleaning 5–7
pin assignments A–1

L
LEDs

blinking power C–7
blinking PS/2 keyboard C–7

line-in audio pin assignments A–4
line-out audio pin assignments A–4

M
memory

CMT removal and replacement 6–11
SFF removal and replacement 7–16
USDT removal and replacement 8–12

menu bar, Diagnostics for Windows 2–16
microphone pin assignments A–3
monitor

blank screen D–11
blurry video D–12
checking connections D–1
cleaning 5–7
dim characters D–12
pin assignments A–5

mouse
cleaning 5–7
pin assignments A–1

MultiBay CD-ROM adapter pin assignments A–6

O
optical drive

CMT removal and replacement 6–24
Service Reference Guide, dc7100 361288-003 Index–3



Index
SFF removal and replacement 7–27
overheating, prevention 5–5

P
padlock

CMT 6–5
SFF removal and replacement 7–6
USDT 8–4

parallel interface pin assignments A–3
password

clearing 3–20
power-on 2–1

PATA
cable layout 4–4
data cable pinouts 4–3
power cable pinouts 4–3

PCI expansion card cage
SFF removal and replacement 7–22

PCI Express expansion card
SFF removal and replacement 7–21

PCI Express pin assignments A–9
POST (Power-On Self-Test) 2–1
POST error messages C–1 to C–6
power cord set requirements

country specific B–2
general B–1

power supply
CMT removal and replacement 6–39
fan 5–8
SFF removal and replacement 7–44
USDT removal and replacement 8–26

power switch assembly
CMT removal and replacement 6–29
SFF removal and replacement 7–39

power-on password 2–1
Power-On Self-Test (POST) 2–1
problems, solving

audio D–15
CD-ROM and DVD D–26
diskette D–6
display D–11
drive key D–27
front panel components D–27
hard drive D–8
hardware installation D–20
Internet access D–28
keyboard D–18
memory D–24
mouse D–18
MultiBay D–10

network D–22
optical drives D–26
power supply D–5
printer D–17
processor D–25

processor
CMT removal and replacement 6–35
SFF removal and replacement 7–41
USDT removal and replacement 8–24

protecting ROM, caution 3–4

R
reference designators

riser card E–1
system board E–1

removal and replacement
CMT 5.25" front drive bezel 6–8
CMT access panel 6–6
CMT battery 6–31
CMT bezel blank 6–9
CMT cable lock 6–4
CMT chassis fan 6–38
CMT diskette drive 6–27
CMT diskette drive bezel 6–9
CMT expansion card 6–14
CMT expansion card guide 6–19
CMT expansion slot cover 6–13, 6–17
CMT front bezel 6–7
CMT front I/O device 6–28
CMT hard drive 6–21
CMT hard drive cable 6–21
CMT heatsink 6–34
CMT hood sensor 6–3
CMT memory 6–11
CMT optical drive 6–24
CMT padlock 6–5
CMT PCI Express card 6–15
CMT PCI retainer latch 6–17
CMT power supply 6–39
CMT power switch assembly 6–29
CMT processor 6–35
CMT Smart Cover Lock 6–2
CMT speaker 6–37
CMT system board 6–30
SFF backwall 7–51
SFF battery 7–58
SFF cable lock 7–5
SFF chassis fan 7–50
SFF computer cover 7–11
SFF expansion card 7–19
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Index
SFF expansion card cage 7–22
SFF expansion card retainer 7–18
SFF external 3.5-inch drive 7–29
SFF fan shroud 7–34
SFF front drive bezel 7–12
SFF front I/O devices 7–35
SFF hard drive 7–30
SFF heatsink 7–40
SFF hood sensor 7–4
SFF memory 7–16
SFF optical drive 7–27
SFF padlock 7–6
SFF PCI Express expansion card 7–21
SFF power supply 7–44
SFF power switch assembly 7–39
SFF processor 7–41
SFF riser card 7–25
SFF Smart Cover Lock 7–2
SFF speaker 7–43
SFF system board 7–46
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